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Disclaimer

MS Govern has taken due care in preparing this manual. However, nothing
contained herein modifies or alters in any way the standard terms and
conditions of the purchase, lease, or license agreement by which the product
was acquired, nor increases in any way the liability of MS Govern to the
customer.
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System Requirements
eComponent Requirements

Refer to the table below to determine which components and applications are
required. Users with installed eComponents will only be able to view the
components that they are licensed to use.

eCOMPONENTS
o ™
= o L 3 ~
5§ | 3| & |5 § | &
T = 5 5 S 1858 2 | = £
€ = 1S c > o< 5 S >
o [} o [} s o o o ©
o o (&) 14 (0] ¥ © o 14 o
o (0] (0] (0] (0] [CN)] (0] o (0]
PC module X X X X X X X X
LM module X X X X
AR module o o o o o* o X
@ MB module o* o
=
8 NA module X X X
= SRT module
(7]
s
E Govern Security | X X X X X X X X X
3) Manager 6.0
T (GSM)
o
<

Govern New X X X X X X X X X
Administration
6.0 (GNA)

Govern for X X X X X X X X X
Windows 10.8

X - Mandatory O - Optional
ePayment Solution requires the following:

1. Accounts Receivable (A/R) Module, with links to the sub-systems for which you
are setting up payment collection
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2. Supported ePayment EFT Provider Interfaces are as follows: Pay Connexion,
Moneris, Nelnet, Paymentus, Pay Pal, Point and Pay, US Moneris, and Your Pay.
»  Credit Card / Debit Card / eCheck software1, installed and configured with
valid merchant account
»  Automated Clearing House (ACH) agreement, in force with a bank if you are
providing Electronic Funds Transfer (EFT) services. Refer to the GNA release
6.0 guide for a list of EFT interfaces / providers supported by Govern.

*  Govern for Windows™ Release 10.8 or greater sub-systems:

3. The Accounts Receivable (AR) Modules with links to the sub-systems to which
you are setting payment / collection are required.

Note: All sub-systems are required for ePayment collection

4. Required if users are creating eSubscriber accounts from the Web.

Third Party Applications

The following Microsoft and Third Party Software are required for the
eGovernment solutions:

* Internet Information Server (IIS) with Secure Sockets Layer (SSL)
certificates, installed

*  Microsoft NET Framework 4.5

» SAP Crystal Reports Runtime Engine 13.0.9.x for .NET Framework 4.5
(32-bit)

Note: Users of Govern eComponents should note that there are issues with
using the Report Viewer for the SAP Crystal Reports Runtime Engine
v13.0.9.x for .NET Framework 4.5 (32-bit). With eComponents use the
v13.0.1.x of the SAP Crystal Reports Runtime Engine the for viewing
reports in a Web browser.
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Server and Network Requirements

Note: It is recommended, but not mandatory, to set up three physical

servers. The first server would be for the Database, the second for the
Application, and a third would function as, if required, for the Web. If,
however, you decide to use one physical server for both the
Application and Web, you will need to revise the minimum
recommended configuration.

Note: Deployments on the application server are maintained with the Deploy

EZ application, ensure that this server has Web access and an open
FTP port.

SERVER HARDWARE
Hardware Type Minimum Specifications
DATABASE SERVER
Platform Windows & Unix'

Database Package

Oracle? or Microsoft® SQL Server® 2008 R2, 2012, 2012 R2, 2014

CPU

2 GHz / 1 MB cache, 800 MHz FSB (2.4 GHz Quad-core 1.066 GHz FSB -
Recommended)

RAM

16 GB DDR2* (32 GB DDR2 or greater - Recommended)

Note that specified memory requirements are for the core Govern Applications
alone, i.e. without 3rd party application integrations. Third party integrations
can significantly impact system performance due to their individual require-
ments. A review of requirements of integrated applications should be per-
formed prior to their installation. Also refer to A Note for users of Virtual
Machines (VM’s) below.

Disk Space

Dependent upon the size of data to be managed; RAID V with a minimum of
500 GB of hard disk space is a recommended configuration. Note that Disk
Space is dependent upon Database and Disk Mirroring requirements

Operating System

Microsoft® Windows® Server 2008 R2, Server 2012, or greater

Network

100 Mbit NIC (1 Gbps - Recommended)

Peripherals

DVD / CD ROM Drive

Page xiv
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SERVER HARDWARE
Hardware Type Minimum Specifications
WEB SERVER
Platform Microsoft® Windows® 2008 R2, with IIS 7.5, Server 2012 R2 with IIS 8.5
CPU 3 GHz / 1 MB cache, 800 MHz FSB (2.4 GHz Quad-core 1.066 GHz FSB -
Recommended)
RAM 8 GB DDR2 (16 GB - Recommended)
Disk Space 100 MB for each site being maintained. Additional space will be required for

reports, and temporary space for submitting multimedia documents.

Operating System Microsoft® Windows® Server 2008 R2, Windows® Server 2012, 2012 R2

Network 100 Mbit Network Interface Card (NIC) (1 GBit Recommended)
WEB SERVER HARDWARE

Peripherals DVD / CD ROM Drive

Other Redundant power supply and fans

Server and Client Operating Systems not Supporting

Microsoft’s .NET Framework 4.5

Users should note that the .NET Framework 4.5 is not supported by any
of the following:

CLIENT OS:
Windows Windows 7 / Windows 8/8.1 (32-bit and 64-bit)

SERVER OS:

Windows Server 2008, all editions
Windows Server 2008 R2 SP1 (32-bit)
Refer to the following link for full information:

http://msdn.microsoft.com/en-us/library/8z6watww.aspx
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A Note for users of Virtual Machines (VM’s)

Users of Virtual Machines (VM’s) should note that when multiple servers are
being hosted in a Virtual Machine on the same physical servers, the
requirements for each individual server must be carefully managed as it can
impact use of system resources. For example, users may decide to host the
Database Server, Application Server, and an eGovern Web server in a VM
that is running on the same physical server. In such a situation, as a result of
the varying requirements of each server, planning is required to address how
shared system resources are allocated to the individual server, and the VM.

Supported Web Browsers

Note: Internet browsers are continuously developed and upgraded, as a
result compatibility issues may arise. The following list is by no means
an exhaustive one, and cannot completely take into account the
incompatibilities that can occur between browser versions and
versions of operating systems.

Web Browsers

The MS Govern eComponents are compatible with the following versions of
these popular Web browsers.
It can be assumed that Web browsers that do not appear on this list are not
supported.

Browser Compatible Version
Microsoft Internet Explorer 9.0 and above
Mozilla Firefox 3.0 and above
Google Chrome 2.0 and above
Apple Safari 3.1 and above
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Introduction

Overview

OpenForms™ and Govern.NET

MS Govern has provided automated land management to government
organizations, for more than 25 years, beginning on Wang and UNIX systems;
then, moving to the Windows™ platform in 1997. With their .NET solutions,
MS Govern extends its services to the citizen and local business professional,
further automating land management by providing online real-time Web
access for submitting permit, license, grievance, complaint and request for
services applications.

What’s New

This section lists new features, or new ways of performing an old function in
the MS Govern eGovern — Public Self Service Portal release 6.0. These new
features are indicated by the symbol.

Change in HPG ePayment Process

In order to minimize timing issues that may arise during transactions with
external transaction servers and the Harris Payment Gateway (HPG).
Modifications have been made to the payment process with HPG and external
transaction servers. This modification involves a reworking of the transaction
process.

Inactive Accounts with Available Filings

Changes have been made to how the system handles Inactive Accounts that
are related to the SRT. When the user is selecting accounts, the system will
verify if the account has any filings available in the selected year. If there are
no filings the system will display a message at the top of the interface.
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In instances where the web profile has only one account, the user will be
redirected to the filing page, Note that if there are available periods, the
system will display a message in the lower portion of the interface.

Note: A navigation button has been added to facilitate navigation back to the
home page.

Modifying the Message

Users that wish to customize the message are able to do so with the Resource
Editor in GNA Release 6.x. When searching, the associated keys to look for
are as follows:

+  WEB_SRT_SELFREPORTEDTAX
+ CVSSELECTEDACCOUNTS

The resource file hierarchy is as follows:

(ROOT) Resource File Name > Module > Function > Key...refer to the GNA
Release 6.0 user Guide for directions on editing Resource Files.

Select Year of Submission for eRemittance

Previously in the eRemittance, on the accounts page you were only able to file
a Self reported Tax report for the current year. There is now a new flag in GNA
to activate the option to select other available years. See Select Year of
Submission for eRemittance on page 92.

Copy of Report Sent as Attachment in Notification Email Message

For the eRemittance, there is now an option to send a .PDF copy of the report
that was filed, as an attachment in the notification email. See Send SRT
Report by Mail on page 92.

ePermit
Link to Display Description of Permit Type if Available

In the ePermit process when a full description is available, appearing next to
the drop down menu in the Permit Type is a link for users to see the full
description of the permit type. See Link to Full Description of Permit Type on
page 172.

Page 2
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ePayment
Credit Card Processors for ePayment

The following are newly supported Electronic Fund Transfer (EFT) providers/
interfaces:

» HPG (Harris Payment Gateway) - Credit Card and Electronic Check
* UniPay - Credit Card and Electronic Check

Refer to the Appendix section of the Govern New Administration (GNA)
release 5.1, for a list of supported providers and interfaces.

Customize Notification Message sent after Account Creation

When a user creates an account online, a confirmation message will be sent
to the email address that the user specifies during the account creation
process. The body of the email message, and the email subject field can be
customized using the Govern New Administration (GNA) Resource File
Editor. See Account Creation Email Message Authentication option on
page 148 and Customizing the Account Creation Notification Message on
page 149.

Friday Batch No. used for Weekend Processes

There is an option in Batch Processes that will use the batch number
generated for Friday to also apply to Saturday and Sunday. See Friday Batch
Number used for Week Processes on page 215.

Disable Payment Auto Selection

During the ePayment process, multiple accounts are by default selected. The
Disable Payment Auto Selection option will ensure that there is no auto-
selection of payments. See Payment Auto Selection on page 216.
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Chapter 1:eGovern — Public Self Service
Portal Installation

Overview

Pre-installation activities...

Prior to the installation steps for the eGovern — Public Self Service Portal,
there are a series of pre-installation tasks that need to be performed.

Due to the number of steps that are involved with the installation of the
eGovern — Public Self Service Portal, it is recommended that administrators
performing the installation refer to the eGovern — Public Self Service Portal
Installation and Configuration Checklist as an assurance that required steps
are completed.

Server Configuration

Step 1 - Installation of IIS and Framework 4.0

Note: Although efforts have been made to ensure that |IS will run correctly,
due to the diversity of versions, additional steps, and changes in the
sequence of steps may be required to ensure correct functioning.

Users that are installing to a server should ensure that Internet Information
Services (lIS) is installed. Alternatively, ensure that Microsoft .NET Framework
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V4.0 is installed; note that ASP.NET 4.0 and ADO.NET 4.0 are automatically
installed when you install .NET Framework 4.0..

.1 Programs and Features

9( )v '3 = Control Panel ~ All Control Panel Items ~ Programs and Features - l‘Z_]JI Search Programs and Features m
Uninstall or change a program
view installed updates To uninstall a program, selectit from the list and then dick Uninstall, Change, or Repair,
5‘ Turn Windows features on or off -
( R P g Organize v = v @
Proar
MName = |v| Publisher |v| Install... |v| Size | -
ErcGIS ArcSDE for Microsoft 5QL Server Ervironmental Systems Resea... 4/30/2012
OArcGIS ArcSDE for SglServer for Windows 64 Environmental Systems Resea... 4/30/2012
OArcGIS Desktop 10 Environmental Systems Resea,.. 4/25/2012
OArcGIS Server for the Microsoft \NET Framework ... Environmental Systems Resea,.. 4/25/2012
eArcGIS Server for the Microsoft .NET Framework ... Environmental Systems Resea... 4/25/2012
[ Microsoft .NET Framework 4 Client Profile Microsoft Corporation 4262012 38.8M
55 Microsoft JNET Framework 4 Extended Microsoft Corporation 4/26/2012 51.9M
QMicrosof't Forefront Endpoint Protection 2010 Microsoft Corporation 44202012
'E’-‘-_’, Microsoft Office 2003 Web Components Microsoft Corporation 4/18/2012 50.8 M
aMicrosoft Office Standard 2010 Microsoft Corporation 512012
ﬁll\‘licmsnﬂ Report Viewer Redistributable 2008 5P1 Microsoft Corporation 4182012
» Microsoft Silverlight Microsoft Corporation 4/18/2012 20.4M
|3 Microsoft SQL Server 2008 R.2 (54-bit) Microsoft Corporation 4/18/2012 b
|3 Microsoft SQL Server 2008 R2 Books Online Microsoft Corporation 4182012 177 M
|3 Microsoft SQL Server 2008 R2 Native Client Microsoft Corporation 4182012 6.09M
|3 Microsoft SQL Server 2008 R.2 Policies Microsoft Corporation 4182012 934K
|3 Microsoft SQL Server 2008 R.2 Setup (English) Microsoft Corporation 4/18/2012 30.5M
|3 Microsoft SQL Server 2008 Setup Support Files Microsoft Corporation 4/18/2012 248 M
|3 Microsoft SQL Server Browser Microsoft Corporation 4182012 9.19M
[ 'j\MicrosoFt SQL Server Compact 3.5 SP2 ENU Microsoft Corporation 4/18/2012 3.39M
| 'j\MicrnsnFt 5QL Server Compact 3.5 5P2 Query Too... Microsoft Corparation 4/18/2012 4.63M
|3 Microsoft SQL Server System CLR. Types (x64) Microsoft Corporation 4/18/2012 L4zm _
o] R e b e e _>]_I
—— Currently installed programs Total size: 918 MB
}‘.3 i;l,- 33 programs installed

Windows Server 2008 users, ensure that Microsoft .NET Framework V4.0 is
installed.

Windows Server 2003 users can refer to the Installing and Configuring
eGovern - Public Self Service Portal sections of the Govern New
Administration (GNA) release 5.1 guide for details. Otherwise, visit Microsoft's
Website for available update information and follow the installation procedure
for your operating system.

Step 2 - Installation of AJAX Extensions

Ensure that Microsoft ASP.NET 2.0 AJAX Extensions 1.0 is installed on /IS.
From Start, click Control Panel > Programs and Features and verify that this
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application is installed. It will be listed as Microsoft ASPNET 2.0 AJAX
Extensions 1.0.

"(‘-\ ./ » Control Panel » All Control PanelIterms » Programs and Features - H Search Programs and F.. ©

File Edit “iew Tools Help

Control Panel Home .
Uninstall or change a program

View installed updates To uninstall 2 program, select it from the list and then click Uninstall, Change, or Repair.
%) Turn Windows features on or
il Tz = el e v @
Install a program from the »
network MName Publisher Installed On  Size WVersion -
L‘%M\crosof‘t {NET Framework 4 Client Profile Microsoft Carporation 12/15/2010 JMBME 4030319

. aed TTCraiort Larparaton 127 [o7 J010 R = R U LLE
EDM\croso&ASP‘NETlU A8 Extensions 1.0 [n Microsoft Corporation  7/25/2011 L74ME 1061025 ] ?
hiceasaft Device Exoulatar (Gl bittuersion 20 o ENULUS  0iciosaft Comoarion 1132010 4 hdR 00 20

5 Micrasoft Docurnent Explarer 2008 Microsoft Corparation  11/3/2010

EM\crosof‘tForefmnt Endpoint Protection 2010 Microsoft Carporation 2/20/2011 2.0,857.0

@M\croso& Lync 2010 Microsoft Carporation /1472012 191ME  40.7577.4061

ﬂ} Microsoft Office 2003 Web Components Microsoft Corporation 6/15/2011 18.6 ME  12.0.6213.1000

= |Microsoft Office File Validation Add-In Microsoft Corporation 1/472012 T.95ME  14.0.5130.5003 -

Note: Windows 7 users should follow from the Start button, Start > Control
Panel > Programs and Features.

When AJAX Extensions are not installed, browser errors may occur when
trying to access the Web site.

¢ Favortes | @ Configuration Errar x | & New Tab {2 ] Suggested Site

7
Server Error in '/WebUserInterface' Application.

Configuration Error

~N\

Description: &n error eccurred during the precessing of a configuration file required to service this request. Please review the specific srrer details below and medify g

Parser Error Message: Could not load file or assembly "System.VWeb Extensions, Version=1.0.61025.0, Culture=neutral, PublicKeyToken=31b13856ad364235 or
(chinetpublwwewrootiwebuserinterface\web. config line 208)

Source Error:

<!-- END ASP.NET BAjax Extention -->

‘\-‘K#ﬁ “‘”\..

Source File: clinetpub\wwwrootiwebuserinterface\wet.config  Line: 208

\

To obtain and install the extensions, copy the following URL into your browser,
download and follow the installation instructions:

http://www.microsoft.com/downloads/details.aspx?displaylang=en&Fami-
lyID=ca9d90fa-e8c9-42e3-aa19-08e2c027f5d6
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Step 3 - Installation of Crystal Report Runtime
i@l Programs and Features =] E3
9( )v [l - Control Panel - All Control Panel Ttems - Programs and Featurss = [ [seercnprograms and Feares 5]
Cantrol Panel Home Uninstall or change a program
View mstalled updates To uninstall a program, select it From the list and then click Uninstall, Change, er Repair.
' Turn Windoves Features on or off =
O ~  Uninstall  Chi R = o~ @
Instal a program From the network oo ninsta e R : @
Name = |v| Publisher |v| Install.. |-| Size: |-| Yersion ;l
=115 Govern - Click Once Installer M5 Gowern 4f26(2012 337 MB  4.7.3001
;_EIMS Govern - Crystal Reparts 2008 For Govern M35 Gowern Sfljzo1z 12.0.02
(M5 Govern - Govern For Windows 10.7 Runtime M5 Gowern 4f26(2012 10.7.0.3
M3 Govern - MelissaData for Gowern (Server) MS Gowern Sf1jz012 2012.06
(e MS Govern - MS SQL Reporting 2005 for Govern Windows MS Gorern 4f26(2012 10.6.0.2
BMS Govern Goviiew V2.3 M3 Gowern Si3jz012 37.4ME  2.3.00017
m_IMSKML 4.0 SP2 (KB9S54430) Micrasoft Carparation 4f26f2012 1.27MB  4.20.9570.0
- MSXML 4.0 5PZ (KBO73638) Microsoft Corporation 4f2ef2012 1.33MEB  4.20.9876.0
[ motepad++ si1z012 612
POP=RCITET TrTkEr S TrETE izt
| J > Crystal Reports runtime engine For JNET Framework 4 (32 SAP Si1jz012 )
lembndde2.0.9 Robertwood Si1z0l 154 MF 2,09
BvirtualCloneDrive Elaborate Bytes 41312012 |
[ElvMware Tools WMware, Inc, 4jz6i2012 274MB 80214744 =
4| | »
SAP Product version: 13.0.1.220 Size: 193 MB
Help link: http:/isuppart.businessa, ..

Verify that SAP Crystal Reports for Visual Studio 2010 Runtime engine for
.NET Framework 4 (32-bit) is installed on your IIS Server. If not installed,
obtain the Crystal Reports Installer, and run the setup on your IIS server. This
is required for running Crystal Reports with .NET applications, using .NET
Framework version 4.0.

Note: The eGovern — Public Self Service Portal is only compatible with
Crystal Reports 13. In order to obtain the Crystal Reports 13 installer,
contact MS Govern Technical Support. During the installation of the
Crystal Report Runtime, you will be prompted with a request for a
Product ID. Leave the field blank and press OK.

Step 4 - Installation of Oracle Client (Optional)

This is an optional step that is intended for users that will be connecting to an
Oracle database. Before successfully connecting to an Oracle database, it will
be necessary to install the Oracle Client. Refer to the Notes for Oracle
Database Users section of the Govern DeployEZ user guide for details.

Step 5 - Verify that GovWin 10.7, or greater is installed

Ensure that Govern for Windows™ Release 10.7, or higher, is installed and
running on your system. For installation instructions, refer to the Getting
Started Release 10.7 guide.

Page 8
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Step 6 - Database Preparation

Database preparation involves the use of the Updata.exe utility in Govern for
Windows. Refer to the Govern for Windows Getting Started Release 10.7
guide for details on running Updata.exe.

Step 7 - Install DeployEZ

Download the ClickOnce .ZIP archive file from the MS Govern FTP site;
install the DeployEZ release 4.7.4 or greater on your server. Refer to the
DeployEZ guide for details.

OR

Step 8 - Install GNA 5.1, Database Preparation, and
Resource files

Create a deployment with DeployEZ; obtain the latest versions of the
Resource Files. Deploy GNA release 5.1 to a folder of your choice
<msgovern_install_folder>. Refer to the DeployEZ guide for details on
creating a Deployment.

Step 9 - Verify Presence of Key Folders

Verify the presence of the following folders/files in the DeployEZ install folder...
<msgovern_install_folder> :

+ GovernDABConfig.xml (File in Root)
* ResourceFiles (Folder in Root)
*  GovernNetConfig.xml (Root\Deployments\Deployment_Name)
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These files are generated by DeployEZ, contact MS Govern Technical Support
to obtain them..

WARNING:
Set the security for the Deployments folder, and the sub-folders for each of
the deployments. Folders requiring access are as follows:

MS Govern install folder - location of the GovernDABConfig.xml,
ResourceFiles folder

Deployments folder and the subfolder for the deployments - location of
GovernNetConfig.xml

This is to ensure that the IIS User will have access to the required folders
and files. Set the security to ensure that IS has Read / Write / Modify /
Delete privileges. If access is not given to IIS errors in the functioning may
occur.

Use of a dedicated Microsoft Active Directory (MSAD) user may be required
in a multiple server environment.

Step 10 - Launch GNA

Locate your deployment shortcut and launch the Govern NetAdmin (GNA).

Step 11 - Perform Complete Database Reset

Select Utilities > Database Ultilities > Complete Database Reset... to run the
Database utilities that rebuild the sections that are required for the eGovern —
Public Self Service Portal.

Step 12 - Creation of Required Directories

Create a folder c:\eGov where c:\eGov can be a Web install folder
<web _install_folder>. The folders MUST BE created on the server running IIS.

Create the following folders:
c:\eGov\WebUserInterface or
<web _install_folder>\WebUserlnterface directory.

c:\inetpub\wwwroot\eGov.

Page 10
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c:\eGov\Reports or <web_install_folder>\Reports directory. All Crystal Reports
used by the Web site should be placed in this folder.

c:\eGowv\logs. This is a directory for error logs.

Note: Ensure that the security for the log folder is set to Read/Write/
Execute/Modify.

c:\eGovlimages or <web_install_folder>\images directory that will hold images
used for the Web site.

Note: Securities for the above folders, by default, should be set to Read/
Execute.

c:\eGov\css or <web_install_folder>\css, Cascading Style Sheets (CSS)
directory that can hold the style sheets that are used for the Web site.

c:\eGov\js or <web _install_folder>\js, javascript directory for scripts used on
the Web pages.

Create a c:\eGov\uploads or <web_install_folder>\uploads directory directory
that will be used for storing Multimedia attachments and upload files. Files that
users upload to this directory are stored temporarily at this location. These
files will be deleted after being processed by the system.

Note: Ensure that the security for the uploads folders is set to allow Read/
Write/Modify/Delete. In addition ensure that there is sufficient storage
space to accomodate files that will be uploaded.

For directories that are located on a server that is external to the 1IS server,
refer to Viewing Multimedia Documents not stored in the Database on
page 21.

Step 13 - Obtain and Extract Web User Interface File

Note: Contact MS Govern Technical Support to obtain the required
WebUserlInterface.zip file; ensure that the version is compatible with
your release of the eGovern — Public Self Service Portals.

Unzip the WebUserlInterface.zip file into the c:\eGov\WebUserlnterface or
<web _install_folder>\WebUserInterface folder.
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Step 14 - Create Application Pools

Open the IS Management Console; click Start > Control Panel >
Administrative Tools > Internet Information Services (lIS) Manager.

Administrative Tools B[] E3
‘( ;.( ) | ~ Control Panel + All Control Panel Tkems = Administrative Tools « = [ [ serch rdmnisraie ook 5]
Organize ~ =7 Open =~ &l @
' Favortes e - Dats modiisd Sz | pe | |=]
B Deskiop Remote Desktop Services 7/14j2009 12:58 AM File Folder
& Dawnloads (3] Component Services 7{14{2009 12:58 AM 2KB  Shorkeut
< Ri t P
- Hecent Hlares (2} Computer Management 7{14/2009 12:57 AM 2KB  Shorkeut
5 Lrares Data Sources (QDBC) 7/14/2009 12:57 AM ZKB Shortcut
3 Documents @ Event Viswer 7142009 12:58 AM 2KE  Shorkout
o music = A— i isasll I PR LIP3 111 KBSharkut
[ Pictures
E# videos Taf TSCSTITSTar T 200 TZrS T T 5 SO
i [#l Local Security Policy 7/14j2009 12:58 AM ZKB Shortcut
1% Computer -
& [#]Y Performance Monitar 7i14/2009 12:57 AM 2kB  Shorteut -
e Local Disk (C:) -
[#l Security Configuration Wizard 71142009 12:58 AM 2KE  Shorkout
i Netwark (2l Server Manager 7114/2009 12:58 AM ZK8  Shortout
(2} Services 7I14/2009 12:57 &M 2KE  Shorkout
{8 Share and Storage Management 7/14{2009 12:53 AM 2KB  Shortut
F= Ghew e Fvnlnrar 741249000 17:50 am ¥R Shovkeut =
ﬁ:. Internet Information Services {1IS) Manager Date modified: 4/18/2012 11:16 AM Date created: 4/15/2012 11:16 AM
ﬂ Shorteut Size: 1.24 KB

Right-click on Application Pools in the left @
hand pane and select the Add Application

Pool option; other versions of [IS may require
selecting New > Application Pool. Name the NET Eramenar version:

new application pool MSGOVERN; select [,NET}ramewmk%ujuﬂg
.NET Framework 4.0 and click OK.

MName:

MEGovern

Managed pipeline mode:

Integrated -

Start application pool immediately

Windows Vista, Windows 7, and Windows
Server 2008 users, select .NET Framework
4.0. o J[ conee |

Note: If you have an older version of /IS, or an improperly installed .NET
Framework 4.0, the version number will not be displayed.

Page 12
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Step 15 - Create Web site s

(Optional)
efsovern eGovern __Sglect.‘. I

Content Directory

By default IIS creates a Web site. Bhysical path o
. CheGowv
You may use thls or Create your Pass-through authentication
own. Note the Port Number that is (Comnectan] [ TestSetingan
used and ensure that you do not .
. . inding
create a site with the same T P sddress Fam
number. Al Unassigred )
Host name:
Right-click on Sites in the left hand T ———

pane and select Add Web Site; on
older versions of IIS version, right StarWeb ss imedistey

click on Web Sites and select New —
> Web Site... Name the web site
eGov.

In the Physical path: parameter, click “...” Select the MSGovern application
pool. Click to select <web _install_folder> folder as the physical path. Click OK
to save.

Note: Under older versions of IIS a wizard will be used to create the new web
site; use the same entries as above.

Step 16 - Convert the eGov Folder to an Application

1. Click to expand the newly created eGovern - Public Self Service Portal
Website icon.

7,
@U [ v BMTLNL » Sites » eGov » Weblsernterface » | k&
File View Help
|| Connections . Actions
% WebUserlnterface Home
| — B Explore
-85 BOMTLNL (HARR I iahs.
483 o l( Shoolaniyan] Filter: . e S| Gre By . Edit Perrmissions
- Application Poals r = Manage Folder ~
4[5 Sites =0 vy rl 2N
B Defa eb Site % \\.f G r 2 Browse Folder
7 eGov HET NET WMET Error MNET (MET Profile  .MET Roles Erawse *:8080 (hitp)
| images Authorizat... Compilation Pages Globalization B @ Help
-eGov ports ‘; i I D -
= = 2) gt Online Hel,
I uploads B/ S = § | rline Help
b WéebUsernterface MET Trust JMET Users Application Authentic., Cornpression Configurat..
Lewvels Settings Editor
L e & &
Connection Default Directory  Error Pages Handler HTTP
Sk D Bi Mappi r
LTl O L L SR Y S
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2. Locate the eGov folder under sites. Right-click on the folder and select
the Convert to Application option.

W5 Internet Information Services (IS) Manager

G e

File  Wiew Help

Connections

# @ eGov Home

-4 Filter: G Show Il | Graup by:
L2} Application Pools tter: o 7 kg Show roup by:
a.[8] Sites =N g, ¢ P 12N
3 Default Web Site B [ L)
B cGow T NET MET Emor MET  .METPrafile .MET Roles
| Bl Explore .. Compilstion  Pages  Globalization

Edit Permissions...

L& Convertto Application & =
f_\

£dd Application...

& ?x :'Q?,s ‘i;‘il B

METUsers  Application  Authentic... Compression Canfigurat..
Settings Editor

T B it Directary E -E s B
Manage Fald , 9 = 29 =
ETEER L Connection  Default  Directory  ErmorPages  Handler HTTP

G Refresh Strings  Document  Browsing Mappings  Respon..
- - = ! Ir P

[ Switch to Content View uf E H ;ﬂ? 7 <ﬁ>ﬂ g
>-[E] CommonPages ISAPLFilters  Logging  Machine Key MIME Types  Modules  Output

+ [ Custom Cachirg

> [] CUSTOMCONTROLS

L EN = o = ”‘&b ,_=‘ﬂ1 ER
8P e gl g 2% 2 _— 'gﬁ,

3. Click OK to save.

“‘\,.\ﬁ\v\l-s\,\',‘“ NN

F e N
Add Virtual Directory -— [ [
Site name:  eGov 4
Path:
b
Re
Alias:
aspneﬂ,chant

|| Example: images
Physical path:
Chinetpublwwwroot\aspnet_client [I]

Pass-through authentication

[ Connect as... l I Test Settings... l

BEST PRACTICES:

When creating Web services, it is a good practice to create separate
application pools for each of the sites.This ensures that the processes
within one pool are run independently of the other. For example, when
maintaining a Test site and a Live site, should a process fail in the Test site,
it will not impact the Application Pool of the Live site.

Step 17 - Create a Virtual Directory (Optional for Crystal
Report Viewer)

Right-click on WebUserinterface and select the Add Application option;
users of older versions of IIS, right-click on WebUserInterface and select New
> Virtual Directory... Enter the parameters as follows:

Page 14
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Under Alias:, enter aspnet_client

Physical path: enter, C:\inetpub\wwwroot\asp_client
Add Application = —— [

L e —— —

Sitename:  eGov

Path: /WebUsernterface

Alias: Application pool:

aspnet_client MSGovern
| Example: sales
|

Ehysical path:
| Chinetpub\wwwroot\aspnet_client [I]
| Pass-through authentication
|
I [ Connect as... l I Test Settings...
;

When completed, click OK and exit from the 1IS Management Console.

Step 18 - Create a Directory for Multimedia Documents

(Optional Virtual Directory)

When Multimedia Documents are stored in the database, there are no issues.

Issues can arise when documents are stored under an external path.

Realistically storage locations that are external to the database will need to be
used particularly when dealing with large files, e.g. videos, high resolution
images, etc. In such instances additional configuration will be required to be
able to access these files. Refer toViewing Multimedia Documents not stored

in the Database on page 21 for details.

© 2015 Harris Govern
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Step 19 - Set ASP.NET Version to 4 (for lIS 6.1 or earlier)

For IIS versions older than 6.1, you will need to right-click on WebUserinter-
face; select Properties. In the WebUSserInterface Properties screen, select the
ASP.NET tab. Ensure that the ASP.NET version: is set to 4.0.

WebUserlnterface Properties @E‘

Directory | Documents || Directary Security | HTTP Headers | Custom Enors | ASP.NET
M'iioigﬁt'
.I lE t

ASP.NET version: |2 050727 j

Wirtual path:

File location:

File creation date: |2.‘1S;‘2DUE 10:33:57 AM
File last modified: |5/1 242009 12:01:00 PM
Edit Configuration... |
et

Note: Users of IIS 7 will note that the above settings were made when

configuring the Application Pool at Step 14 - Create Application
Pools on page 12

(" Add Application [® i

Site name:
Path:

Alias:
eGow

Example: sale

Physical path
Chinetpubindfl B3

Pass-through

Connec tas.

Web site Configuration

Step 1 - Create a Webskin

Create a WebSkin with the WebSkin Manager; in Govern NetAdmin (GNA)
select Setup > Web Configuration > Manage Web Skin... For details, seeWeb
Skin Manager on page 106 for details.

Page 16
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Step 2 - Configure your Dynamic Web Search

Configure Web Search...

1. Select Setup > Dynamic Search Configuration > Any of the following
(Dynamic Search Objects..., (Dynamic Search Styles..., (Dynamic Search
Groups...) to set up Objects, Styles, and Groups.

Refer to Search Configuration section of the Govern New Administration
(GNA) release 5.1 user guide for details.

Step 3 - Configure your Web site

Configure your Web site with the Web Site Manager; select Setup > Web
Configuration > Manage Web Sites... ; take a note of the Website ID number,
it will be used at a later step. For details, refer to the Web Site Manager
section in the GovernNetAdmin Application guide.

Step 4 - Use Web Config Editor

In GNA...

Select Setup > Web Configuration > Web Config File Editor...

2. In the Web Config File Editor, select the Web.config file from your web
site folder (c:\eGoviWebUserInterface or <web_install_folder>\
WebUserinterface).

3. On the Page 1 tab, define the following parameters:

* Location of the GovernNetConfig.xml file:
<msgovern install folder>\GovernNetConfig.xmI"\>

» Upload Document(s) group: Location of the uploads directory, and the
maximum filesize for an upload file.

* Web Site group: Web Site ID (a numerical value) and the configuration that
your site will begin with, Web portal (for general inquiries) or Web profile
(for more actions, i.e. permitting, remittance, etc.)

Note: The above are suggestions for an example Web site and are in no way
an indication of limitations of the eGovern - Public Self Service Portal.

See the Web Configuration File Editor on page 96 for details.

On the Page 2 tab, define the following parameters:

© 2015 Harris Govern Page 17
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If you want to enable error logs, specify the notification recipients and the
location of the .log file.

In the Auto Login group, if used, i.e. for “Kiosk mode” enter the Login and the
Password.

* Inthe Crystal Report group, specify the Print Mode: as ActiveX

* Locate or enter the location of the Crystal Reports in the directory:
parameter.

Step 5 - Set up Web eProfile Parameters

Set up Web eProfile Parameters...

1. Select Setup > Web Configuration > Manage Web Sites...

2. Select your Web site and click the eProfile tab.
Refer to Web Site Manager - ePayment tab Parameters on page 75 for
details.

Step 6 - Design and Create your Menus

Create Website menus...

1. Select Setup > Web Configuration > Manage Web Sites...

2. Select your web site and click Menu Setup.
See Configuring Website Menus on page 47 for details.

Step 7 - Set up Private Names & Addresses (As
Required)

In Govern for Windows Admin, if your name and address records are to be
kept private, define a department. For details, refer to the Govern for Windows
Super User Release 10.7, guides.

Step 8 - Configure ePayment Parameters (As Required)

Set up the Web ePayment Parameters...

1. Select Setup > Web Configuration > Manage Web Sites...

Page 18
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2. Select your Website and click the ePayment tab.

Refer to Web Site Manager - ePayment tab on page 75 for details.

Step 9 - Configure ePermits (As Required)

1.

In Govern for Windows Admin, select Parameters > Land Mangement >
Parameters...

In the Land Management Parameters form, Select a Department and click
Maintain > Definition of Type > Permits.

In the Permit Type Maintenance form click the eComponents tab and set
up ePermit parameters.

Next, select Maintain > Definition of Type > Workflow, in the Workflow
Type Maintenance form.

Set up the parameters for the eComplaints, eRequest for Services, and
eGrievances.

Refer to the eGovern — Public Self Service Portal release 5.1 guide for
details.

Step 10 - Configure Fields that are viewable on Web (As
Required)

In Govern for Windows, use the Field Setup Mode to configure the fields you
will be displaying on the Web with the following functions:

Permit Types

Complaint and Anonymous Complaint
Request for Services

Grievance Types

Refer to the eGovern — Public Self Service Portal release 4.7.4 guide for
details on Name and Address functions, Permits, Complaints, Request for
Services, and Grievance types.

Step 11 - Configure eRenewal Activity Steps (As
Required)

Setup the Activity steps for the eRenewal in GovAdmin.

Select Parameters > Land Management Parameters

© 2015 Harris Govern
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» Select a Department , click Maintain > Definition of Activities > Permits

Choose the activity step with renewal that eRenewal will be permitted for; click
the Page 2 tab and specify an expiration date. Click the Page 4 tab and select
Allow eRenewal. Select a Response from the drop down menu.

Step 12 - Configure eRemittance Web Layout (As
Required)

In Govern NetAdmin (GNA) configure the layout of the Self Reported Tax
(SRT) eRemittance form by selecting Setup > OpenForms Configuration >
Self Reported Tax Editor.
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Additional Configuration

The following are additional configuration steps that may be needed based
upon user requirements.

Viewing Multimedia Documents not stored in the
Database

When multimedia files are not stored in the database, i.e. store on external
servers, user will find that they are not accessible.

Multimedia files that are not stored in the database, i.e. files stored under an
external path are not accessible to users.

Solution: In order to view Multimedia documents that are not stored in the
database, it will be necessary to perform a workaround with IIS.

Step 1 - Note the Multimedia Document Path

In Govern for Windows Admin...

1. Select Parameters > Edit the System Registry...

Note the path of the Multimedia document; look at the path entered in the
Level I/II/lIl Multimedia Document Path parameters. For our example, the
common path is:

\\FServer\ntwin\ ... this is our common root; close the form.

2. Select Parameters > Property Control > Parameters...

3. Inthe Property Control Parameters form, select a department and click
Maintain > Multimedia Codes
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It is here that we see the different multimedia files that we would like to view.
These types of files are saved in the various Multimedia Archive Levels.

3 System Registry Maintenance

o S |

Govern T Options T eProfile TEEGmpDnenlsT EnﬂnechnnsT Login SetupT Credit EardT Intagrahnn]

Path Information
Bitrnap Fold ‘Windows Imaging Editor Falder

[=]] 1

Help Files Folder AutoCad Viewer
|\\FS erversnbwintgovernyyersion, 107\Help

Reports Folder PDF Viewer
[\\FServersntwintgoverniversion. 10745 tandardReports J |

Custom Reparts Folder Melissasidddress Data Folder
|\\FS ervershtwinhgoverniersion, 10745 ampleR epaorts

GIS Query Definition Folder evel | Multimedia Docurnent Path

"AFServerintwinhgoverniersion 1074GIS Quernies J |\\FSErvel\ntwin\gnvem\\MAGES1
Guery Definition Folder Level Il Multimedia Document Path
YWFS erversnbwinhgoverniversion, 107YGenerals cripts J |\\FServel\ntwin\govem\\MAGES2
Inspection Templates Lewvel 1l Multimedia D ocumert Path
|\\FSErver\ntwm\gnvem\\u"elslﬂn 107\ nspectionT emplates J |\\FServel\ntwm\gnvem\\MAEE53

Lockbos File Folder Log Files Folder

| _

— G/L General Parameters
County Format Casze Sensitivity

GAL Interface
‘USA j |N° ﬂ |Govem Generic Interface j
Ciystal Report Sleep Time [ms)
1]
GI5 Link Type P_Id Calumn M ame
[rcview G.x | [PARCEL_ID

Exit |

4. Onyour IS server, start the IIS Manager; Start > Control Panel >
Administrative Tools > Internet Information Services (1IS) Manager.
5. In the WebUserInterface node, look for the Multimedia node.

Page 22
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Additional Configuration

6. Right click and select Add Virtual Dlrectory

5 {115} Manager

. arcgsibs
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S
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2pp_Themes
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Multimedia Home

Group by fuas
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o-.

SMTP Emal

s
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L Athentication o6l

i

MIME Types Modules Cutpet
Cacheg

¥ Stes b DefakWebShe b MSGovem b Weblseriterface » Mukimeds *

B Ephee
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Hanage Molder
- 2 - Browse Folder
i“r ab f( 8 S;« (& Erowese =:80 bz
MET Tt Aopktion Conecion  Machme@ny  Pagesand  Sevsion Rate @ nee §
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e
® i 'y b I o
Dtk Dwrectory Errar Pages Hander MTTP Radeect HITP
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UNC format path of the physical directory.

| aspnek_client
| Dummy

¥ weblUserInterface
-] App_Data

B App_Themes

B AR

B bin

-1 Comman

- CommonControls
-] CommonPages
-] Custom

B EN

B Errar

B FR

B Images
BN

-1 In_Mobile

B ME

1 Multimedia

S 1P E-mai

s

&
=
asp

an-

MIME Types

g P

=

Authe

4
M

Add ¥irtual Directory
il
Site name:  Default Weh Site —
Path: IMSGovern/WeblserInterFaceiMultimedia pd‘:g"s
Alias:

T/ TR

Example: images

Physical path:
|\\FSERVER\NTWIN\

Pass-through authentication

Connect as.., | Test Settings...

L

Enter the name of the Alias folder, for our example NTWIN. Also enter a

iy

HTT

NN ALA S

JMW‘)J"*""”““/

Note: For our example, all directories exist on the same server. If there were
multiple servers, a virtual directory would have to be created for each.
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8. Click OK.

Note: If the IIS server is outside of your “DMZ”, access may still be blocked
by your firewall. Additional configuration will be required, e.g. opening
specific ports to gain access. This additional configuration is outside
the scope of this document and should be referred to Microsoft
Technical support. Refer to Default Firewall Port Settings on page 280
for default Firewall ports for Web-based applications

Auto Login for Multiple eGovern - Public Self
Service Portal Sites

The eGovern - Public Self Service Portal system is designed to request login
credentials when a user wants to access a Website requiring a Profile.
Situations may arise where it is necessary to access multiple eGovern - Public
Self Service Portal setups. For example an administrator may have to access
Websites for the following, the Assessors office, one for Ulility Billing,
Inspections, and one for the Permitting office. In such instances, i.e. two or
more Websites, multiple individual logins can become tedious and time
consuming.

There is a configuration option that allows users to be able to switch between
multiple Websites with only one initial login. With this process, the sessionlID is
passed to the next site along with the serialized state, this ensures that the
initial session is recreated on the next site, i.e. the SessionlID is replicated.

To perform this setup, the following steps will need to be followed:

Creating a Link Element

You need to create a Link Element; add in the link the Domain Name Server
(DNS) of the other eGovern - Public Self Service Portal site.

Next you will need to add the following string:

/webprofile/controls/autologin/
web wp autologin.aspx?webportalsession

Page 24
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This will redirect the session to the auto login of the eGovern - Public Self
Service Portal site that you would like to access.

Note: The above procedure must be repeated for each Website that is to be
accessed.

Web Site Menu (BPOTGM1_CMSDEMO_MICROSFOTSQL2005)

Menu

Menu Id Menu Sequence g

Description g ~

Ttem ——]
trem ind (U A— i o —

Path / URL

1 Parameter —

Name Value ;

To enter the URL...

1. In the Govern NetAdmin (GNA), select Application Configuration > Web
Configuration... > Manage Websites...

2. Click to select the Website that will be accessed from the Available Web
Sites list.

Click Menu Setup.
If not created, create a menu selection for the site; in the ltem group select
an ltem Kind of URL..

Note: When there are multiple sites, and this method of access is to be
given, create a menu with each site as a menu item. Ensure that the
menu Security is set to Intranet Admin, or Internet with Profile.

5. Inthe Path / URL parameter, enter a URL in the following format:
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http://www.sitel.metropolis.com/webuserinterface/
webprofile/controls/autologin/
web wp autologin.aspx?webportalsession

Ensure that the URL corresponds with the address of the site. If you want the
link to open in a new browser window, select the Open link in a new window
option. Repeat the above steps for each required website.

Page 26
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Chapter 2:eGovern — Public Self Service
Portal Admin

Overview

Configuration of the eGovern — Public Self Service Portal is carried out with
the Govern New Administration (GNA) Release 5.1 and Govern Admin 10.7 in
Govern for Windows..

Note: The following parameters are to be used for configuring release 4.0
and greater of the eGovern — Public Self Service Portal. Components
that are prior to release 4.0 can be configured, with appropriate
licensing, by the Govern for Windows Govern Admin release 10.6/10.7
application.

The main Web site tab of the Web site editor in GNA release 5.1 is used for
configuration. Under the Web site tab are the sub-tabs used to configure the
various eComponents. The grouping of the tabs are as follows:

General: Select the General tab to configure the Simple Mail Transport
Protocol (SMTP) email parameters (Mail group), the default department that
the Web site will be linked to. See Web site Editor - General tab on page 29.

eProfile: Select the eProfile tab to define default user permissions for the
eProfile and the eComponents. The default permissions can be modified on a
user-by-user basis through the Administration pages of the eProfile. In
addition, Subscription and Password settings are maintained here. See
eProfile tab Parameters on page 69.

ePayment: Under the ePayment tab are the configuration parameters for
configuring online payment options, Credit/Debit cards and Automated
Clearing House (ACH). See ePayment - Setting the Web Parameters on
page 210.

Self Reported Tax: The Self Reported Tax tab contains the parameters and
options for configuring the Self Reported Tax module. See Web Site Manager
- Self Reported Tax tab on page 89.

elnspection: The elnspection tab is used to configure options for the online
inspection module. See Web Site Manager - elnspection tab on page 94.

© 2015 Harris Govern
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Report: Select the Report tab to define the database connection parameters
for Crystal Reports. See Web Site Manager - Report Tab on page 95.

Others: Miscellaneous Billing payments are configured under the Others tab.
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Configuring the eGovern — Public Self
Service Portal

Defaults and Connection Parameters

When users arrive at the home page and access the ePortal, or perform a log-
in to access the eProfile, a default starting point is used from the setup. This
default refers to a department. The default and other settings are part of a
series of steps needed to define the eComponent site. The principal steps are
as follows:

Creating the Web Skin

The Web Skins forms is used to define the look and feel of your Web site.
After this step, you can then configure the menus. To create your web skin,
refer to Create a WebSkin on page 121 of this guide.

Web site Editor - General tab

eComponent configuration parameters are located in the Websites Manager
form in the Govern New Administration (GNA) Release 5.1. See Web Site
Manager on page 62 for a description of the parameters. Follow the steps
below to access the editor and configure the required parameters.

To access the editor...

1. Click Application Configurations (tab) > Web Configuration (group) > Man-
age Web Site.

Govern New Administration (GNA)

-1 8] x
jle . p Editors Utilities Windows Help
@ @ > QPB R S o
Manage | Manage Open Web Real Personal  Motor  AirCraft Boat Business  Accounts Mass Utility
(Web fite| Web Skin Config Editor Exclusion Property ~ Property = Vehicle - Excise - Excise~ Tax~  Receivable - Appraisal ~ Billing ~
Web Configuration General Govern Tax CAMA Utility Billing
——
2 |\,1 Manage Web Site
Web skin |, ] | Web Skin Preview || [=
{ General \( eProfile -IfePaymert \I- ePermit | =inspection \[ =Rer CD
[0 Live Mode [ User Confirmation Required Minimum Payment Amount| |
Cashier D |D|'5play X Previous Payor | | (
- . [ | P - - al
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2. Click New [ to create a new Web site, or select an existing site from the
the list on the left hand pane..

Note: When you click on New, the button changes to Cancel || ; this will
allow you to cancel the creation of the current record. The Cancel
button is present until the new record is saved.

3. Enter a name for the Web site.

Govern New Administration (GNA) -lal x
e
Options Parameters Application Configurations Editors Utilities Windows Help
~
B & B ®© & @ » Q@ @ B @
Manage Manage OpenWeb Roll Forward Real Perscnal  Motor  AirCraft Boat Business Accounts Mass. Utility
Web Site Web Skin Config Editor Exclusion Property = Property * Vehicle ~ Excise» Exciser Tax~ Receivable - | Appraisal ~ Billing ~
Web Configuration General Govern Tax CAMA Utility Billing
8 Manage Web Site X \
Detal ]
,—‘ ! -
Web Site 1d | Web Site Name [BTL_DEFAULT | ([ Menusewn |
Web Skin [ Fort Callins Prod ] [web skin preview]
General \I"/ eProfile \“-’/ ePayment \“-’/ ePermit \“"/ elnspection \“"/ eRemi m
WebSite linked to department | Sales Tax Department N y 7 -
Log File Location f Log CD
Deault County etacetogtie [ |(2)
Maximum rows te display in g1
Button Navigation Layout
r Reports 1

4. Specify a Webskin from the list; refer to the Govern New Administration
(GNA) release 5.1 guide for instructions on creating a Webskin.

Setup Web site Default Parameters

To specify a default department...

5. Select the default department for the Web site from the Web Site Linked
to Department drop down menu.

6. Specify a default Country from the Default Country list.
Secondary Address Indicator |z|
unit  [173¢
Address Line After I
*City INeW York
State / Province New York
*ZinCode  [ioooa

@mtw ] )

E-mail meidres :.........w. u p%"\

Previnus] Next I Cancel]
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7. Enter a numerical value for the Maximum number of Rows that are

displayed in a grid; try to keep the number low to avoid excessive scrolling
on the users side, as in the image below.

eComplaint Application

City Work

Select a property for the application I

Previous Step Next Step

Previous Step J To Continue J

Enter Your Search Criteria

n

Search
Owner status | [ET ]
Last Or Cle / First / Init |A
Include Inactive [
o N
Name and Address Parcel Id Tax Map Number Effective Year Effective Year
[ Geoffrey L Zubay, 1 Shinnecock PI, Hampton Bays NY 11946-1411, 22258 192-201-500-0 1997 9999
[E Frank Voso, 52 Knoll Rd, Riverside CA 92522-0001, 18666 162-200-800-0 1957 9999
[E] Ronald T Bellistri, 221 04 Corbett Rd, Bayside, NY 11361, 18948 164-102-500-1 1997 9999
[0 3&V Auto Salvage Inc, 375 Majors Path, Riverside CA 92522-0001, 24807 212-204-800-0 1997 9999
[ James M Demitrieus, 28 Greenacres Ave, Scarsdale NY 10583-1414, 71227 143-205-100-1 2004 9999
[F1  James M Demitrieus, 28 Greenacres Ave, Scarsdale NY 10583-1414, 16453 143-107-200-0 1957 9999 I} W
[0l constance Calamita, 103 Briarwood Ln, Plainview NY 11803-6403, 16645 145-100-800-1 1997 9999
[  william Rosko, 142 Marys Ln, Riverside CA 92522-0001, 22540 195-202-500-0 1997 9999
[F]  Gaetanto Paino, 12855 N Miami Ave, North Miami FL 33168-4636, 22856 198-201-000-0 1957 9999
[E] John R Nagle III, Bay View Oaks Dr, Riverside CA 92522-0001, 14869 128-104-800-0 1997 9999
[F] Joseph T Sbarra, 115 Edgemere Dr, Riverside CA 92522-0001, 15324 132-100-700-0 1997 9999
[@ Patricia Moore, 109 Bay St, Riverside CA 92522-0001, 18179 157-103-000-0 1957 9999
Mo 12343

Email Communications - SMTP Setup (Mail group)

The Mail group is used to configure email services for the eGovern — Public
Self Service Portal. This can be an address that website errors would be
directed to.

1.

In the Administrator Mail parameter enter the e-mail address of the admin-
istrator that has been designated to receive error messages.

The System Mail parameter is the address that will be used for the from
field in the email message. These are system messages that will not
require replies, e.g. confirmation of user payments.

Enter the host name of your SMTP server in the SMTP Host parameter.
Example: mailhost.domain_name.com, or smitp.sparta.com.

© 2015 Harris Govern
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Specify the SMTP Port; the typical port is 25.

In the SMTP User field enter the username used to access the SMTP
account.

6. Inthe SMTP Password field enter the password used to access the
account. Text entered into this field will appear “cloaked”, i.e. typed letters
will appear as asterisks “ ****** ” to hide the typed letters.

The Web site Footer information (Website Footer group)

Web site footer information can be specified in the Web site Footer group. As
a footer, this information will be displayed on each eComponent page. This
section can contain additional branding information, copyrights, last update
information, etc. (A) You can specify a URL for a page that will be used to
populate the frame. Additional text for the frame can be entered in the Frame
Text field.

|2l Property: 91 Castle Hill Ct
[E property: 93 Castle Hill Ct
O property: 102 Castle Hill Ct

Make a Search By
@ By Parcel 1D
© By Tax Map
@ By Subdivision & Lot
@ By Property Location

mn

@ By Property Owner

@ By Business/ Property Occ
@ By Related Name

@ By TX Mailing Index

@ By UB Mailing Index

@ By Saved Dataset (P_ID)
© From PC__EXTERNAL

\

( The 2013 Harris Customer Conference is scheduled for October 30th to November 1st, 2013 at the Gaylord Palm in Orlando, FL. % i

.

General tab - Website Footer group parameters

Refer to General tab - Website Footer group on page 68 for details about the
Website Footer group parameters.

To specify Website Footer information...

1. Under the General tab of the Web sites editor, look for the Web site
Footer group.

Page 32
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2. Click to select the Display Footer option.
3. If you have a specific page location for the footer, enter the URL.
4. Enter any additional text that is to be included in the Frame Text field.

Note: Text can be formatted with HTML tags to enhance presentation of the
text, i.e. size and font.

Note: Refer to Web Site Manager - eProfile tab on page 69 for details of the
eProfile tab parameters.

Defining the Web site Menus

The eProfile Web Menu Setup form is used to customize the eProfile and
eComponents menu options. As menu selections are created, they are
associated with a Web page, a report, or with a Search Style created through
one of the Dynamic Search editors.

Tip: Before you begin, plan your menu setup. Create all your top level menus
first. You will need to refer to them when you create your second level
items, then the third, fourth and perhaps fifth level items, if applicable.

To access the Web site Menu form...
1. In the Govern NetAdmin (GNA) main screen, select Setup > Web Configu-
ration... > Manage Web sites...

2. Click to select a Web site from the available Web sites column (left hand
side of the Web sites form).

Click Menu Setup in the upper right hand side of the form.

4. In the Web site Menu editor, you can create your menu structure, or if
already created, view the menu that is associated with the selected Web
site.

Web Site Menu Command Buttons

See Web Site Menu Command Buttons on page 48 for a description of the
Web site Menu command buttons.

© 2015 Harris Govern Page 33



ﬂ'ﬂ'
-

eGovern — Public Self 4 ‘!9 HARRIS
»

Service Portal

GOVERN

Web site Menu Parameters

See Web Site Menu Parameters on page 48 for a description of the Web site
Menu parameters.

Creating a Web site menu

Creation of eComponent menus is found in Defining the Web site Menus on
page 33. Refer to eComponent ltem Kinds on page 266 for a description of
the eComponents.

Prior to setting up menus, it is key to have an understanding of the Security
structure, and what the requirements of each menu setting will be. The
security levels are as follows:

* Internet Subscriber - When selected, the security level is set to that of a
subscriber.

* Internet with Profile - This menu selection will be accessible by internet
users with a saved profile, i.e. only internet users with a profile will be able
to see this menu.

* Internet without Profile - This menu selection will be accessible by
internet users with no saved profile, i.e. all internet users will be able to
see this menu.

* Intranet Admin - Set this security level to make this menu accessible to
Administrators within the organization.

* Intranet User - This is the Security level for a user within the organization.

Note: Menus will be filtered based upon security settings. This feature allows
you to customize a specific menu for each of the above user access
levels. For example, when a set of menu’s are created with security
set for Internet Subscribers, those menus will only be displayed to
internet subscribers.

The following menu structure is one example of a layout for a Web site that is
to be accessed by users with an internet profile, and users without an internet
profile. Those without a profile would be casual users, i.e. citizens that come
into the municipal office to search for property information, pay bills. No log in
is required for users without a profile.

The design of the menu structure is as follows:

¢ Home

Page 34
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* Property Based Information
* Online Services

*  Property Information

* Payment Online
*  Misc Payment

* Apply for a Permit

* eRenewal

* eRemittance

* Request for Information

* File a Complaint

* Anonymous Complaint
* Your Profile

* Manage Your Properties

* Manage Your UB Accounts

* Upadate Your Profile

* MS Govern

e Sign Out

Menu Design Grid

With a layout of the menu structure decided upon, the next step would be to
create a grid that would assist in the assigning of the required security
settings. An example would be the following:

MENU SUB-MENU SECURITY
Intranet Intranet w/ Internet Intranet Intranet
Subscriber Profile w/o Profile Admin User

Home + + + + +
Property +
Based Info.
Online + + + +
Services

Property + + + +

Information

Payment Online

Misc. Payment

© 2015 Harris Govern
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MENU SUB-MENU SECURITY
Intranet Intranet w/ Internet Intranet Intranet
Subscriber Profile w/o Profile Admin User

Apply for a Permit + + + +
eRenewal + + +
eRemittance + + + +
Request for Info. + + +
File a Complaint + + + + +
Anonymous + + + +
Complaint

Your Profile + +
Manage Your + + +
Properties
Manage Your UB + + + +
Accounts
Update Your + + + +
Profile

MS Govern + + + + +

Sign Out + + +

The “+” is an indication that the menu will be visible for the required user
setting. For example, the Online Services menu will be visible for Internet with
Profile, Internet without Profile, Intranet Admin, and Intranet Users. Whereas
the Online Services and the Payment Online menu will be made available to
all security levels.
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Anonymous eComplaints

The advantage of the eComplaints (Anonymous) is that the user that is
lodging a complaint is able to do so without an eProfile. Without a profile there
is no indication of user identity. When the user is logged in with an eProfile, the
NA_ID is not attached to the eComplaint, thereby again allowing the user to
lodge the complaint anonymously.

Configuring the Anonymous eComplaint Menu

To create the Anonymous eComplaint menu...

In the Web sites Menu form, click New (1) at the bottom of the form.
Enter Anonymous Complaint (2) for the name of the Menu.

In the item group, specify the ltem Kind as eComponent (3). Refer to
eComponent Item Kinds on page 266 for a description of the
eComponents.

4. For Iltem Name select eComplaint Anonymous (4).

Ms Govern Web Site Menu (CMSDEMO_IXMVLNL |
MS Govern - Beta

Menu [Order By Sequence] Menu
MenulD 9 e Menu Sequence 1
Description Online Payment (Property)

Item

Path / URL

™, Open link in a new window

3

B Use Long Description

¥ Internet s

Security '~I

¥ Intern
jan Payment Inquiny

¥, Intranet user
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5. No entry is required for the Path / URL field (5).

Web Site Menu {CMSDEMO_JXMVLN1 SQL)

6.

Menu
MenulD 9 Menu Sequence 1
Description Online Payment (Property)
Item
Ttem Kind Me P [tem Name B
Path / URL

™, Open link in @ new window

onnnection Key — —

0

B Use Long Description Group [T

Security Parameter
[/ b R
¥: Internet subscriber o ' Nare I Value
%% In e

¥ Intranet admin

¥4 Intranet user

In the Dynamic Search group, the required key is the Parcel ID; click to
select Parcel ID (6) from the Requested Key parameter.

For this example, under the Security group (7), the security requirement
for this menu is as follows: Internet Subscriber, Internet with Profile,
Internet without Profile, and Intranet Admin.

Note: Security settings are based upon user requirements

8. Save the menu; click Save (8).

Limitations of the eComplaints (Anonymous)

Note: There are limitations to the eComplaint Anonymous; although the

process of charging fees to lodge a complaint is not common, for the
eComplaint Anonymous, there should be no fees generated for the
process as there is no profile to charge the fee to.

Page 38
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Configuring a Menu for the eRemittance

The eRemittance component is a customized Self Reported Tax (SRT) report
submission form. A customized Crystal Report will be required if the user is to
be provided with a printable summary of their entry.

To create the menu that will be used to access the eRemittance form...

ite Menu (CMSDEMO JXMVLNI SQL)

irder By Sequence] Menu

MenulD 27 e Menu Sequence 1

Description eFiling (Seff-Reported Tax)

o

Item Kind TS cRemittance

Path / URL Chi m\Reports\DEMO\WEB_SRT_SHEET.rpt

™ Cpen linkinan

Group

Parameter —]
F Name Value I

In the Web site Menu form, click New (1) at the bottom of the form.
Enter eRemittance (2) for the name of the Menu.

In the item group, specify the ltem Kind as eComponent (3). Refer to
eComponent Item Kinds on page 266 for a description of the
eComponents.

For Iltem Name select eRemittance (4).

In the Path / URL field enter the path to the Self Reported Tax (SRT)
Crystal Report that will be used to display the summary information; this is
an optional field.
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6. As the information that is being entered is for the holder of the profile; i.e.
the system will locate any accounts that are linked to the profile, no
parameters are required for the Dynamic Search group (6).

7. For this example menu, under the Security group (7), security
requirements are as follows: Internet Subscriber, Internet with Profile,
Intranet Admin, and Intranet user.

8. Unless a specific parameter like a YearlD is needed for the report, i.e. to
filter the report according to a year, no entry is required.

9. Click Save to save the menu.

When the menu is configured as above, a user selection will display the
designed web form for completion. See eRemittance on page 231 for details
about creating a form with the Self Reported Tax Editor in the Govern
NetAdmin (GNA).
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Creating User Accounts

With required permissions, users can create their own eProfile account IDs
and passwords, as described in Web Interface on page 134.

Alternatively, you can generate an account ID and password for all individuals
and companies in your database through the Generate Internet Accounts
batch process.

To access this process from GovBafch...

1. Select Tools > eComponents > Generate Internet Accounts.

_ax Title  Utility Biling  Self Reported Tax  Import/Export | Tools Help ,

Govern For Windows, .,
Govern Admin,..
Lockbox Data Entry

Menu Securiby Setup. ..

Purge entries in SY_LOCAL_TABLE...

Initializing Mext Year's Data For Property Conkral...
Archive Multimedia Documents. ..

Link Multimedia Files to Parcels »

Audit Trail GOYBATCH Setup...
Automatic Inspection Rescheduling. ..
Generate Workflow from a Recordset

Mame Merge Ukility, .,

Mame and Address Formatting. ..
Export Mames in Mail +4 Format. ..
Import Mames in Mail +4 Format. ..

Format Property Location. .,

Generate Internet Account eComponents

Start Daemon Setver. ..
Purge Entries In Daemon Tables. .

Process Flow Wizard. ..

Query Generator
Ernail Motification

VR |

This process generates an account ID and password for all the individuals and
companies listed in NA_NAMES.

Note: The first time you run the process, it takes a long time to complete, as
information is generated for every record in the table.
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The password is stored in the INTERNET_PWD_U field. This password is not
encrypted. It is used only the first time the user logs in to the eProfile.

Note: The user needs access to the Change Password page. Ensure that
the Allow Password Modification option is selected undet the
eProfile tab of the Web sites form in the Govern NetAdmin (GNA). See
eProfile tab Parameters on page 69, for details.

The organization can generate a report with the newly created account IDs

and passwords.

Rules for Batch Generated Usernames and

Passwords

When the Batch process is used to generate usernames and password, there
are rules that are adhered to in the generation process.

Username Generation Rules

Rules to generate the username for Stephen Jones...

1. In the NA_NAMES table, the first character of the FIRST_NAME, and all
characters of the LAST_NAME are used to obtain a string: e.g. SKING.

2. Any spaces, leading, trailing and in between are removed; for our example

there are none.

3. If there are any special characters from the following list of hardcoded
characters, they are removed:

Special Characters: ~'#$% *&* () _+[1{}|\";

:Illl<>l?.

Character Name

~ Tilde

! Exclamation mark

# Pound sign (Number sign)
$ Dollar sign

Page 42
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Creating User Accounts

Character Name

% Percent sign

A Caret

& Ampersand

* Asterisk

( Open bracket

) Close bracket
_ Underscore

+ Plus

[ Left square bracket

] Right square bracket
{ Left brace bracket (Left curly bracket)
} Right brace bracket (Right curly bracket)
| Vertical line

\ Backward slash

! Apostrophe

; Semicolon

Colon

" Left double quote

" Right double quote
< Less than sign

> Greater than sign

/ Forward slash ()

? Question mark

Period

© 2015 Harris Govern
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Character Name

, Comma

4. After Step 1 to 3, the first 10 characters of the resulting string are used. If
the resulting string is less than 10 characters, the last character of the
string is repeated to pad the string up to 10 characters. For example if the
name resulting after the above 3 steps is SJONES, the S character will be
repeated to give the following: SJONESSSSS.

5. Ininstances, there may be more than one user with the same generated
string after Step 4. In such an instance, the first duplicate will be appended
with three (3) digits starting with 001, e.g. SUIONESSSSS001,
SJONESSSSS002, SIONESSSSSO003, etc.

6. When the final username string has been determined, a randomly
generated password is generated.

The password generated will follow the rules set by the Security Level that in
Govern NetAdmin (GNA). See Password group on page 73 for details.
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Web Configuration Tools

Overview

The Web Configuration tool allows you to modify the look and feel of the
eProfile and eComponent Web sites.

A feature of the Govern New Administration (GNA) is its ability to manage
multiple web sites within the same database, i.e. you are able to manage
multiple sites and their respective files within the same database. For
example, a municipality may require two (2) web sites, one for the city, the
other for the county.

Note: Versions 3.2 and earlier of the .NET Toolkit were only able to manage
one web site per database; the site would have to be used for both the
city and the county.

Accessing Govern for .NET Web Config. Tools

To access the Web Configuration tool in GNA:

1. Click Setup > Web Configuration > “Any of the Web Configuration tools
below”.

Web Site Manager (Manage Web Sites...)

After you set up your WebSkins, you can use the Web Site Manager, to assign
WebSkins to the eProfile and the eComponents associated with the Web site.
Each application can be assigned a different skin to provide a different look
and feel or you can assign the same skin to all components. See Web Site
Manager on page 62 for details.

WebSkin Manager (Manage Web Skin...)

The WebSkin Manager can create customized WebSkins to define the look
and feel of the eProfile and eComponents. This has tools for defining general
layout, title, and sections of a Web page like the head, left and right margins,
and the body. These sections are defined as a skin, assigned a name and ID,
and applied to the eProfile or eComponent with the Web Site Manager. With
the WebSkin Manager, since all your styles and formatting are centrally
located, it is easy to preview your site and make modifications. See Creating a
Web site on page 121 for details.

© 2015 Harris Govern
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Web Config File Editor (Manage Web Configuration...)

Web Configuration editor is used to define and manage configuration
parameters of Govern’s eComponents.. See Web Configuration File Editor on
page 96 for details.
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Configuring Website Menus

Overview

The Web Sites and Web Skins forms are used to create the “shell” that will be
your Web site; after defining the look and feel, you can then configure the
menus. Menu options can be associated with a Web page, a report or with a
Search Style. See Accessing Dynamic Search Configuration Tools on

page 255. The Web Site Menu form is used to create and configure your
menus.

Web Site Menu (CMSDEMO_JIXMVLNL_SOQL)
Menu [Order By Sequence] Menu

= Menu MenuID 13 Menu Sequence 2
00001: Home

00002: My Profile

nline Services

yment E
fU C:\Inetpub\wwiwrootiMSGOVERN\Reports\DEMCAWEBR_NA.rpf
Sl e s Path / URL C\Inetpubywawwr MSGOVERN\Reports\DEMCA\WEB_NA.rpt

Description My Profile

Item —_—

™, Open link in a new window

Report Connection Key ()

eSearch —_—

Apply For a Pe

Permit or Licer Requested Key Style

quest for Inf

B Use Long Description Group
File a Complair

File an Anonyn Security Paramete

¥. Internet subscriber

¥ Internet

B Internet without profile
¥4 Intranet admin

¥ Intranet user Sheyatil
ow

ShowST
ShowPP

Tip: Before beginning, plan your menu setup. Create all your top level menus
first. You need to refer to them when you create your second level items,
then the third, fourth and fifth level items, if applicable. In addition
indicate the ltem Types that will be assigned to each menu item. See
Item Kind on page 49 for details about Item Kinds.
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Web Site Menu Command Buttons

New: To create a new menu item, click New.

Save: Click Save to save the record containing the menuitems. The Menu
Name, Short Description and Long Description are saved.

Delete: Select the menuitem from the list and click Delete to remove it from
the form and from the database.

Default Page: Click Default Page to display the Default Menu Setup form.
This form is used to setup the default page that will be displayed to a user
based upon their Access Level setting. In the Default Menu Setup form you
can click on the drop down menu to select a page that is available for the
security level.

Exit: Click Exit to close the form and return to the Web Sites form.

Web Site Menu Parameters

M e n u [0 rd e r By Se q u e n ce] Web Site Menu (CMSDEMO_GOV006_MICROSOFTSQL20059
COI u m n Menu [Order By Sequence] X

This column (A) will display a list of new
and existing menuitems; each menuitem is .
preceded by its sequence number. Sub- oD e a———
menu items are displayed in a hierarchical R
. 0c ory (Tak)
manner, when available they can be
accessed with a click on the “+” to expand,
or the “-” to collapse them (B).
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Menu group

L)
Menu

MenuID 13 Menu Sequence 2

P

Description My Profile

Thamn

Menu ID: This is a system generated number; this number cannot be
changed by the user.

Menu Sequence: Select the top level menu, or any submenu items. Enter a
number for the order that you want the item listed on the menu. Enter 1 if you
want the item to appear at the top of the menu. Enter 2 if you want it to appear
second from the top, and so on.

Description: Enter the name for the menu item; this is the name that is
displayed on the menustrip.

Note: If a description is not entered in the parameter, the MenulD number
will be used.

Item group

Description

00002: My Prafile -
= Q0003: Online e Ttem —_|

= 2 -
= . Path / URL CAlnetpublwwwroot\MSGOVERN Reports\DEMOAWEB_NA.rpt z

™, Open link in a new window

Report Conmection ey (N
= 00004

00001: Apply For a Pe S 1

Item Kind: Here you specify the kind of link that the menu item is; the options
are as follows:

» eComponent: to call an eComponent item, from the menu option. You
need to select the eComponent item, from the ltem Name drop-down list.
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eComponent Item Kinds

When the option for eComponent is selected in the ltem Kind parameter,
various options are available for selection under ltem Name:

Refer to eComponent ltem Kinds on page 266 in the Appendix for details
about the eComponents.

+ External Component: to call an external component; If you select
External Component, you need to enter the full path in the URL parameter.

Menu: The Menu item kind is used for menu selections that will contain
sub menus. For example, if we wanted an online menu item called Online
to have several menu items underneath it, it would be of ltem Kind Menu.

Note: When the Item Kind is set to Menu, the New command button is
accessible indicating that sub items can be created.

* Report: to generate a report, from the menu item. If you select Report, you
need to enter the full path to the report in the Path / URL parameter. For
example, if we want to offer a menu selection that will provide Property
Information, we could use a Crystal report that will query the database and
display property information.

e URL: The Universal Resource Locator or (URL) is used to open a Web
site in the current window or in a new window.

Item Name: The /ltem Name dropdown list appears only when the

eComponent option is selected in the ltem Kind parameter. Select the Web
page that will be called from the menu item. For example, you can create a
menu option called User Access Rights that will call the Modify User page.

Note: When the eComponent option is selected in ltem Kind, this drop down
menu is activated.

Path / URL: When a selected /tem Kind requires a URL to be provided, enter
the path in the Path/URL parameter. Entries are made using standard HTML
syntax. Only the Menu /tem Kind disables this parameter; all others will leave
it active.

Open Link in a New Window: When this option is selected, the page that
the link leads to will appear in a new instance of the browser window. When

this option is not selected, all links will be presented in the current window of

the Web browser.
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Report Connection Key: In the Report Connection Key parameter, select
the connection key that will be used to access the database that contains the
report.

Note: At this level the connection key that is specified for the Report will
override the connection key specified in the Reports group under the
General tab of the Web Site Manager form. See Report Connection
Key on page 66 under the General tab - Reports group

Dynamic Search group

The Dynamic Search group is used to specify the parameters that will be
required for web searches. These include, the search key, the style, and the

group.

Note: You have the option of assigning either a Search Style, or Search
Group to a menu item, not both.

Requested Key: Select the key to be retrieved by the item, options are as
follows:

e Account Receivable ID

e NamelD
e ParcelID
e PermitiID

«  Utility Billing ID

Note: If you are associating the menu item with a search, in the next step,
select the same Reference ID that you selected for the Key to Retrieve
field on the Search Style Management form. Otherwise, if different IDs
are selected, the one entered on the Search Style Management form
overrides the one selected in this field.

If the menu item is used in a search, select either the Search Style, from the
Style drop-down list or the Group, from the Group drop-down list.

Style: The items that appear in the drop-down menu are filtered by the
selection that is made under the Requested Key parameter

Group: Items that appear in the drop down menu are determined by the
option selected in the Requested Key parameter.
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Use Long Description: Select this option display the Dynamic Search with
the description entered in the Long Description field of the Dynamic Search
Object/Style/Group.

Security group

This feature allows you to specify the level of security that will be applied to
the menu.

* Internet Subscriber - When selected, the security level is set to that of a
subscriber.

* Internet with Profile - This menu selection will be accessible by internet
users with a saved profile, i.e. only internet users with a profile will be able
to see this menu.

* Internet without Profile - This menu selection will be accessible by
internet users with no saved profile, i.e. all internet users will be able to
see this menu.

* Intranet Admin - Set this security level to make this menu accessible to
Administrators within the organization.

* Intranet User - This is the Security level for a user within the organization.

Note: Menus will be filtered based upon security settings. This feature allows
you to customize a specific menu for each of the above user access
levels. For example, when a set of menu’s are created with security
set for Internet Subscribers, those menus will only be displayed to
internet subscribers.

Parameter group

When the ltem Kind option of i
eComponent or Report is selected, the g

Parameter group (A) is activated. This ShowPM
parameter is used for passing on =,
additional parameters that cannot, or
should not be specified by the user of

the web portal.

For example, you can specify a menu option to print a report displaying values
for the last three (3) fiscal years. Since the online user cannot specify the
years for the report, they can be passed to the report through the parameters
group when the report is requested. Click “+” and “-” to add or remove
parameters (1).
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Creating Menu'’s

The Menu item is the top level of your menu hierarchy, it represents your
menu. All items that appear underneath it are represented as they appear on
the Web site.

For example if we look at the following menu structure as it is set up in the
Web site menu editor. We see a menu that will display as follows:

* Menu
Web Site Menu (CMSDEMO_GOV006_MICROSOFTSQL200:
. Home - =
. Menu [Order By Sequence] Menu
. Information J
= Menu
. Property Information 00001: Home
. On Iine SerViCGS 0 nformation
1: Property Informat
. Make Payment 0 nline Services
. lake Payment

. Apply for Permit Apply for Permit

. 0 dmin
. Admin 0 tact Us
. Contact Us
. Greetings from our Mayor
. Log Out

Sub menu items are clearly indented
indicating the structure that they will take
when they are presented on the site as seen
below. You will note that some of the menu items do not appear, this is due to
the security settings that are set for the menu. See Security group on page 52

{2 Welcome to the City of Metropolis - Windows Internet Explorer

@.\_ A || X |§, harriscomputer. com
: File Edit Wiew Favorites Tools Help i

{“f Favorites {,5 £ | Suggested Sites = & | Get More Add-ons =

& welcome to the City of M... 3 | @ New Tab

Metropolis Welcomes You...

¢
VI Metropolis ?

Make Payment
Apply for Permit ;

Official Portal for the City of Me

for details about security settings.
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Adding Menu Levels

Click the menu (1) or submenu (2) item that you want the new menu item to
appear under:

Web Site Menu (CMSDEMO_GOMD06_MICROSOFTSQL20053

Menu [Order By Sequence] Meri.

- (= 5

00001: Home D

00002: Online Services
y 000N+ Dronarhy Natoil T

= DO004: Tax Information
00001: Tax Information
00002: Payment H|ston_.rkTax}
ol ng History (Tak)
i)
00006: Subscriber S«tup
00007 Subscription Plan

For example, in the above menu structure, to create a new submenu item that
will appear under Payment History...

1. Click to select Payment History (1); click New at the bottom of the form.

Item Kind

Path / URL

™ q

eSearch
Requested Key 5

2. Enter a name in the Description parameter.

3. Complete the parameters; click Save.
The new submenu will appear under Payment History.
Note: For example, in the following screen shot Web Portal is a Top Level

menu item (1), Tax Information is a submenu item (2) and Payment
History (Tax) is a submenu (3) item of Tax Informations:

Page 54
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Web Site Menu (CMSDEMO_GOV006_MICROSOFTSQL2005_11)

Menu [Order By Sequenc?o Menu ‘Weh Portal
= Menu el Property Detail
Desaription yweh portal Liility Billing

il 00007: Web Porta
O

00001: Tax Information

00002: Payment History (T

00003: Billing History (Tax
00004: Mass Appraisal Summz
000K 2rmits

Item
Ttem Kind

Path / URL

™, Open link

eSearch

Tax Information P TaxInfarmation
Mass Appraisal Summar e Ry =)
Perrmits

Fermits Summary

Billing History {Tax)

00006: Permits Summary

Requested Key -

Parent: Select the menu item used to access the current item or report.

Note: For example, in the following screen shot, the ePermit solution, Apply
for a Permit is accessed from the Online Services menu option.

Online Services

Payment On Line
Apply Fora Permit
Grievance

Request For Services
File a Complaint

Modifying Menu Levels

Menu levels are modified using a drag and drop action. A single menu or
menu with full submenu structure can be moved or copied.

To modify a menu or submenu level...

1. Click and drag a menu that you want to reposition.
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2. Note the insertion line (A) indicating the possible positions that the menu
item can be placed.
Web Site Menu (CMSDEMO_GOV006_MICROSOETSQL2005_11)
Menu [Order By Sequence]

Menu Id Menu Sequence
= Menu 47 SLTEZT, 7

il 00007: Web Portal Description ywap portal
00001: Prc nperty Deta!'
Ttem

ren o e e

355 Annuisal Su - I )
00007 W ,‘\ Yortal B ¥, Open link in a new window

0000 Ly Report Connnection Key
= DO0O0S: Services

00001: Payment Online eSearch

o e | [ Remested ey (N
00003: Grievance
- - N

Note: If you see a circle with a diagonal slash through it (B), this is an
indication that the menu item cannot be placed at this level.

The interface for creating menu items will only allow you to create the
permitted subitems. For example, only a menu item of ltem Kind Menu will
allow the creation, or repositioning of items underneath it.

Tip: When creating your menus, ensure that the security options in the
Security group are set. Initially you can select all options, until you
review the Web site and determine who will have access.

Copying Menu Levels

A menu with submenus can be copied using the same drag and drop action
that is used for modifying the level, except hold down the Ctrl key during the
action (A). Only release the Ctrl key after you have released your mouse.

Page 56 © 2015 Harris Govern



(‘ ,’ HARRIS Configuring Website Menus
\ GOVERN

3. Note the insertion line (B) indicating the possible positions that the menu
item can be placed.

Web Site Menu {CMSDEMO_GOVD06_MICROSOFTSQL2005_11)
Menu [Order By Sequence] Menu

= Menu Menuld &7 Menu Sequence 5

il 00006: Web Porta Description ywah portal

Item

™, Open link in a new window

Report conenection ke (S

eSearch

st — - (—
-~ QR

Note: When a menu is being copied, a plus “+” symbol appears with the
cursor until the Ctrl key is released.. Always take note of the insertion
line indicating where the menu will be inserted.

Deleting Menu Levels

To delete a menu or submenu item...

1. Select the menu or submenu item from the treeview area.
2. Click Delete
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3. At the confirmation screen, click Yes, to confirm, or No, to cancel. If your
menu contains sub menuitems, you may see the following screen.

Impossible to delete this treeview item, please make sure to delete all
the sub-items from the selected menu treeview.

Crystal Reports in the eComponents

As Administrators, you have the ability to customize the Crystal Reports
supplied with the eComponents. You are able to take a standard report and
with a fully licensed version of Crystal Reports, customize it. The links that
appear within the report can be modified. Refer to Crystal Reports in the
eComponents on page 127 for details about set up and associating with
menu items ..

Dle Edn Yiew |nsent Fomgt Database Bepon Window  Help
DS BISaNS | sBNgo-0- RN M

{ Verdana 0 e A [T A A BeE s e
IMEZCLNN0DMG0 08 28 9 Sk ANBBITO N PM

StatPage  WIDMENURLPORT =
| Design|
'. ) : 'D'_‘,?"V""U""_’.ﬂ_ .............. TR T u....,.u

sty : rzz

%3 Web Portal Demo
v Online Information

Propertv Informa tion

° operty Locabon .
{FORMATED_ADDRESS} Lt

Da rosl 102 {TAX_MAP}
5 ¥ Number: {LEGALY
1aes: {um@.} {LONG_DESC}

Tax Information

Tox Statement Report

Jax Detall For Flscal Year {@Currentfisc | Payg
: .

i Jax Detall For Fiscal Year (@Previousrisc
% Jax Datall For Fiscal Year {@PreviousFis:

Tax litlg

1 utility Billing Information
5 Linity Biling
5

:Ma ss Appraisal Information
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Strategy for setting up menus

As indicated earlier, to create logical and relevant menus it is best to plan
ahead. Take a few moments to decide on which menus will be required for
your Web site.

Step 1 - Plan Your Menus

For a typical site, you can use the following “general” menu options. A grid like
the one below can be useful for planning.

TOP Home Online Admin External Contact | Log
LEVEL Services Application | Us Out
Second Make Subscriber

Level Payment Setup

Third Apply for Subscriber

Level Permit Plan

Fourth Register a

Level Complaint

Fifth Property

Level Information

When the menus that are required are carefully laid out, it is easy to see which
menus and submenus are needed. From the above grid, it is easy to
determine that six (6) top level menus are required. Submenus will also be
required; four (4) for Online Services and two (2) for Administration.

Step 2 - Create the Menus

When Web site and Webskins have been created, use the Web Site Menu
form to create the menus, and link the pages and modules.
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To create menus...

I % Govern New Administration (GNA
File Options System Parameters _ Editors Utilities Windows Help

GIS Configuration

Self Reported Tax Categories »
Govern Tax Manage Web Skin... k
Open Web Config Editor f

- ’4'—“‘0.."-.." *J‘r—&*—w\*mﬂ{

1. Select Setup > Web Configuration... > Manage Web Sites... (A)

2. Inthe Web Sites form, click to select your Web site from the Web Sites
column (1).

3. Click Menu Setup, to display the Web Site Menu form (2).

Web Sites(CMSDEMO_JXMVLN1 SQL)
Available Web Sites -1

R “ weoste [l UGN 1of2 \ e
S ~ . 3 s =
M3 Goveim -Heta o Web S Web Site Name Ms Govern L
MSGOVERN. :
[ General \ eProfile ePayment Self Reported Tax elnspection

WebSite Linked to Department e =nis) Button Navigation Layout m

Default Country [EEHE

Maximum row to display in grid 50

Reports

Report Connnecton Key

In the Web Site Menu form, click New to create a menu.

When created, the new menu item appears in the Menu [Order By
Sequence] column on the left hand side; note how it is listed with its Menu
Sequence number.

6. Enter the Description for the menu, this is the name that will be displayed
on the menu of the Web site.

Follow the process described in Adding Menu levels to complete your menu
structure. See Item group on page 49 for details.
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eComponent Item Kinds

When the option for eComponent is selected in the ltem Kind parameter,
options are available for selection under ltem Name. Refer to the eComponent
Item Kinds on page 266 in the Appendix for details about the eComponents
that are available.

Note: eComponents that are described as “<CUSTOM>" are components
that have been customized for specific clients.
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Overview

With the Web Site Manager, you can create a look and feel for each of your
Web sites by assigning WebSkins to the eProfile and the eComponents. Each
application can be assigned a different skin to provide a different look and feel.

Web Sites(CMSDEMO_IXMVLN1_SQL)

Available Web Sites =
 web site Em 102 \

Ms Govern

MS Govern - Beta ~
. Web Site Id 1 Web Site Name Ms Govern

eb Skin MSGOVERN. "
.‘ ‘General \ eProfile ePayment Self Reported Tax elnspection

o= (88
WehSite Linked to Department S) Button Mavigation Layout

Default Country

Maximum row to display in grid

Reports

Report Conmnection key

Mail
Adminstrator Mail eGovAdmin@msgovern.com
System Mail el
SMTP Host 127.00.1 SMTP Port
SMTP User smtpuser SMTP Password *

Website Footer
¥, Display Footer
Frame Url httpe// st/MSGovem/Skins/MSG/Images/HARRISLOGO48.PNG
Tk omer Conference is scheduled for October 30th to November 1st, 2013 at the Gaylord
Palm in Orando, FL.
Frame Text

The Web Site Manager interface was changed in Release 4.0 of the Govern
NetAdmin (GNA). The interface follows the standard of the other GNA editors.

Note: The parameters described in this section are to be used for configuring
release 4.0 and greater of the eComponents. eComponent
applications that are prior to release 4.0 can be configured, with
appropriate licensing, by the Govern for Windows Govern Admin
application, release 10.6/10.7.
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To access the Web Site Manager:

1. Select Setup > Web Configuration... > Manage Web Sites...

Web Sites Manager Command Buttons

Menu Setup: Click Menu Setup to open the Web Site Menu editor and
create and edit your site menus. See Configuring Website Menus on page 125
for details.

Web Skin Preview: Click WebSkin Preview to display a preview of your
web skin in a window.

New: Click New [] to create a new Web site.

Note: When you click on New, the button changes to Cancel L] ; this will
allow you to cancel the creation of the current record. The Cancel
button is present until the new record is saved.

Save: Click Save [#] to save your new Web site, or any changes that have
been made to an existing site.

Delete: Select an existing Web site from the Web Sites list on the left hand
side, click Delete [1] to delete the site.

Closing the Editor

To close the editor, click the Close Window button in the upper right hand
corner of the form.
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Web site Manager Parameters

Web Siteld 1 Web Site Name  pMs Govern

Web Siin iohiind

r General ‘\

WebSite Linked to Department [EYYRSEIe tc)

Default Country United States

Maximum row to display in gnd 5g

Web site tab

Web Site ID: The Web Site ID contains a system generated number. This
parameter is automatically incremented when a new web site is created.

Note: Take note of the Web site ID number as it is required to be entered in
the Web Config File Editor during the setup of the ePortal Application.

Web Site Name: Enter a name for the Web site in this parameter.

Web Skin: Use this parameter to select a WebSkin from the drop-down list of
saved WebSkins.
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Web Site Manager - General tab

The General tab (A) contains the first set of parameters used to configure your
Web site.

(CMSDEMODEY_BRLSHS1_SQL)

= /TQWT\

S Go L
MS Govemn - B We 1 Web Site Name Ms Govern - A

Test
T (ievsin e
ofile ePayment ePermit eRemit =

Ms Govern - A

elnspection Others

SMTP Port

SMTP Password

Website Footer

Frame URL hi
i

Frame Text

Web Site Manager - General tab parameters (B)

WebSite Linked to Department: Select the name of the department
responsible for the eProfile user accounts, from the drop-down menu.

Note: The same name and address privacy permissions and restrictions, set
for the department in Govern, apply to the Web. Refer to the Super
User guide for full details on name and address restrictions.

Navigation Button Layout

Button Navigation Layout: This option allows you to choose the location
of the navigation buttons for the web page. The options for the feature are as
follows:

« Baseline - Select this option to display page navigation buttons only at the
bottom of the page.
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* Both - When this option is selected, navigation buttons will be displayed at
the top and the bottom of the result page. This option is recommended for
pages that may display results that require the user to scroll multiple pages
to view all results.

* Top - This option will display page navigation buttons only at the top of the
result page.

Default Country: Enter the country to appear in the Default Country line on
the eProfile Creation page. This selection is added to the NA_NAMES table.
Users are free to change this default.

Maximum row to display in grid: Enter the maximum number of lines to
appear in the grids of all the Results pages, following a search.

General tab - Reports group

Report Connection Key: This is the name of the connection key that will
be used to access reports.

Note: The connection key that is specified for Reports at this level is a global
value. Should another connection key be required for an individual
Report located on another server / database, it can be specified at the
Menu level. Refer to the Report Connection Key on page 51. This
parameter is in the ltem group of the Web Site Menu parameters.

General tab - Mail group
In the event of system errors with the Web site, messages will need to be sent

to the system administrator. The Mail group is used to configure the
parameters required to send the e-mail messages.

Administrator Mail: Enter the e-mail address of the administrator that has
been designated to receive error messages.

System Mail: This is the address that will receive system messages that will
not require replies, e.g. confirmation of user payments.

SMTP Host: Enter the host name of your SMTP server. Example: mail-
host.domain_name.com, or smtp.sparta.com.

SMTP Port: Type in the designated port number; the default port is 25.

SMTP User: Specify the username used to access the SMTP account.
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Web Site Manager

SMTP Password: Enter the password used to access the account. Text

entered into this field will appear “cloaked”,
asterisks “ ****** ” to maintain the anonymity of the typed letters.

i.e. typed letters will appear as

Activate email in HTML format: NEW! Select this option to send email
messages in HTML format. As HTML text additional formatting can be added

to the messages. The default format for sending is plain text.

r Mail

Adminstrator Mail |egcvadmin@m5g OVErn.Com

System Mail |egcvsysadmin@m5g CVErn.com

SMTP Host |12?.0.0.1 | SMTP Pon|

M Activate email in Html format

SMTP Password |

M Include Administrator in Email Communication

rWebsite Footer

Include Administrator in Email Communication: NEW! Select this
option to send a copy of the email message to the administrator.

About Error
Conditions

SQLQueryZsql - H..KISVhalonso (63])° | BRI GMLEMS. NDING WEBTRAN | SQLQuerylisql - ., Misthalonso (31))7 |

pelect *

[ Resuls | [y Messages

from cc_pending webtran

SESSION_ID AR_ID AMOUNT  DATE_TRANS TOTAL_AMOUNT PAYOR_ID LATE_CH&RGE

. 1 | 603712354 5000 20114007 100836340 5000 4914 000
Currenﬂy the System W|” 2 T e03e9w7 000 2011101308:44:29.467 D00 #9194 0m
3 vaehSnikdcdecivametichd 603732490 5000 201110-13 084429540 5000 NN 000
generate an error message 4 ziwahwvgqmSdhosdklq 60363327 000 20111013 092643457 0.00 aA9NM 000
. 5  ziwahwpgmeSihutsgglq 603732490 10000 201110-3032643483 10000 49134 00
that IS Sent tO the 6 wemhlusaglaqluabrieuls  BO3533S6 5000 20120105101913620 5000 agE 0o
. . . [a xsv24maZlamnsyvuycdsbre 603593856 5500 2M201311:1117.867 5500 419154 0o
Adm|n|strators e-ma” 8 i2holgudequenzwbinpiid 6036368631 0.00 20120116 15510080 0,00 419134 0.00
5 iZholigrdequonzwbiopiid BOTZETZI 1352 2M20016 105510150 1394 N9 042
add ress When the Nelnet 10 ogdehiedgpkinigcou  BUNZ7SE 4% 20120120 142354413 500 a9 0
11 ukbgStpaliodgBehonii 0327566 1083 201201.20143148403 1035 a9 002
12 cwbowuziebhpgdheSkin 0327556 1083 201201-20143405630 1085 a9 002
EFT prOVIderS syStem 13 AquizgnihpZZ3421 sevhiSvk B03727586 1093 2N2M-2014:3548313 1095 419134 ooz
H 14 idgdpoSukaii3sfugds B03539631 100000  201201-20 154549300 100000 19194 0o
retu rnS a IncorreCt format 15 wpedmdlygOmoSzguewlkannn  B03680597  200.00 201201-2211:06:45023 20000 419194 000
H 16 hepedndygOnoSegelkannn 03746198 045 201201-2311:0645047 000 4919 045
error. When th|S occurs the 17 sbquelblsorgindyeqdiilc  BOI46198 045 201201-2311:3624830 000 49134 045
TR NI L] 18 K02 zste2bfekpfivoh C0E0S07 2500  20120123130044870 2500 anu 00
payment prOCeSS WI” fall 19 Mk021 zets2biSsingf 1 voh 603746198 045 201201-2313:0044887 000 419134 045
. . 20 gvaengpquzibtqXDoymodp B03680597  150.00 2M2001-2317.5221.227 15000 419134 000
and trlggel’ an exceptlon. 2 guenganhicBongd  BMEIE 045 2012317522120 000 a0
. . 2 awipevihygmasrweldddn  B0S0597 854500  20120124101630.053 854500 H919 000
Slnce the payment IS nOt 23 awipevihiZygmasrweldiain  BO3P46198 045 20120124 1016:30.0680  0.00 ANH 045
. 24 cakSechibdgilawiaslool EO3MICS00 644328 20120208151511.300 644229 ane oo
Complete, a ro”back IS 25 cakBudhikdgidmiasgol 603720402 1352 20120208151511357 1405 ANy 0
. 26 3dphahdhollSvsdl2elbdad -1 32300 2012.02-08 155356430 32300 419134 0.00
executed and the detail of 7 vvgdmidobeopdtacsh  BIGSESZ1 77320 20120014 085547477 7720 smm 000
. . . 28 delavdlpziSvikdupcibez 603746198 045 2012023 18:5642567  0.00 419194 045
29 2u2k3zsyh1I0S6a25kwib2a 603593843 100.00 20111013 033353623 10000 419134 0.00
0 2uk3zsyh10SHa2iSkwib2a 603733664 000 20111013 033353653 000 419134 0.00

the transaction is saved in
i 31 elorplsigavinkopenrpuso  B036S0597 20000 201201-2311:0921097 20000 499 000
the fO"OW|ng Govern table 2 egptagimikopenrfoues B0IV4EI98 045 201200-2311:0921.113 000 49134 045
(Table . B lpecpocdqnicpasdh  BOIIE¥ 000 2M201201463231873 000 a9 000
- 34 021yvsopecsiqZzndcyaadh 603745768 3395 2N20-20143231.977 3831 419134 43
CC PENDI NG WEBTRAN 35 ghhodZidovnSpimiuncsShox B03698631  500.00 2M201-20 155043083 50000 419134 Lilli i}
| _ ) 36 sbawwibZacxgimyeqdhidc 603580597 1000 201201-2311:36:24820 1000 419134 000
T hodholovlnkZKipsedp  B0BSOSIT 2100 201201-23124521.703 2100 a9M 000
B hodhorlawOukkipeedp  BOIEI9 045  201201.23124521743 000 4913 045
3 Odvifesehidktikiecucol 6030537 S57.00  201201-23151823050 8557.00 a9 000

(& Query executed successfully.
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Above is an example of data details kept in the CC_PENDING_WEBTRAN
table.

Note: The CC_PENDING_WEBTRAN table will contain all failed
transactions.

E-mail Format

The following is the format of the email message that will be sent:

Subect: “Organization Name” Unsuccessful Nelnet ePayment
Text: An error has occurred while using the Nelnet
ePayment.

Transaction id Transation ID number
Credit Card Payment OR eCheck Payment

Amount: “Transaction Amount”

General tab - Website Footer group

Web page footer information for the eGovern - Public Self Service Portal
Website is specified in the Web site Footer group. As a footer this information
is persistent, i.e. it will be displayed on each eComponent page. For additional
information, please refer to the MS Govern eComponents Release 4.7user
guide.

This section can be used for information like additional branding information,
copyright notices, or last update date. You can specify a URL for a page that
will be used to populate the frame. Additional text for the frame can be entered
in the Frame Text field.

Display Footer: Select this option to enable the Web site Footer option

Frame URL: When a custom HTML page containing the footer information
has been created, the address can be entered in this field.

Frame Text: Enter the text that will appear in the frame. Text that is entered
in this parameter can include HTML tags which will be parsed by Govern.
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Web Site Manager - eProfile tab

Click the eProfile tab (A) to view the parameters used to set the default user
access rights for the eProfile and the eComponents.

1_DURANGO_MICROSOFTSQL2005)
-

(e B o

MS Govern - Beta

Web SiteId 1 Web Site Name Durangol

f eProfile ; \

Allow ePermit
ePermit Display Column 4

ittance application

bscriber Hit Counter

4 Allow Profile Creation Maximum Property In Account 0

Maximum UB Account

Subscription

B Allow Subscriber Creation b fauit Subs s T e

Password

Security Level Minimum Password Size 6

Special character allowed 0+

eProfile tab Parameters

Allow Name / Address / Password / eMail Modification: Select one
or more of these parameters to allow users to modify their Name, Address,
Password, or eMail address. If these options are selected, the Edit button is
displayed beside the applicable information on the Update Your Profile Web
page, otherwise, it is not visible.

Allow Add / Remove Parcel: Select this option to grant Web users the
right to add and remove parcels to and from their eProfiles. This may be
required by professional users, such as contractors, who need to view data
and make payments on other properties in order to obtain permits.
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If this option is selected the Add and Remove Properties buttons are displayed
on the Manage Your Properties Web page. Otherwise, they are not visible.

Allow Add / Remove UB Account: Select this option to grant Web users
the right to add and remove other Utility Billing (UB) accounts to and from their
eProfiles. If this option is selected the Add and Remove UB Accounts buttons
are displayed on the Manage Your UB Accounts Web page. Otherwise, they
are not visible.

Hoeme  Online Services  Your Profile  Administration  Links  Sign Qut Help? English

Utility Billing Accounts in Profile

[ Add UB Accounts ] { Remove J

1 Utility billing accounts found.

00 001 95 Castle Hill Ct
Please refer to our Privacy Pelicy for further details on how your personal information is used

and protected.

Disable Activity Step: This option will allow the user to disable the display
of the outline of the steps followed for completing the activity.

Combine eComplaint, eGrievance, eRequest:

lome  Online Services  Your Profile Aj

. . . . Property Information
Select this option when you would like the eGrievance, S
and eRequest to be combined with the eComplaint. s, Pavment
pply For a Permit U1
eRenawal
T . eRemittance o
Note: If you are combining the three items, you can Request for Information | Add

link it to any one of the components, on the
eProfile Menu Setup form. Also, if the three
components are combined, you need to add a
search. See Defining the Web site Menus on
page 33, for full details on setting up the
eProfile menus.

Ancnymous eCompIa\E!
000

Bypass ePayment on Permit Application: By default, it may be
required to pay a fee that is associated with a permit application before the
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application can be submitted over the Web. Select this option to enable the
bypass for the ePermit.

For example, by default, a fee associated with a permit application needs to
be paid before the application can be submitted over the Web. Select this
option to enable the bypass so that users can submit the application without
making it mandatory to pay the fee online.

When selected,

Note: When selected, this option to enable the bypass for the ePermit will
also affect the eRenewal, eRequest, and eComplaint.applications.

Allow ePayment/eComplaint/eGrievance/ePermit/eRequest:

These parameters are used
to set the default setting for
each of these eComponents.
Note that any settings for an
individual eProfile will
override these defaults.
Select one of the following
options from the drop down
menu (A):

* Not Available - Select
this option if the
eComponent is by
default is not available on
the Web.

* Restricted to Account - When selected this option will provide restricted
access to the eComponent, by default. Users can submit applications on
the properties defined in their eProfile, only.

» Unrestricted - Select this option to provide full access to the eComponent.
Users can then submit an application on any property within the
municipality or organization. For example, contractors may need to apply
for permits on several properties that they otherwise do not want to include
in their eProfile accounts.

N Maximum Property In Account

Maximum UB Account

Note: You cannot select the Restricted to Account option for the eComplaint
component.

ePermit Display Column: This parameter controls the number of columns
that will be displayed in the user added fields. The default setting for
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displaying ePermit columns is two (2); if more columns are required, enter the
value.

Profile group

Allow Profile Creation: When selected, this option grants users the right to
create an eProfile account, from the Web. Deselect this option if the eProfile
accounts are to be set up by the organization. If this option is selected, the
account creation link appears on the eProfile Login page, otherwise the link
will not be presented. See Creating User Accounts on page 41 for details
about generating accounts for users that are present in the database.

Maximum Property in Account: Enter the maximum number of parcels
that users can add to their eProfile. If this field is left blank, users can add an
unlimited number of parcels

Maximum UB Account: Enter the maximum number of Ultility Billing
accounts that users can add to their eProfile. If this field is left blank, users can
add an unlimited number of accounts.

Note: In order to use this option, the Allow Add / Remove UB Account option,
under the eProfile tab, must be selected.

Maximum number of SRT Accounts: Specify the maximum number of
SRT accounts that the user can add to their profile. If the field is blank, an
unlimited number of accounts can be added.

Default Identification: During the account creation process, this is the
default setting that will be used for a new user in the “How can we identify
you” drop down menu parameter.

Use Particule: When the French language option is selected, the “I’”
referred to as a particule, will be used in the user creation of the ePermit.
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Subscription group

Allow Subscriber Creation: Select this option to grant users the right to
create an eSubscriber account, from the Web.

&3 MSGovern

Enter your Account ID and Password

ccount ID govern

Password

Eorgot your account or password?

Eirst-time user? Register here

Buy a Subscription Here

Note: When the Allow Subscriber Creation option is selected, the Default
Subscriber Type will become active.

Default Subscriber Type: This option is active when the Allow Subscriber
Creation option is selected. The subscriber type that is selected will be the
default subscriber type.

Misc. Billing Year: Enter the default year that will be used for Misc. Billing.
Misc Billing A/R Class: Select the A/R class from the drop-down menu

that will be used for collecting the subscription fee. The combination of this
with the Misc. Billing Year will be used for invoicing purposes.

Password group

Security Level: Select a security level for the eProfile passwords:

* Low Security requires alphanumeric characters only.

* Medium Security requires at least one numeric character with alphabetic
characters.
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* High Security requires at least one numeric character and one special
character with alphabetic characters.

Note: The security level selected will determine the complexity of the
password generated by a batch process. See Rules for Batch
Generated Usernames and Passwords on page 42 for options that
affect the rules for generating passwords.

Minimum Password Size: Enter the minimum number of characters for
the eProfile password.

Special Character Allowed: Enter the special characters that will be
accepted in the password. Examples of special characters are @ # $ % & etc.
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Web Site Manager - ePayment tab

The ePayment solution increases the efficiency of bill payment and collection.
It provides the client, or taxpayer, with a secure, fast and convenient method
of paying bills, while providing the organization with a fast and effective
method of tracking payments and maintaining up-to-the-minute account
information.

The Web ePayment Parameters form is used for setting and maintaining the
default parameters for the ePayment data.

{ web site Bmm 101 )

Web SiteId 1 Web Site Name s Govern

f ePayment \

B Live Mode ¥ User Confirmation Required Minimum Payment Amount $0.00

Cashier I Display X Previous Payor

WEB_

Receipt Prefix WER Business End Day

Default Installment : Block RE Payment After

B Disable eSearch Multiple Selection

ACH
¥4 Allow ACH
ACH Batch Suffix WEB_AC
Check Image Path

Convenience Fee

Minimum $1.00 Maximum §1.00 Percentage o

Web Site Manager - ePayment tab Parameters

Live Mode: The MS Govern ePayment (A) sub-system can be used in two
modes: Live Mode, and Test Mode (default mode). Test Mode allows you to
perform simulations on the system with credit card providers in “test mode”.
When the Live Mode option is selected, the sites are to be live on the internet.
Select this option to run the Web site in a live environment.
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User Confirmation Required: Select this option to display a confirmation
of transaction prompt when an online transaction is initiated by a user. When
not selected, transactions will be completed without a confirmation.

Minimum Payment Amount: Enter the minimum amount that can be
accepted for an ePayment, in dollars and cents. If the user enters an amount
that is less than the minimum payment value specified in this field, an error
message is displayed. The user will need to correct this amount in order to
complete the ePayment transaction.

Cashier ID: Enter a prefix for the cashier ID; this ID is comprised of this
prefix followed by the effective date.

Display X Previous Payor: In this parameter “X” represents the number of
previous payors that will be displayed in the list.

D
o2 MSGovern
Management Solutions for Govemmant.
“hidalgo T
Home  Online Services  Your Profile  Links  Sign Out Help? English

Step 3: Select Previous Payer, if you have already made an ePayment, or select a New Payer
and fill in the parameters.

© Previous payer
u

ve.
Montreal QC H4A 2R2

© New Payer
First Name |Olusegur
Middle Name

Receipt Prefix: Enter the sequence that will be used as a receipt prefix. It
consists of a maximum of three characters and is used as a prefix for receipt
numbers (Table: USR_KEY_ RECEIPT)

Business End Day: Enter the
end of the business day, in hours : .
and minutes. This parameter is used Minimum Payment Amount $0,00

for calculating interest and penalty bl o o 3 Q
charges. Charges on payments Business End Day '
accepted after this time will be Block | '

calculated as of the next business
day. For example, if you enter 4:00

Page 76
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P.M., interest on payments received at 5:00 P.M. are calculated as of the next
business day. Interest on a payment received Friday evening is calculated
from Monday morning or the next business day if the Monday falls on a
holiday. Otherwise, payments are processed and accounts are updated in real
time.

Note: It is important that this parameter is set because this value, when
applicable, can affect the result of interest calculations.

Modifying the “Business End Day” Parameter
The Business End Day parameter (A) can be modified as follows:
1. Click in the parameter to highlight the current value.

The numbers must correspond to the hours, minutes, and time of day, i.e. AM
or PM. The format is as follows: HH:MM AB

...where HH is the hour of the day, MM is the minutes, and AB is the time of
day, i.e. AM or PM

Default Installment: Select the A/R installment for which payment is
currently due: first, second, third, fourth or total (Table: VT_ SY_INSTALL). By
default, the installment due is selected on the Web page, as in the following
screen shot.

Note: Leave this field blank if you do not want the default installment to be
selected on the Web page.

This field is required for Real Property Tax payments only.
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hidalgo Hello Hidalgo Exports
Home Online Services Your Profile Links Sign Cut

Step 2: Accept the default or enter the amount you want to pay.

Description Details Amount To Pay

Type Amount

Real Estate 2011

First —
Tax Map Number: 110-101-200-0 Installment $11,383.87 [500.00

Property Location: 9 Clearview Dr
Total Amount: $11,383.87

L

Please refer to our privacy Policy for further details on how your personal information is
used and protected.

Back to Your Account

Block RE Payment After: Specify the date after which all Real Estate (RE)
payments will be blocked. This option might be used when you want to enforce
the requirement that payments must be made by the end of a closing fiscal
year.

Modifying the “Block RE payment After” Parameter

The Block RE payment After
parameter (A) can be modified as
follows:

Minimum Payment Amount $0.00
1. Click in the parameter to o E
highlight the date/month/year. Business End Day 0L

Block RE Payment After /30/200
2. Type the DD/MM/YYYY " r——
required. O -~ e '3" J "f;o
6 7 8 9
OR 13 14 15 16 17 18 19
20 21 22 23 24 25 26
1. Click the Calendar (A) button 2728 2980 31
to display a calendar; select a . [ : Today

date.

There are Left and Right Arrows on either side of the month that will allow you
to scroll through the months of the year (1). To scroll through the years, place
your cursor on the right side of the Month. Up and Down arrows will appear;
click the arrows to increase or decrease the year (2).

Note: On the calendar, click Today to set the calendar to the current date.
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Disable Dynamic Search Multiple Selection: Select this option to
disable the multiple selection feature.

ACH tab

B Disable eSearch Multiple Selection

B Allow ACH
ACH Batch Suffix

Minimum &5 o Maximum &g o Percentage g gopo

Automated Clearing House (ACH) is a secure payment transfer system that
provides a centralized clearing facility for Electronic Fund Transfer (EFT)
payments, occurring within the U.S. and Canada. You can use ACH for all
your electronic payments; for example, to validate authorized debits from your
clients’ accounts for recurring payments. Click the ACH tab (A), to set required
parameters.

ACH tab Parameters

Allow ACH: Select this option to enable ACH transactions.

ACH Batch Suffix: Enter a suffix for the deposit number for ACH payments.
This is appended to the Effective Date of the ePayment.
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Check Image Path: Enter the path to the directory where the example ACH
check image is stored.

JERMIFER LANE
JOHN B I..Jn-NE

T .
T DRBER OF f

'|I.H.-IEI|N.\NI,'|-\I s initids
NCLIRTSE AT WL R IETITLIT b

Hib

RO000B 785G b2 ILSEPE™)O L0 1
Bank ID Account Check

Number Number

This is the default image displayed during the ePayment process when the
user enters the Bank ID and Account Number. You can replace this default
with another image.

Convenience Fee group (ACH tab)

A convenience fee is charged for each credit card transaction made through
the ePayment component, to cover the associated costs, such as, the 2.5%
charged by the credit card company. You need to set the following parameters.

Minimum: Specify a minimum convenience fee.
Maximum: Enter a maximum convenience fee.
Percentage: Enter the percentage of the payment to be charged for the

Convenience Fee. A confirmation screen, showing the calculated amount as

based on this percentage, is displayed to the payer before the transaction is
completed.
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Credit Card / Debit Card / eCheck tab

lock RE Payrffent After 06/08/2011

B Disable eSearch Multiple Selection g
[ Credit Card / Debit Card / eCheck |

Batch Suffix Credit Card \yep cc

ffix Dedit Card
Batch Suffix eCheck
¥ Allow Credit Card B Allow Debit Card B Allow eCheck
Convenience Fee

Use Secondary Account Fee = 'I—

Minimum $1.00 Maxirmum §1.00 Percentage 0.1000

This tab (A) contains the parameters that are required for configuring credit
cards, debit cards, and eChecks.

Credit Card / Debit Card / eCheck tab Parameters

Govern is able to support a selection of Electronic Fund Transfer (EFT)
providers / interfaces. Currently, the providers / interfaces available are the

following:

+ ICVerify

* Pay Connexion

* Moneris

* Nelnet (QuikPAY)
+ PayPal

* Point and Pay

* US Moneris

*  Your Pay

* Paymentus

Note: To configure your Electronic Fund Transfer (EFT) vendor account, see
the Manage parameter below.
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Note: Refer to Appendix E - Electronic Fund Transfer (EFT) section of the
Govern New Administration (GNA) guide for additional details about
supported providers.

Vendor Account: Click on the parameter (A) to display the list of vendor
accounts that are available.

Vendor Account M_ m

%, Master Card Batch Suffix Credit Card g cc e
¥ Visa
Batch Suffix Dedit Card

Batch Suffix eChedk

¥ Allow Credit Card @ Allow Debit Card B8 Allow eCheck

ondary Account Fee = W

Manage: Click Manage (B) to display and manage the selected vendor
accounts in the Vendor Account Management form. Depending on the vendor
that is selected, the Account Management form (B) will display any required
parameters.

Note: To configure your Electronic Fund Transfer (EFT) vendor account, you
will need to contact the vendor and obtain the information that will be
entered in the Vendor Account Management form (C).
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Account (CMSDEMO_JX E_MICRDSOFI’SQDODS)

Account Type

Partner
Vendor

User

Po
Time Out
Tender

itCard B Allow eCheck
L

—— I TS it R 0

Electronic Funds Transfer Process

The Electronic Funds Transfer (EFT) process is similar for each of the
providers / interfaces. For example, PayPal offers the Payflow Pro product for
processing Credit Card and Debit Card payments. Payflow Pro is a secure
online gateway for sending billing information to banks. Banks, authorize,
process, and manage payments that come from online requests. These online
requests containing billing information for orders, are transmitted through the
certified, secure connection that is provided by the Payflow Pro payment
gateway.

The Govern system supports PayPal's Payflow Pro and other EFT provider

transactions by providing forms that contain parameters that are supplied to
the user by the EFT provider.

Steps for Setting up an EFT Provider

User requirements for EFT provider transactions are as follows:

1. A credit card account from the city or organizations business bank to be
supplied to the EFT provider.
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2. An account created by the EFT provider.

Note: This account is not to be confused with a standard web account like a
PayPal account that is typically created online.

3. If Governs’ eComponent is to be hosted on the city’s IIS server, a
certificate from VeriSign, DigiCert, or any other Certificate Authority (CA) is
required. If not, the city must be able to ‘sign’ the site for security and

correctly use the HTTPS protocol.

All Govern required configuration parameters should be requested from the
EFT provider when an account is opened.

File Options Paramete up Utilities Batch Process Windows Help

MO_IXMTLN1_MICROSOFTSQL2005)

tes s
[ weosie BIZIE torn )
Web Sit Narme. s Gover [ tens scive |

Account (CMSDEMO_IXMTLN1_ MICROSOFTSQL2005)
¢ fgeneral __ [ ico Scn Previeu
s ¥

[ ePayment N

1 User Confirmation Required Minimum Payment Amount g5 0

Partner 0
WEB_

Vendor 0
WEB_

ch Multiple Selection

[ Credit Card / Debit Card / eCheck \

Maximum $1.00 Percentage 0.1000

SCRL CAPS NUM INS 0231 PM

V4514 CMSDEMO_JXMTLN1_MICROSOFTSQL2003

The configuration parameters provided by the EFT Provider, e.g. PayPal, are
to be entered in the Account form (C).

When configuring the EFT interface, use the Credit Card/Debit Card/eCheck
tab (B) under the ePayment tab (A) of the Website Manager.

Note: No additional information is required, i.e. file layout information, header
file specifications, etc.
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Specify a Batch Suffix for Credit Card/Debit Card/eCheck

Usually there are multiple transactions that occur on a daily basis. When these
transactions are processed it is often necessary to determine the origin of the
transactions. This suffix is for the deposit number and is appended to the
Effective Date of the ePayment. By specifying a Batch Suffix you are able to
quickly determine, the Electronic Funds Transaction (EFT) transaction, and its
origin. For instance a batch suffix can be used for quick identification of Web
transactions.

Batch Suffix Credit Card / Debit Card / eCheck: Enter a batch suffix for
any of the required parameters, i.e. Credit Card, Debit Card, and / or eCheck.

Allow Credit Card: Select this option to allow credit card transactions.
Allow Debit Card: Click on this option to allow debit card type transactions.

Allow eCheck: Select this option to allow eCheck type transactions.

Convenience Fee

The convenience fee is used for specifying a supplementary charge for a
transaction. This feature will allow you to specify a threshold amount, and or a
percentage value of the full payment. In addition, if required, you are able to
specify an alternate Automated Clearing House (ACH) account to divert the
convenience fee charges to.

Convenience Fee group

Use Secondary Account Fee: Use the Use Secondary Account Fee
option to specify a secondary ACH for handling convenience fee charges.

Minimum: Specify a minimum amount to charge for the convenience fee.

Maximum: Enter a maximum amount that will be charged for the
convenience fee when entered this amount will override any percentage
amount that exceeds the entered value.
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Percentage: Enter the percentage value that will be applied to the payment
amount for the convenience fee when the minimum value is exceeded.

Note: A value must be entered in this parameter; if the option is not required,
then a value of zero (0) must be enterd in the parameter.

Specifying a Flat Rate for the Convenience Fee

When a Percentage value is not specified, i.e. set to zero (0), and a value is
entered in the Minimum parameter, a flat rate will be charged for the
convenience fee.

To specify a flat rate for the Convenience Fee...
1. Enter the amount that is to be your flat rate in the Minimum parameter.

2. Set the Maximum and the Percentage parameters to zero (0).

Disabling the Convenience Fee option

Batch Suffix Dedit Card

Batch Suffix eCheck

B Allow Credit Card @ Allow Debit Card B Allow eCheck

Use Secondary Account Fee —_ m

Minimum 40,00 Maximum ¢0.00 Percentage 0000

Complete the following steps to ensure that the convenience fee option has
been disabled.

To disable the Convenience Fee option...
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1. In the Convenience Fee group, click to select the Use Secondary Account
Fee drop-down menu (1) and select the blank option from the drop down
menu.

B Allow Credit Card @ Allow Debit Card @ Allow eCheck

Minimum $0.00 Percentage (.00

2. Set all parameters to zero (0), i.e. Minimum, Maximum, and Percentage.

3. Click Save.

Site Seal Script tab

Web Skin

B Live Mode B User Confirmation Required Minimum Payment Amount $0.00

Cashier ID Display X Previous Payor

Receipt Prefix Business End Day 5:00 PM
Default Instaliment — Block RE Payment After  12/30/9998 =

B Disable eSearch Multiple Selection

(" Site Seal script \

rtificator.com/seal js?style=norma

<1—end Certificator Smart Icon tag

The function of the Site Seal under the Site Seal script tab (A), is to inform
visitors that your Web site is secure. In order for a site seal to work, you should
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have purchased a secure certificate from a provider like Verisign. A script (B)
that is similar to the following may be provided:

Example:
<I-The Certificator Site[c] Smart Icon tag. Do not edit. -->

<script type="text/javascript" src="https://
sealserver.thecertificator.com/seal.js?style=normal"></script>

<l-end Certificator Smart Icon tag -->

The provided script should then be copied and pasted into the text parameter
under the Site Seal Script tab. This script is included in the page when it is
generated.

Note: Depending on your certificate provider, you will need to contact them
for full configuration instructions.

Payment Option tab

[ ePayment \

B Live Mode B User Confirmation Required Minimum Payment Amount §10.00

MSGOVERN

Cashier ID Display X Previous Payor

Receipt Prefix Business End Day 5:00 PM

B Disable eSearch Multiple Selection

f Payment ﬂplimo.
i Sub System Force Full Payment o

| Aircraft Excise Tax
I Bankruptcy

| Boat Excise Tax

I Business License |l
J Deed [ ]
I Land Management
| Land Managemen... B
| misc. silling [ ]
I Motor Vehicle Exc... ll
| Personal Propert... W
| Real Properiy Tax W
I Seif Reported Tax W

Use the Payment Option tab (A) to enforce which subsystems (B) require that
a full payment be made when users are using the Web.
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Web Site Manager - Self Reported Tax tab

Web Site Name Ms Govern

f Self Reported Tax \ elnspection

B Show only Unfiled Generated Periods
¥ Enable Zero Filler

@ Bypass eRemittance Posting to AR

Select the Self Reported Tax tab (A) of the Web Sites form to configure the
behavior of the Self Reported Tax form on the eGovern Web site.

Web Site Manager - Self Reported Tax tab Parameters

Show only Un-filed Generated Periods: NEW! When there are
municipalities with pre-generated forms for all required period, there may be a
preference to display only un-filed periods. By default, after generating the
forms, all periods will be listed and accessible to the user for completion. To
streamline this process it may be advantageous to display only the periods
that are required for filing. Select this option to hide the periods that have
already been filed.

This option is associated with a Govern Release 5.1 process that is used to
generate required parameters in the SRT form. This process serves as a
means of directing user to complete only the current required form, and
thereby minimizing the occurrence of any incorrect entries. For example when
a pre-generated
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To run the Batch Process, in Govern Release 5.1...
7@ Govern Application MS Govern - Demo oolaniyan EE'—_‘
Home View Options Batch Process Help

g@
Batch
Processes

Accounts Receivable 3

Self Reported Tax Process  » Daily 3

Core System 3 Periodically » dsfrom Imput Tables
Tax Assessment & Billing  » Yearly

Mass Appraisal 3 -~ I x

Interfaces & Options : E'-—-‘
Property Control 3 4
H T

f Parameters \ Schedule

Selection Criteria

; JULIA GOVERN [419194)

I Lx' ‘““RW- - '

ON PazIg

Year Department

2010 Fr————— -

Category

Default Period Period Mumber

O

Period # 1
Pe

Period # 3
Period # 4

1. With sufficient permissions, click to select the Batch Process tab.

2. Click to select Batch Processes > Self Reported Tax Process >
Periodically > Create Missing Filers.
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3. Inthe Special Procedures form, click to select the option for SRT - Create
Missing Filer.

Note: If the error, ClickOnce Batch Shortcut has not been defined, is seen,
you will need to configure the path to the Deploy EZ application under
the Connections tab of the System Registry Maintenance form of the
Govern for Windows GovAdmin application. Refer to the Govern Batch
Processing Interface section of the Govern for Windows Super User
form.

Enable Zero Filer: Auditors may find it preferable to contact organizations
directly when they have no declarations for a required period, i.e. a Zero
declaration file (Zero Filer). By default the option to allow a Zero filer entry on a
Web site is disabled. Select this option to enable the Zero filer option, and
allow on the Web site.

Bypass ePayment on eRemittance application: When selected this
option will skip the payment requirement step when posting an eRemittance.

Note: As of Release 5.0, the above option, Bypass ePayment on
eRemittance application, has been moved from the eProfile tab.

Show Pay Later: After the completion of a Self-Reported Tax filing, the user
is instructed to settle any owed or outstanding amounts. When selected, this
option will display the Pay Later user option (A). This is an indication that the
amounts to be settled may be deferred to another time.

Web Skin
=Profile ePayment I self Reported Tax \

B Show only Unfiled Generated Periods

% Enable Zero Filler

M Punasc =P=-n1|'ﬂo ncting to AR
w Pay La
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Select Year of Submission for eRemittance

Allow Year Selection: Prior to release 5.1 eRemittance users on their
accounts page were only able to file a Self reported Tax report for the current
year. Select the Allow Year Selection option (B) to allow users to select other

available years.
T, VISGOVERN

Genersl eProfile

k

B Show only Unfiled Generated Periods
%4 Enable Zero Filler
eRemittar-= Posting to AR

Show Pav | ah‘—ro

¥ Mllow Year Selection

Online users will observe a modification in the user interface.

Home My Profile Online Services My Profile Setup Administration (eGov) Link

Version: 5.1.1307.4

i

Account Year Name .
Jus g | ERemittance
Select 00001391 [2013[] ety
JULTA G(
Select 00001330 [2013]+] 1000MA select
ST-LOUT
2012
2011
2010
2000 .
No option to select year.
A Account link to
Account Year Name Account
Select 00001356 Sherill Vi J1L6”(_)IuAr(13f1\|<|E§tN\.f5 ite 62
30 Syl M N Suite 62
(2013=] 20 Syt Select 00001391 2013 Bl o s et

JULTA GOVERN

1600 MAIN S5t W Suite 62
Select 00001330 2013 I} ST-LOUIS MO 62007

B e el R )a—o——u—, -

Send SRT Report by Mail: After submitting a report, select this option (B)
to send a .PDF copy of the submitted eRemittance report to the user as an
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email message attachment. The email address that will be used is the one that
is assomated W|th the users eProfile.

’ Self Reported Tax \

B Show only Unfiled Generated Periods
¥. Enable Zero Filler

@ Bypass eRemittance Posting to AR

Un-filed Self-Reported Business Tax Accounts in the eGovern

NEW! Changes have been made to how the system handles SRT accounts.
During the set year, when a user in a profile performs a search, the system will
verify if there are any un-filed accounts. If there are no un-filed accounts, the
system will display a status message at the top of the interface. When un-filed
records are found, the user will be redirected to the filing page to complete the
process. A navigation button has been added to facilitate navigation back to
the home page. The status messages that are displayed by the system can be
customized by the user. To customize the displayed message, you will need
the Resource Editor in GNA Release 6.x. The associated key to be modified is
the following:

WB > WEB_SRT_SELFREPORTEDTAX > CVSSELECTEDACCOUNTS
Active From: Release 6.0.1503.410.

Note: A navigation button has been added to facilitate navigation back to the
home page.

Modifying the Message

li‘ Resource File Editor

Maodule

Function |WEB_SRT_SELFREPORTEDTAX |

Label |CVSSELECTEDACCUUNTS |

English String French string

Select an acc::uunt.| [3 Sélectionnez un compte, [3|

(ROOT) Resource File Name > Module > Function > Key...refer to the GNA
Release 6.0 user Guide for directions on editing Resource Files.
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Web Site Manager - elnspection tab

Select the elnspection tab to configure options for the online inspection
module.

Web Site Manager - elnspection tab Parameters

Allow Change Department: Select this option (1) to allow inspectors to be
able to work outside of their department. When this option is not selected,
inspectors can only work within their assigned departments.

SDEMO_JXMTLN1_MICROSOFTSQL2005)

1
‘ Web Site Emm 10f1 \

Web Siteld 1 Web Site Name Ms Govern

Web Skin

° Fa Allow Change Department

A
f elnspection
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Web Site Manager - Report Tab

The parameters under the Report tab (A) are used to specify Crystal Reports
that are used for the eComponents.

Web Siteld 1 Web Site Name Ms Govern

Web Skin

Crystal Reports

Database Name CMSDEMO
Server Name

User Id

Password

Web Site Manager - Report tab Parameters

Crystal Reports group

Database Name: Specify the name of the Web Information database.
Server Name: Enter the name of the Web Information Database.
User ID: Enter the user ID that is used to access the database.

Password: This parameter should contain the password that is used to
access the database.
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Web Configuration File Editor

Overview

Note: The following requires administrative access to the Govern New
Administration (GNA)

The Govern Net Admin’s (GNA) Web Config File Editor is designed to manage
Govern’s eComponents. With the Web Configuration File Editor, you are able
to define configuration parameters, determine how errors and exceptions are
managed by the system, and set auto login parameters.

To access the Web Config File Editor in GNA, select Setup > Web
Configuration > Web Config File Editor... You will be presented with a
window requesting that you select a .config file. This is your Web site
configuration file.

To locate and select the web.config file:

1. Root Directory... \ InetPub \ wwwroot \ WebUserInterface directory.
Select the file called Web.config; click Open.

Wekb Config File Editor
f Pagel \ Page 2

Link to GovernNetConfig

Directory: Cinetpub\wwwroot\GovernNetConfig.am|

Upload Document(s}
Directory:

Maximum File Size (MB): 0

ID: Organize + New folder

Display Build Version @ Off © On

Name Date modified Type Size

J bin 2/8/2011 1:36 PM File folder
‘ |2 Web.config 2/1/2011 2:54 PM XML Confi...

' F =
Ml Desktop ‘E

& Downloads

Recent Places

4 Libraries
@ Documents

J’ Music

[ Pictures
B8 Videos

18 JXMTLNL
& os(c)
4 olusegune (\\fserver\staff)
S8 NTWIN (W:)

- q . ] »

File name: Web.config + | *.config -
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2. In the Web Config File Editor form, select the Page 1 tab (1) to define the
configuration parameters.

Web Config File Editor

{ Page 1 \ Pape 2

Link to G .':'n"-]r':u_'::-.nﬁgo

Directory: C:\inet publwwwrootiGovernNetConfigmg!

Upload Document(s)
Directony:

Maximum File Size (MB): 0

ID:

DefaultPage

3. Click Select a Web .config configuration file to edit to select the
configuration file for the Web site you are defining or modifying.
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Web Configuration - Page 1 tab

Web Config File Editor
f Page 1 \

Link to GoverniNetConfig

\WCFPropertyControlSe rernMetConfigam|

Upload Document(s)
Directory:

Maximum File Size (MB): 0

Web Site

ID:

Display Build Version @ Off © On

Wekb Config File Editor
I Page 1 \.

Link to GovernNetConfig

Directory: CAinetpub oty WCFPropertyControlSery nNetConfigxm|

Directory: Click... to select the directory where the GovernNetConfig.xml file
is located.
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Upload Document(s) group

Upload Document(s)

Directory: C:\WORK\02_dotNET_Apps\Test Site\Upload

Maximum File Size (MB): 4.814607265625

Directory: Click... to select the directory you are using for uploading
documents from the Web for the ePermit and eComplaint solutions.

Maximum File Size: Enter the maximum permissible file size, in megabytes
(MB), for a file that can be uploaded.

Note: A maximum file size setting of 2MB is usually adequate for most .JPG
documents.

Web Site group

Web Site

ID: 01

SR GERIS WERPORTAL

Display Build Version ANEBPROFILE
WEBPORTAL

ID: Specify a web ID for the site.

Default Page: Select the Default Page drop down menu to specify which
page will be displayed as a default. Options are as follows:

WEBPROFILE - This option is used when users have an existing account.
Users will be required to enter a username and password.

«  WEBPORTAL - Select this option in situations where you would like users
to be able to perform actions that do not require an account, i.e. access
credentials.
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Display Build Version: Click to select the option to display the build
version of the site on the web page. Setting this option can assist during
troubleshooting.

&2 MSGovern

Management Solutions for Govemmant

Sarvices Your Profile Administration Links Test Report Sign Qut

Welcome!
Your profile currently contains the following references:

Web Configuration - Page 2 tab

Page 1

Publishers
Eventlog: © Off @ On

Database: O Off @ On
Email: © Of @ On

File: © Off @ On File Name:

Auto Login

Crystal Report

Publishers group

Parameters in the Publishers group define how logged errors and exceptions
are to be managed by the system.

Note: The difference between an exception and an error are, Exceptions
can be caught and recovered whereas Errors are unrecoverable.
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Event Log: Select On to create an event log. This log that can be viewed
through Windows Event Viewer. By default, the system setting for this option is
On.

SMTP Mail Server: Enter the domain name of the SMTP Server; for
example, mail.mycompany .com

Database: Select On to log errors and exceptions in the SY _EXCEPTION _
LIST table in your database. By default, the system setting for this option is
On.

Mail Address: Enter an e-mail address for the errors to be sent to; for
example astark@mycompany . com.

E-mail: Select On to send errors and exceptions to an e-mail contact; enter
the address in the Mail Address parameter..

Note: Do not turn on this option if an e-mail address has not been entered.
By default, the system setting for this option is Off.

File: Select On to create a log file for any generated errors and exceptions.

Note: Do not turn on this option if a filename for the log file has not been
specified. By default, the system setting for this option is Off.

File Name: Click ... to specify the location of a resource file.

Validate Event Publisher: After selecting your required publisher options,
click Validate Event Publisher to perform a test of all settings that were
enabled in the Publishers group. These are the settings that are set in the
Setup > Web Configuration... > Manage Websites... form.

(4
_~ Web Config File Editor

Page 1

Publishers
Event Llog: © Off

Database: © Off

Email: © Off

File: © Off
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Note: This test will validate that the connections that are based upon user
access privileges are successful. This means that if directories are
accessed, it will be completed based upon the rights that the user
performing the test has. This will in no way be a reflection of the
access rights that may be required by a Web server. Users should
verify that server access has been verified.

Auto Login group

Note: When using the Auto-Login option, ensure that the information being
accessed is not of a sensitive nature.

When you enter your Login and Password information into the Auto Login
parameters, you will gain access to the Web site without having to enter a
login ID or password. This option can be used when continuous access is
required, e.g. a public kiosk for citizens to access property information. This
kiosk site would be configured as a separate Web site that is accessed with a
customized eProfile. As a separate Web site it will also have its own
web.config file.

Note: The Username and Password are encrypted within the web.config
file and any attempt to modify the information within the file will result
in an error.

Crystal Report group

Print Mode: Select whether the user prints using ActiveX or PDF; if ActiveX
is not supported, PDF will be the default.

Display Build Version @ Off © On

Crystal Report ————

Activex
PDF

N

st i <oy cnrion st
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Note: Users of Crystal Reports will need to install the Crystal Reports 2008
runtime on the server hosting the application, and on each client
computer. Refer to the Crystal Report Runtime section of the
DeployEZ™ Installer Guide for details.

Directory: Click... to select the path to the report files.

Installing Web Services over HTTPS

As the information that will often be displayed on the Website may be
personal or sensitive, it may be necessary to install Govern Web services
using a secure intra/internet protocol like HyperText Transport Protocol Secure
or (HTTPS). Installing Govern Web services over HTTPS will require some
modifications to the Web.config file.

Example Web.config file modified for HTTPS

Note: Prior to making changes to your Web.config file, save a backup copy
of the file is case of errors, and a roll back is required.

Below is a sample Web.config file that has been commented to indicate the
locations where switches and custom setting are required. The file can be
edited with a text editor like NotePad.exe.

WARNING: Extreme care should be taken when editing the Web.config file.
Users will notice the syntax for “commenting out” a line. Any text
line that appears between the following characters will not be
executed;
<!-- Text that appears between the brackets -->
...will be taken as a comment.

<?xml version="1.0"?>
<configurations>
<appSettings>
<add key="MSGovern.GovernNetConfig" value="C:\MSGovern\GovernNetConfig.xml"/>
<add key="MSGovern.SynchFileAndFolders" value="FALSE"/>
</appSettings>
<system.web>
<compilation debug="true" strict="false" explicit="true" targetFramework="4.0"/>
</system.web>
<gystem.serviceModel>
<bindings>
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<basicHttpBindings>
<binding name="soapBinding" maxBufferSize="2147483647" maxBufferPool-
Size="2147483647" maxReceivedMessageSize="2147483647">
<readerQuotas maxDepth="2147483647" maxStringContentLength="2147483647"
maxArrayLength="2147483647" maxBytesPerRead="2147483647" maxNameTableChar-
Count="2147483647" />
<security mode="None" /> <!l--When HTTP -->
<!-- <security mode="Transport" /> --> <l-- When HTTPS remove brackets and comment out the line
above -->
</binding>
</basicHttpBinding>
<webHttpBinding>
<binding name="webBinding" maxBufferSize="2147483647" maxBufferPool-
Size="2147483647" maxReceivedMessageSize="2147483647">
<readerQuotas maxDepth="2147483647" maxStringContentLength="2147483647"
maxArrayLength="2147483647" maxBytesPerRead="2147483647"
maxNameTableCharCount="2147483647" />
<security mode="None" /> <!--When HTTP -->
<!--<security mode="Transport" /> --> <!-- When HTTPS -->
</binding>
</webHttpBinding>
</bindings>
<behaviors>
<serviceBehaviors>
<behavior name="MyServiceBehavior"s>
<!-- To avoid disclosing metadata information, set the value below to false and remove the
metadata endpoint above before deployment -->
<serviceMetadata httpGetEnabled="true" /> <!--When HTTP -->
<l--<serviceMetadata httpsGetEnabled="true" />--> <!-- When HTTPS -->
<!I-- To receive exception details in faults for debugging purposes, set the value below to true. Set to
false before deployment to avoid disclosing exception information -->
<serviceDebug includeExceptionDetailInFaults="false"/>
</behaviors
</serviceBehaviors>
</behaviorss>
<services>
<service behaviorConfiguration="MyServiceBehavior"
name="MSGovern.WCFServices.SV_AccountsReceivableAPI">
<host>
<baseAddresses>
<add baseAddress="http://localhost/Services/SV_AccountsReceivableAPI"/>
</baseAddresses>
</host>
<endpoint address="soap"
contract="MSGovern.WCFServices.IAccountsReceivableAPI"
binding="basicHttpBinding"
bindingConfiguration="soapBinding"
name="HttpEndPoint" />
</service>
</servicess>
<serviceHostingEnvironment multipleSiteBindingsEnabled="true" />
</system.serviceModel >
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<l-- Web Server -->
<system.webServers>
<modules runAllManagedModulesForAllRequests="true"/>
<validation validateIntegratedModeConfiguration="false"/>
</system.webServer>

</configurations>

After completing modifications to Web.config file

After completing the required modifications for HTTPS, save the changes to
the file and close it.
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Web Skin Manager

Overview

A “skin” is a term used to refer to the appearance of the user interface (Ul).
Consequently a “WebSkin” refers to the appearance of the Ul in a web
browser. A WebSkin will present a Web application with a different look and
feel, but the behavior of the U/ will not change.

With the WebSkin Manager, you are able to customize the look and feel of the
eProfile and the eComponents. The WebSkin Manager contains tools for
defining the parts of the layout, e.g. title, head, header, footer, left and right
margins and body, of a Web site. These parts are defined as a “skin”, assigned
a name and ID, and then selected for the eProfile or an eComponent through
the Web Site Manager.

Typically the Webskin Manager can be used to replicate the pages of your
Web site that will contain restricted access eProfiles and eComponents. For
example, the pages that are duplicated can contain eComponents that allow
citizens to access information for outstanding tax balances, make payments
online, or apply for permits as contractors.

Using JavaScript

Your non-eComponent pages, i.e your main Website, can contain JavaScript
code that may be used for linking to other pages or as text fields that are used
to enter search phrases. Embedded JavaScript code can be executed on a
Web page; using them in pages with eComponents may result in
unpredictable results.

WARNING: When duplicating your pages, avoid including any JavaScript
code or components. JavaScript components can interact and
impact negatively with the eComponents. This can lead to non-
functional or “broken” web pages.
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To access the WebSkin Manager.:

File Options Parameters Utilities Batch Process Windows Help
Editors 3
GIS Configuration

,
OpenForms Configuration v
,

Dynamic Search Configuration

Manage Web Sites...

Weh Confin File Feitor_..
WebSkin Manager (CMSDEMO_IXMTLN1_MICROSOFTSQL2005)

Avail List ~
(wesen LI 1o )
e

WebSkin ID WehSkin Name

2 MSGOVERN

f Layout Type act rt ter Sec ! ce \
©Q Full width header and footer @ Full height left and right border

Header Section Header Section

MS Govern
Section

MS Govern
Section

Left Section
Right Section
Left Section
Right Section

Footer Section Footer Section

Wiew Skin Preview

1. Select Setup > Web Configuration... > Manage WebSkin... (A)

HTML and the WebSkin

Some of the tabbed sections of the WebSkin manager allow you to include
custom HyperText Markup Language (HTML) code to your WebSkin.
Customization also allows you to add JavaScript code and include or
reference Cascading Style Sheets (CSS).

HTML Primer

In order to add HTML customization to WebSkins, it is good to have an
understanding of basic HTML. For in-depth explanations, various text
references are available from most stores that sell programming books. In
addition, numerous “go to” resources can be found on the Internet.
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The structure of a basic HTML document is as follows:

HTML Mested Structure
<HTML:
— <HEAD>
This section contains general information
about the document.
<TITLE>
This is the title of the page as it appears
on the browsers title bar,
</TITLE>
L </HEAD>
— <BODY>
This section contains information that is
generally displayed in the browser.
— </BODY>
</HTML=>

There are four (4) primary “tags” used in HTML.:

+ <HTML>
+ <HEAD>
* <TITLE>
+ <BODY>

There are two (2) principal parts to the HTML document, they are the “HEAD”,
and the “BODY.” An HTML document starts with the <HTML > tag and ends
with the closing </HTML> tag, note the “/” that is used for the closing tag.

Applying HTML Tags

In the following example, we want to make text appear as bold. To do this we
would surround the block of text with the following:

<B>This text block will appear Bold!</B>

If we want part of the sentence to appear ltalicized we can “nest” the tags as
follows:

—1 |

<B>This text block will appear Bold, and this part <I>ltalic.</|></B>
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The opening tag “turns on” the bold option and the closing tag turns it off; if the
closing tag is not present, all text after the tag will appear as bold until it
encounters a closing tag. The ltalic tag is “nested” within the bold tag.

This methodology of using opening and closing tags is the general rule for
HTML. Exceptions exist where only an opening tag is used.

Paired HTML Tags

Tag Name Tag Used Comments
Bold <B></B> Bold
Italic <|></I> Italic
Paragraph <p></p> Plain
Font <font face="Arial” color="#FFFFFF” | Not
size="5"> recommended
- The font name must appear as it for use; use CSS
does in your fonts folder instead.
- Colors are defined using Octal

Single Tags
Tag Name Tag Used
Horizontal Rule <HR>
OR
<HR WIDTH="50%">
The rule is specified as 50% of the page size
Break <BR>
Non-breaking &nbsp
Space
Image and Source | <IMG SRC="URL">
The path to the image must be specified. Ex.
<IMG SRC="C:\IMAGES\MyPic.gif">

See Appendix E: HTML Tags on page 281, for a list of common HTML tags.
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Creating a WebSkin

To create a WebSkin:

1. Select Setup > Web Configuration... > Manage WebSkin...
2. Click New (1) on the Webskin tab.

WebSkin Manager (CMSDEMO_IXMTLN1 MICROSOFTSQL2005)
W RILIM -0
‘WebSkin ID Web5Skin Name

Gaslight Village

AT TR T A

O Full width header and facter @ Full height left and right border

L SO
T (e BO@ o)

WebSkin ID WebSkin Name

7

{ layouttype '\

O Full width header and footer @ Full height left and right border

Header Section Header Section

MS Govern
Section

MS Govern
Section

Left Section

Right Section
Left Section
Right Section

Footer Section Footer Section

3. A Webskin ID is generated in the WebSkin ID (1) field; this field cannot be
changed.

4. Enter a name in the Web skin Name (2) field. This is descriptive and is for
informational purposes only.

5. Define the WebSkin properties, as described in this section.
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6. Display a preview of the WebSkin, by selecting the View Skin Preview
button (3).

Navigating the Webskin Manager tabs

There are a total of eight (8) tabs in the Webskin Manager form. Depending on
the size of the form, some tabs may become hidden. You can expand the
width of the form by placing your cursor at the side, or any one of the corners
of the form until a double headed arrow appears, click and drag to expand.

To view hidden tabs...
S)e)

1. Click the left and reverse buttons (1), (2) that appear on the
last tab (A). When there are no hidden tabs, this tab will not

be visible.

(CMSDEMO_JXMTLN1_MICROSOFTSQL2005)
(e BOE o

WebSkin 1D WebSkin Name

o
{ Layout Type \

© Full width header and footer @ Full height left and right border

N1_MICROSOFTSQL2005)
Header §

MS G [Rms
Sect|

=
=]
[=]
]
]
=
]
-

O Full w er and footer @ Full height left and right border

:

Header Section

MS Govern
Section

MS Govern
Section

Right Section

Left Section
Right Section
Left Section
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Layout Type tab

The first step is to select a layout type for the Web site; two (2) layouts are
available.

» Select Full width header and footer to extend the header and footer to
the full width of the Web page with the left and right borders extending only
between the top and bottom border.

+ Select Full height left and right border to extend the left and right
borders to the full height of the Web page with the header and footer
extending only between the left and right border.

Web Page Section tab

Click the Web Page Section tab to define general properties for the WebSkin.

-1

{ webskin ﬂmm 60f6 )

WebSkin ID WebSkin Name

Gaslight Village

f Web Page Section \

Web Page

Web Page Margins
For Internet Explorer Table Layout

Left 0 Width

Right 0 ! [ MediumSlateBlue
0 i

Top

For Firefox

Height 580
Width 780 Cell Spacing

Cell Padding
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Default Web Page Title: Enter the title for the Web page. This appears in
the title bar of the browser. The title is included in the Head section as follows:

<TITLE>Govern.WEB Demonstration Page</TITLE>

Sometimes, the title information is used, by some search engine robots, with
the keywords, to create an index for the page. This index information is
displayed when users query the search engine.

Web Page Background Color: Extend the drop-down list (A) to define a
background color (1) and do one of the following.

Web Page Margins
For Internet Explorer Table Layout

Left 0 Width
Right 0 Back Color
gop 0 Border Width

Border Color
For Firefox
Height - Alignment

Width 780 Cell Spacing

Cell Padding

conte
Radius 050 = 050 =

« Select a customized color, use a standard Web color, use a standard
Windows color, or enter the Red, Green, Blue (RGB) or hexadecimal (hex)
value.

OR
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Select the color sampler (Eye Dropper icon) (A), click, hold, and drag the
eyedropper over any area on your desktop; this will use the sampled color
as a background colour.

Table Layout
Width

Back Color

Border Width

Border Color

Alignment

Cell Spacing

Cell Padding

Web Page Margins group

For Internet Explorer: For displaying the Web page in Microsoft® Internet
Explorer (IE), enter a value for the Left, Right and Top Margins.

For Firefox: For displaying the Web page in Mozilla Firefox®, enter a value
for the Margin Height and Margin Width.

Tip: Enter values for all parameters in order to support both of these popular

browsers.

Table Layout group

This section controls the Layout Table section of the Web page. This is the
area between the header, footer and left / right borders; i.e., the Govern area.

Width: Enter a value for the maximum width of the layout table.

Back Color: Select a color or enter a value for the background color of the
table, as described under Web Page Background Color on page 113.

Border Width: Enter a value for the width of the borders.
Border Color: Select a color or enter a value for the border.

Alignment: Select the alignment for the elements in the table; options are
Center, Left, or Right.

Cell Spacing / Cell Padding: Enter values for the spacing and padding of
the cells.
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Head Section tab

Click Head Section to define the information for the Head section of the Web
page. The Head Section (1) of a Web page contains keywords, meta tags,
Javascripts and references to CSS files. Meta Tags may be used by search

engines, such as Google, Bing, and Yahoo, to categorize and rank your Web
site in a search result.

WARNING: When duplicating your pages, avoid including any JavaScript
code or components. JavaScript components can interact

negatively with eComponents, resulting in non-functional or
“broken” web pages.

You can add other information, such as links to Cascading Style Sheets
(CSS). If there is nothing to be added, the Head Section may be left blank

‘WebSkin Manager (CMSDEMO_IXMTLN1_MICROSOFTSQL2005)
Available WebSkin List =1

((wesn BICII o)

WebSkin 1D WebSkin Name

MSGOVERN

[ Head Section '\

ity of Metropolis’

ox should be displayed.

<img src="htip://gov006.harmiscomputer.com/Metropolis/images/MetropolisMastHd.jpg” height="89" width="794"

View Skin Preview

Note: The CSS file for the eProfile and eComponents is handled separately.

However, you can include a link to an external CSS file for controlling
other properties on the header, footer, left or right margins
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WebSkin Layout

The sections of the layout and the borders are illustrated in the following
screen shot:

@ WebSkin Preview (CMSDEMO_GOW006_SQAL)

polis Welcomes You... ,
Metro

Copyright c. 2003 Gity of Metropolis Footer. Se cti on

Header, Left, Right and Footer Sections

Select these sections to define the properties for the borders of your Web
pages.
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WebSkin Manager (CMSDEMO_IXMTLN1_MICROSQFTSQL2005)
le WebSkin List =
((wewsen LI coe )

WebSkin ID WebSkin Name

7 Gaslight Village
Gas!lht\u’lllae Gaslight Village

‘ Header Section ‘

Cell Width
Cell Height

Herizontal Align

Vertical Align

Background Color

Background Picture

Custom HTML code to include

<table styl

(3] i)

Cell Width / Cell Height: Enter a value for the cell width and the cell height.
Note: You can enter the value in pixels (px) or as a percentage.

If you are using a percentage, you need to specify this, otherwise the
browser will interpret the entered value as pixels.

It is highly recommended to use the same type of value for all
sections: i.e., the Head, Footer, Left and Right sections

Horizontal / Vertical Align: Use these options to specify positioning within
the cell.

Background Color: Select a color or enter a value for the background color
of the table, as described under Web Page Background Color on page 113.
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Background picture: Select this option if you are adding a background
image to the selected area; i.e., the header, footer, left or right border. Then
enter the file name and extension in the text box.

Note: Specify a URL for the image.

Custom HTML code to include: Enter any additional HTML code you
want to add to the header, footer, left or right section.

MSGovern Section

Select the MS Govern Section to define the properties for the Govern section
of your Web pages.

WebSkin Manager [CMSDEMO_IXMTLN1 MICROSOFTSQL2005)
(e DO o\

WebSkin ID WebSkin Name

7 Gaslight Village

{ WsGovemn section '\ 'e \

Cell Width
Cell Height

Hernizontal Align

White

R [ 1. 255
o — \_‘
B 255 [ IA)

i 1N

Cell Width: Enter a value for the cell width.
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Cell Height: Enter a value for the cell height.
Note: You can enter the value in pixels or as a percentage.

If you are using a percentage, you need to specify this, otherwise the
browsers interpret the value in pixels.

It is highly recommended to use the same type of value for all
sections: i.e., the Head, Footer, Left and Right sections.

Horizontal Align: Select center, right, left or none specified for the
horizontal position of the Web site.

Vertical Align: Select top, middle, bottom, baseline or none specified for the
position of the Web site.

Background Color: Select a color or enter a value for the background color
of the table, as described under Web Page Background Color on page 113.

Click Save; then Exit to complete the WebSkin setup.
Editing a WebSkin

To edit an existing WebSkin:
1. Select an existing WebSkin on the Web Skin Manager (A).

Web5kin Manager (CMSDEMO_IXMTLN1_MICROSOFTSQL2005)

[ webskin Em 4065 )

o‘ WebSkin ID WebSkin Name
100%

6 San Innocenti

@ Full width header and focter O Full height left and right border

Header Section Header Section

MS Govern
Section

MS Govern
Section

Left Section

Right Section
Left Section
Right Section

Footer Section Footer Section
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2. Modify any existing parameters under the WebSkin tab (B); refer to the
setup for the creation of a new WebSkin for details. See “Creating a
WebSkin” on page 110.

3. Display a preview of the WebSkin, by selecting the View Skin Preview
button.

4. Click Save and Exit.

Deleting a WebSkin
To delete a WebSkin:

1. Select the WebSkin in the WebSkin Manager list box.

1. Click Delete [i1] on the WebSkin tab.

2. Click Yes on the confirmation message box to delete the WebSkin.
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Creating a Web site

Following are the steps used to create a basic eComponent Web site:

Create a WebSkin

The WebSkin can be described as the theme or look of your Web site.
Creation of the WebSkin is the recommended first step when building a Web

site.

1. To create a new WebSkin, select Setup > Web Configuration... > Manage
WebSkin...

2. In the Web Site Manager click New. (1)

WebSkin Manager (CMSDEMO_JXMTLN1_MICROSOFTSQL2005)

-1
(e B
D

WebSkin ID

]

3. Inthe WebSkin Manager form select the layout style of your Web site;
complete all additional forms. See Creating a WebSkin on page 104 for

details.

WebSkin {CMSDEMO_IXMTLN1 MICROSOFTSQL2005)

Available in List -1
MSGOVERN weosan  EICIMD 1ors
_Mai

WebSkin ID WebSkin Name

f Layout Type \

© Full width header and footer @ Full height left and right border

Header Section Header Section

3

MS Govern
Section

MS Govern
Section

Right Section

5 c
2 S
2 g
@ (7))
= =
(=] ©
o -l

Left Section

Footer Section Footer Section
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Create a New Web site

Once you have created any required WebSkins, create the Web site and
attach the WebSkin to it.

1. Select Setup > Web Configuration... > Manage Web Sites...

2. In the Web Sites form, click New (1); a number is automatically generated
in the Web Site ID parameter (2).

DEMO _IXMTLN1 MICROSOFTSQL2005)
~ 1

Siteld 2 Web Site Name  Generic Site

feate a new item
Web Skin _

! General \

WebSite Linked to Department

3. Enter a name that will be used to identify the Web site in the Web Site
Name parameter (3).

4. Select a WebSkin from the WebSkin drop-down menu (4).

Previewing a Web site

As you are building your Web site, it is recommended that you periodically
preview how your Web site will look with the WebSkin.
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1. Click WebSkin Preview (A) to display your Web Site with a selected
WebSkin.

CMSDEMO_JXMTLN1_MICROSOFTSQL2005)
=

( weose  BIEIME 2oz '\
Web SiteId 2 Web Site Name Generic Site o
. _________—— v

f General \

WebSite Linked to Department

5 WebSkin Preview (CMSDEMO_JXMVLN1_SQL]

- WebSkin Preview (CMSDEMO_JXMVLN1_SQL

Help| Language

N HEAD SECTION --> Section Section

nvinl.hammiscomputer.com/MSGOVERN/Skins/MSG/images/favicon.ico” />

#FFFFFF" BORDER
MARGINHEIGHT =

="center">

While previewing your Web site (B), you are also able to view the source code
(C) for your page in the same window..

Note: When you click View Source in the WebSkin Preview window, the
View Source button will change to View Preview when the source
code is displayed in the preview window.

Adding Menu items

To add menus to your Web site...

2. Click Menu Setup to access the Web Site Menu setup form.
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3. Click New to create a new menu item; enter a description in the
Description field.

4. Change the Menu Sequence by changing the number that appears in the
Menu Sequence parameter.

Editing a Web site

To change the parameters of an existing Web site...

1. Select the Web site from the Web Sites (A) list on the left hand-side; when
selected, the parameters for the site are displayed on the right hand side

(1).

2. Make any required changes to the parameters.

b Sites (CMSDEMO_JXMTLN1_MICROSOFTSQL2005)

-

.4 —
Q ‘ Web Site ﬂmm 2074 \

Web Site Name Generic Site

WebSite Linked to Department [ < Offi
Default Country R kee o
Maximum maspla_'.-‘ ingrd g
e.com

Smtp Host Smtp Port _3

Adminstrator Mai  adpr

System Mail

Smtp User Smtp Password

Website Footer
@ Display Footer

Frame Url

Frame Text

3. If necessary, select different skins, from the drop-down lists as required.

Deleting a Web site

To delete a Web site:

1. Select the Web site from the Web Sites list (1) of the Web Sites manager.
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2. Click Delete (2).

Web Sites (CMSDEMO_IXMTLN1_MICROSOFTSQL2005)

Metropolis Web SiteId 2 Web Site Name Generic Site

Gotham ~
L
f General \

WebSite Linked to Department ASSWN

3. Click Yes on the confirmation message box.

Website Menus

For an understanding of the steps involved in creating menus and related
activities, refer to the steps below:

* Creating Menus - See Creating Menu’s on page 50

* Adding Menu Levels - See Adding Menu Levels on page 52

* Modifying Menu Levels - See Modifying Menu Levels on page 53
+ Copying Menu Levels - See Copying Menu Levels on page 54

* Deleting Menu Levels - See Deleting Menu Levels on page 55

Configuring Website Menus

The Web Sites and Web Skins forms are used to create the “shell” that will be
your Web site; after defining the look and feel, you can then configure the
menus. Menu options can be associated with a Web page, a report or with a
Search Style. See Accessing Dynamic Search Configuration Tools on

page 261. The Web Site Menu form is used to create and configure your
menus.
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Web Site Menu (CMSDEMO_GOV006_MICROSOFTSQL2005_11)

Menu [Order By Sequence]

= Menu Menuld 35 Menu Sequence 4
- Description. wajs payment

Item

— |

Path f URL

™ Open link in a new window
Subsc stup

Subscription Plan eSearch ]

el optaton | | Reauested ke (RN HF I
ntact Us

00011: Help

Search by Namgs
¥ Internet subscriber Search by Permit (linked to a name)
¥ Internet with profile
¥ Internet without profile
B Intranat admin
B Intranet user

Security Paramet ]

Tip: Before beginning, plan your menu setup. Create all your top level menus
first. You need to refer to them when you create your second level items,
then the third, fourth and fifth level items, if applicable. In addition
indicate the ltem Types that will be assigned to each menu item. See
Item Kind on page 47 for details about Item Kinds.

Web Site Menu Command Buttons and Parameters

For details about the Web Site menu Command Buttons and Parameters,
refer to Web Site Menu Command Buttons on page 46 and Web Site Menu
Parameters on page 46.

Strategy for setting up menus

For steps to successfully set up menus, refer to Strategy for setting up
menus on page 57 for details.
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Crystal Reports in the eComponents

A feature of the standard Crystal Reports supplied with the eComponents is
the ability to customize them. Users are able to take a standard report and
customize it with a fully licensed version of Crystal Reports. The links that
appear within the report can be modified.

A= 8 &

§, Verdora < w m];millill_nvm £ & 2
'-'Eirl;;ﬁ\uﬂh*‘a DBt 7 - AKL NS DN
SatPage  WIDMENURIPORT =

&3 web Portal Demo

Online Informaﬂnq

Property Information

{FORMATED_ADDRESS} Owmert
e} (TAX_MAP}

umbsar: {LEGAL)

{CLASS} {LONG_DFSC)

Tax Information

Tax Statument Report
Jox Dt £ ise , Payo-t— —a—
Tax Det ol Yeor {@Previoushiacs 4 |
ax Detail For Fiscal Yeor { @PreviousTisc iy rommag e
tax title | o Feamat fuinter
4 Z |
Utility Billing Information :“::*r ;
ind Sort Control.
Iality Bl
Lty Billing —
Mass Appraisal Information Sige hed Pedition
s CMlow pad

WLow

To fully understand this concept, let us first look at a a typical report and how
to set it up as a menu on the Web site. In the following example, we will create
a menu selection called Property Information. Property Information is a
submenu of Information.

To setup the menu...
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1. In GNA, select Setup > Web Configuration... > Manage Web Sites

. GovernNetAdmin Application (GNAA

File Options F‘arameters- Utilities Batch Process Windows Help
Editors
GIS Configuration

OpenForms Configuration ,

Dynamic Search Configuration  »

Manage Web Skin...
‘Web Config File Editor...

el et P e N i PO
2. In the Web Sites form, click to select your Web site (A)
3. Click Menu Setup (1).

Web Sites (CMSDEMO_JIXMTLN1_MICROSOFTSQL2005)

£
{
b
s

(om @OE o)
Metropolis Web SiteIld 2 ‘Web Site Name  Generic Site
W
! General \

Gotham

WebsSite Linked to Department [ PsSeoNtas’: 1o

4. Inthe Web Site Menu form click Menu under the Menu [Order by
Sequence] list.

Click New.

In the Description parameter, enter Information; this is the name of the
menu.

7. In the Iltem group, select Menu for /tem Kind, this menu item is going to
have a sub menu.

8. Click Save.

Now that the menu has been created, we can now create the sub menu item
that will link to our report.

To create the sub menu item...

9. Click to select the recently created Information menu item; click New.
10. Enter Property Information in the description field.
11. In the ltem group, select an ltem Kind of Report.

12.in the Path / URL parameter, you will need to enter the path to the report
on the server. for this example the path is a follows:
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C:\Inetpub\wwwroot\Demo Reports\DEMO\WEB MENUREPORT.rpt

The report used here is a generic report that will be used to retrieve property
information. This report is also embedded with links to additional information.
To obtain the property information required, a key will have to be supplied, e.g.
AR _ID, NA_ID, P_ID, etc. For property information, we will use the Parcel ID.

13. In the Dynamic Search group, select Parcel ID for the Requested Key.
14. For the Group parameter, select Search by Property.

15. In the Security group, because this menu will be accessed by all users, set
all options; i.e. Internet subscriber, Internet with profile, Internet without
profile, Intranet admin, and Intranet user.

This report requires the year that will be queried, i.e. the YEAR_ID. For this
report it will be for the year 2009.

16. Click “+” (A) in the Parameter group; enter YEAR_ID under the Name
column (1), and 2009 under the Value column (2).

Group [N~

Parameter

|
| YEAR_ID 2009

17. Click Save.

The menu on the web site will not change immediately. In some instances, it
may be necessary to perform a reset of Internet Information Services (1IS).
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Resetting Internet Information Services (lIS)

To perform a reset of IIS...

Open:

1. On the Windows desktop, select Start > Run...

Open: iisreset|

Type the name of a proegram, folder, document, or Internet
resource, and Windows will open it for you,

= Type the name of a program, Folder, document, or
Internet resource, and Windows will open it for you,

lisreset -

B This task will be created with administrative privileges.

2. Inthe Run window, enter iisreset.

This command may also be entered at a command prompt (A) in a console

window.

+ Command Prompt

Microsoft Windows X zion 5.1.260081
(C» Copyright 1985-_ icrosoft Corp.

H:“>iizreset

Attempting stop.
Internet ..e}ulc:es successl-'ully stopped

Attempting start.
Internet services successl-'ully restarted

H:v>
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Once saved, the menu will be available to all users accessing the Web site.
Through this particular report, users may also link (A), (B) to other queries like
Utility Billing information and or the Online Payment eComponent.

£= Wielcome 1o the City of Betropedis - Windows Intemet Explases

G 4xe harmscomptercom i)
B £ Wew Fyortes ook beb ‘x
i Fovortes s ) Supoested Stes = B Gat More Addors =
b 1 B ekoma tothe Sty of M., % [ nen e

L
“}:z(nhr) polis *
=) B

(= Welcome to the City of Metropolis - Windows Internet Explorer

5@,- /(x| (06, harriscomputer.com/Webliser Interfacei(3) [web_Report_Crystaviener.aspx | (] [$q soode 128

Elle  Edit View Favorkes  Tools  Help

i Favorites | 5 ) Suggested Sites ~ 2 Get More Add-ons ~

| @t | Ewelometothe ity of ... % | @ ew Tab ] Pt 7

polis Welcomes You... 4
3
- = ~ [\
Metropolis m
Home Information Online Services Contact Us Greetings from our Mayor Francais
@S| Drarameters| 4 4 [1 i1 od [ oo |- b
Main Report ‘
3 Web Portal Demo

C2
Online Information =
Property Information
Property Location owner
35 Beechwood Dr
Wayne A Swiatocha
Parcel ID:  194-202-500-0 35 Beechwood Dr
Key Number: 3022 Southampton, NY 11968
Class: 210 One Family Year-Round Resid Jessica Swiatocha

35 Beechwood Dr
Southampton, NY 11968
Tax Information

Tax Statement Report @ View
Utility Billing Information ( B ’
Account #0002703001

View Pay Online
utility Billing Statement Report View 35

Account #0002709001 View Pay Online v

&3 Local intranet 45 v Bw -

Adjusting Crystal Report Embedded Viewer Size

After customizing a Crystal Report, there are options available to control the
display size of the report that is embedded within the Web page. This can be
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necessary if the requested report has a large margin and more of the
information on the reports needs to be displayed.

Note: Setting these parameters will affect the presentation of all embedded
reports. As a result they should be altered with the understanding that
it will be the standard size for all reports presented within the Web site
that is controlled by the Web.config file.

To specify the Width, Height, and Zoom factor of an embedded Crystal
Report...

1. Use a text editor like notepad.exe to open the Web.config file that is used
for the Website.

2. In the file, locate the following three (3) parameters:
e GovernSoftware.WebReportViewerWidth
¢ GovernSoftware.WebReportViewerHeight
e GovernSoftware.WebReportViewerZoomFactor

3. Enter the values that will correspond to the display area that is required
beside the value= parameter.

4. Save the changes to the Web.config file.
For example, if the following values were entered, it would correspond to a

display area of 875 pixels wide, 1200 pixels high, and a zoom factor that is set
to 90%.

<add key="GovernSoftware.WebReportViewerWidth" value="875" />

<add key="GovernSoftware.WebReportViewerHeight" wvalue="1200" />

<add key="GovernSoftware.WebReportViewerZoomFactor" value="90" />

152 <add

= <add
25 <add
£ <add
96 <add
g7 <add
198 <add

89 <add
<add
<add

<add
<add

<add
A

kev="MSGovern.Gove.nletConfig" valle="C:\inetpub\ww root\MSutvern\5iteb\Gy,. -nNetConfig.xml" /> %
key="MSGovern. SynchFileAndFolders" wvalue="FALSE" />
key="MSGovern.CopyFilesAndFoldersLocally" value="FALSE" />
key="GovernSoftware.WebSite Id" wvalue="1" />

key="GovernSoftware.DefaultPage" value="WEBPROFILE" />
key="CovernSoftware.UploadDirectory"” wvalue="C:\inetpub\wwwroot\MSCovern\Dummy\" />
kev="GovernSoftware.UploadMaxFileSize" wvalue="41594304" />
key="GovernSoftware.Version dnet" value="4" />
key="GovernSoftware.DisplayBuildVersion" value="0n" />
key="GovernSoftware.TraceArTransactionResponse" value="Off" />
. . \wwwroot\MSGovern\Reports\DEMO\" />

key="GovernSoftware.WebReportViewerWidth" wvalue="875" />
key="GovernSoftware .WebReportWViewerHeight" value="1200" />
kev="GovernSoftware.WebReportViewerZoomFactor" value="90" />

\"\w *\4\,"

O m h b RO

<add

Pa Ra Ra Ra R R ORI ORI R

7‘.

e o P o 3 I Bl L
- - - e

key="GovernSoftware.Web-Service-CCardConfirmation-URL" wvalue="http://governnet.governsoftware y

__Jac{d ke‘-_\-'=“Gowrl§oftw =.w1LM1”}'—"“ /= ‘ F 4 >y -
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Web Interface
Overview

Note: In this section are examples of menu structures and site layouts. The
examples are in no way indicative of any limitations of the eGovern —
Public Self Service Portal.

This section describes the eProfile Web interface, as viewed by the user over
the Web. The eProfile provides access to Govern’s eGovern — Public Self
Service Portal, ePayment, ePermit, eComplaint, eGrievance, eRequest for
Services, eRemittance, eRenewal, and to the ePortal. The eProfile also
includes an administrative menu. This menu is visible to Administrators and
Super Users only. Itis used for granting personalized rights and for adding and
removing access to properties and utility billing accounts, on a user-by-user
basis. See Administration on page 139.

In order to access the eProfile or the eComponents all users, including
Administrators and Super Users, need an active account, a valid ID, and a
password. This can be provided by an administrator or created by the user
online, depending on the organization’s setup. See Update Your Profile on
page 138.

eProfile Menus — An Overview

Depending upon your organizations needs, the Govern’s eProfile menu bar
can contain the following menus:

* Home

* Online Services
*  Your Profile

* Administration

* Links
+ Sign Out
* Help?
* Francais

Page 134
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Home

Management Solutions for Govemment

Hello JULTA GOVERN

Ip:
-- ] Ay Profile Online Services My Profile Setup Administration (eGov) Link Sign Out HEE

Verin: 5.1.1307.4

Welcome!
Your profile currently contains the following references:

Properties

The Home menu provides a link to the Home or Welcome page of the
principal site.

My Profile

Selecting the My Profile option will link you to the My Profile report page.

govern Hello JULIA GOVERN
Ho d 'l nline Services My Profile Setup Administration (eGov) Link Sign Qut

m

Back to Your Account I

My Profile

| Find... |@% % #3101 |+ 100% |~

¢ myuome PEREEERSENRG |

navarn

Online Services

&2 MSGovern

Management Solutions for Govemment |

Summary govern Hello JULIA GOVERN

Home My Profilef Online Services My Prdfile Setup Administration (eGov) Link Sign Out e

Version: 5.1.1307 .

| ePayment ‘h 13
eSubmit 3
l

Properties

Welcome!
Your profile currently contains the following references:

witility Rillina Accounts

The Online Services menu may be configured to displays one of the
following, depending on the setup of your organization:
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» Default eComponents, as selected on the eProfile tab in Govern NetAdmin
(GNA)

» Personalized eComponents, created for the logged-in user through the
User Account Information Web page

For details, see Web site Editor - General tab on page 29 and Account
Information on page 139.

:WePﬂayment

|
govern Hello JULIA GOVERN

Home My Profile Online Services My Profile Setup Administration (eGov) Link Sign Out
Fr

Back to Yq

p— —-"-\..-;.,’*—-0.-._.."‘_*__""‘“ PP ST T SN L -H_’“'r‘ & ok

ePayment
aSubmit |l Online Payment (Name)

Self-Reported Tax » | online Payment {Barcode)
\;' = Misc Payment

The ePayment option provides access to Govern’s ePayment solution. For
complete details on making payments online, refer to the ePayment section of
this guide. This menu option may be used for processes reserved for all online
payments. These can include:

Online Payment (Property): Property/Parcel related payments.
Online Payment (Name): Name related linked modules, i.e. SRT.

Online Payment (Barcode): A/R accounts where Barcodes may have
been implemented.

Misc. Payment: Payments that will allow selection of specific A/R classes
that have been made available online. For example, a school tuition fee
payment.
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eSubmit

govern Hello JULTA GOVERN

Home My Profile Opline Servi

atiop (eGov) Link Sign Out

Property Information

ePayment 3

eSubmit 3

Self-Reported Tax »
Back to Y@t AccounT

Version: 5.1.1307.

Apply For a Permit
Permit or License Renewal

Request for Information

File a Complaint

Request an Appeal w

il

The eSubmit menu option can be configured to contain all submit and request
actions. These actions can include the following:

Apply for a Permit : The Apply for a Permit option provides access to
Govern’s ePermit solution. For complete details on applying for a permit
online, refer to ePermit Administration on page 152.

Permit or License Renewal: The Permit or License Renewal process
provides access to Govern’s eRenewal solution. For complete details on
applying for a permit online, refer to Configuring eRenewal on page 201.

Request for Services: This menu option will link to the eRequest for
Application page.

govern Hello JULIA GOVERN
Home My Profile Online Services My Profile Setup Administration (eGov) Link Sign Out

Version: 5.1.1307.4

eRequest Application

Select your application type

Back To Your Account Next Step

Please Select an Application Type

( =]

Building Department Request for Services PC Inspaction Request
City Clerk Request for Services Citizen

City Clerk Reguest for Services Council k
City Clerk Request for Services Media

City Clerk Reguest for Services Nbhd Association Head

L — ity Clerk Request for Services Non-Resident

City Clerk Request for Services UB Customer

File a Complaint
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Request an Appeal

Filing a Complaint or Grievance or Submitting a Request
for Services

The eGrievance, eComplaint and eRequest for Services options can be
combined and accessed from a single menu option or displayed separately,
depending on your setup in Govern Admin. See eProfile tab Parameters on
page 69.

Your Profile

nage Your Properties
Manage Your UB Accounts

Home  Online Services gﬂ Administration  Links  Sign Out Help? English j
: 4
Update Your Profile P
- elgome!
g a— P e plielgo TSR PN

The Your Profile menu provides access to your eProfile account information,
as well as to the properties and utility billing accounts associated with your
eProfile:

Update Your Profile

The Update Your Profile option would display a summary of your eProfile
account, including your payment options.

Manage Your Properties

The Manage Your Properties option displays the properties in your eProfile
account by tax map number and address. You can add and remove properties
to and from your eProfile, provided you have the required access rights.

Manage Your Utility Billing Accounts

The Manage Your Utility Billing Accounts option displays the utility billing
Accounts in your eProfile. You can add and remove accounts, provided you
have the required access rights.
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Administration

1

Home  Online Services  Your Profile Links  Sign Out Help? English

Manag{}]sers

Account Information

Access Rights

Manage Properties

Your profile Manage UB Accounts

Subscriber Setup
Subscription - Plan Setup

lowing references:

Prnpertles
P Utility Bjlling Accounts
N S PO N S LR e S pr |

The Administration menu provides access to your users eProfile account
information, properties, utility billing accounts and access permissions.

Note: This menu is available only to users with administrative or Super User
rights.

Manage Users

The Manage Users option displays a search screen to retrieve the user
eProfile that you want to modify.

Note: You need to select a user in order to enable the other options on the
Administration menu,

Account Information

Account Information displays the user’'s name and address, and eProfile
account information. You can update the address, the password and the
additional name and address information, from this page.

Access Rights

Access Rights displays access rights to the eProfile and the eComponents
for the selected user. You can modify these rights, as required.

Manage Properties

Manage Properties displays the properties in the eProfile account of the
selected user. You can add or remove properties to and from this list.
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Manage Utility Billing Accounts

Manage Utility Billing Accounts displays the utility billing accounts in the
eProfile account of the selected user. You can add or remove accounts to and
from this list.

Subscriber Setup

Subscriber Setup will allow you manage the users that are enrolled in a
subscription plan.

Subscription - Plan Setup

Subscription - Plan Setup is used to create subscription plans that
administrators can apply to user accounts.

Links

Hello Dr Eric M Martineau JR

Home  Online Services  Your Profile  Administration K Sign Out
Gi

Version: 4.5.3 S Govern
ePortal

eProfile

#*’Fwnmikumr% e e J—' '..4.! -

The Links menu provides access to the city home page, access to the ePortal
home page, or eProfile log in page.

Sign Out

Summary emartineau Hello Dr Eric M Martineau JR

Hecme  Online Services  Your Profile  Administraticn  Links Sign Out p?  English

Version: 4.5.3

The Sign Out menu returns you to the Login page.
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Help?

The Help? link will display Help information associated with the page in pop-
up windows.

-Hnme Online Services  Your Profile  Administration Links Sign Qut English

= httpy//mtldeviL harriscormputer.com/MSGovernebUsern... - |0 X

Signing Up Users to a ﬂ
Subscription Plan

In order to purchase a subscription
plan, the Web user needs to call in to Plummer
the organization. The clerk needs to a\
perform the following procedures:

1. Assign Subscriber Access to the
user.

2. Sign up the userto a
subscription plan.

Assigning Subscriber Access - J Cancel
I

A Note about WebHelp

The text that is used to populate the popup Web Help screens are stored in
resource files.

Filename: GovernNetHelp.en.resources, and
GovernNetHelp. fr.resources

Users are free to modify these files with the Resource File Editor in GNA.
Whenever these files are modified, they should be backed up and stored in a
safe location. A new installation will overwrite these files; they can then be
restored from a recent backup. For an explanation of the methodology
employed by Govern in updating resource files, refer to the Management of
User Changes in the Resource File Editor section of the Govern New
Administration (GNA) Release 5.1 user guide.
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Resource File Locking and IIS

Note: Users of Govern’s eGov should note that when the Internet Information
Services (lIS) is running, resource files cannot be maintained by the
Resource File Editor. 11S locks the files making it inaccessible. In order
to access the resource file, you must stop the IIS service. This can be
performed through the Control Panel; Control Panel > Administrative
Tools > Services > Internet Information Services (lIS) Manager.

Alternatively, administrators can make a copy of the Resource file,

perform any required edits on the copied file, then stop the IIS Service,
replace the file with the edited copy and restart the Service.

Francais

13 8 11 7 33 19 Aide? English

@ Afficher les abonnés actifs
 Afficher les abonnés inactifs
Souscripteurs existants: 6

André Martineau pl
Dr Eric M Martineau JR

Mara-Jade Martineau la

Réal Martineau

Richard Martineau la

Yvon Martineau

| Annuler

The Frangais menu displays the Web pages in French. This can be changed
to Espanol or another language. Up to four languages can be supported by
the eProfile.
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First Time Users Creating Accounts

In the Account Creation process, a workflow has been initiated that reduces
the number of steps involved in each of the processes that are opted for. This
is done by providing options at the beginning of the process that then
simplifies subsequent steps. For example, at the start of the account creation
process, the online user is given the option to select how the system will
proceed with the account creation process. Users with preexisting profiles in
the system, will have the option to add properties or accounts to their profile.
Users that are not known to the system will simply go through the registration
process; once their account is created, they can then add properties or UB

accounts.

During the account creation process, visual cues are available to indicate the
stage of the process that a user is currently at.

& MSGovern __

ke

Creating an Account

First time users are presented with the log in screen. To create a new
account...

&2 MSGovern

Management Solutions for Govemment

Enter your Account ID and Password

Account IDI

Passwo.’dl

Log In

Foragot your account or password?

First-time user? Register here

Buy a Subscription Here

1. Atthe log in screen, click the “First-time user? Register here” option.
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2. In the Account Creation screen, enter an Account Name; this name,
account ID must be between 6 and 30 characters long and can only
contain numbers (0-9) and alphabetic characters (a-z).

3. Create a password that conforms to the requirements; between 6 and 16
characters long containing letters. Numeric characters and special
characters are allowed but optional. Allowed special characters are ! @ #
$%"&*()_*+{}

&2 MSGovern

Management Solutions for Govemmant

Account Creation

Create an Account ID and Password. Password must be between 6 and 16 characters long. It must contain letters. Numeric characters and sg
characters are allowed but optional. Special characters allowed: !@#$% ~&*()_+{}
Account Name mk‘night

Password sessssssse
Repeat Password eesesscess

e-mail address oolaniyan@govern.net

How can we identify you? |I don't have an account.

I don't have an account.

Cancel |Use an Account associated with my name.
Use my property address.

Use my Property Identification Number.
Use my ST Account.

Use mi Uti\iti Billini Account.

4. Enter an e-mail address.

5. The system will need to know how to identify a new user; click the “How
can we identify you?” drop down menu to display the options.

There are multiple options available for first time users that are creating an

account. The following are explanations of the available options.

Account Creation

Create an Account ID and Password. Password must be between 6 and 16 characters long. Tt must contain letters. Numeric characters and sp
characters are allowed but optional. Special characters allowed: !@#$% ~&*()_+{}
Account Name mknight

Password sessssesss
Repeat Password ssssssssss

e-mail address oolaniyan@govern.net

How can we identify yo ﬁdon’t have an account.

Iam not a property owner and I don't have an account.
Use an Account asseciated with my name.

Use my Property Identification Number.
Use my property location address.

Cancel

A

Use my Utility Billing Account. ¥
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Account Creation options

Property Owner without an Account

When the option “l am not a property owner and | don’t have an account”
is selected, the user will be able to create a new name, with the understanding
that they have no information in the system.

Use an Account Associated with an Existing Name

For the “Use an Account associated with my name” scenario, the user will
be required to enter their account number (this is associated with the
na_names.account_no field)

Create Account Using Users Parcel ID (P_ID) Number

The “Use my Property Identification Number’ method will ask for the
following details:

* A partial name (a minimum of three (3) characters is required)
» A Last name (this parameter also requires at least of 3 characters) OR

+ The company name (this also requires a minimum of 3 characters), if a
business and tax map are involved.

The search will validate the name with the Tax Map, if the person is the owner
or occupant, and if they are in the Mailing Index

Create an Account Using Property Location Address

When “Use my Property Location address” is selected, this method will ask
for the following:

* A partial first name (a minimum of three (3) characters must be entered)

» Last name (it requires at least of 3 characters) or the company name (it
requires at least of 3 characters), if is a business and the address.

The search will validate the name versus the address (in the tables for Owner,
Occupant and Mailing Index).

Create an Account using Users ST Account

The "Use my ST Account” option requires the user to enter the complete
Account Number (this is associated with the ST_MASTER.ACCOUNT_NO
field)
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Use my Utility Billing Account

When the “Use my Utility Billing Account” option is selected, the following

will be requested:

*  First name of the user (a minimum of three (3) characters is required)
* Last name (3 characters minimum required) OR...
»  Company Name (a minimum of three (3) characters required), in the case

of a Business and Ultility Account Number.

The search will validate the Name with the Utility Account Number.

Example

| am not a property owner and | don’t have an account

If you select the option for / am not a property owner and | don’t have an
account, you are presented with the Name Creation form. Complete the form

and click Next.

&3 MSGovern

Management Solutions for Covemmant

User Creation Name Retrieval |

Name Creation

Confirm account Creation

@ Individual @ Company
Prefix  Doctor bl
“First Name  Peter
Mid Name
“Last Name  Parker
Suffix b
Address Line Before
*House No 4321
Direction &
*Street Name Maple
Street Suffix  Avenue i
Direction *
Secondary Address Indicator >
Unit
Address Line After
*City  Brooklyn
*State [ Province New York bl
*Zip Code 10026
*Country  United States - h
[ Previous J [ Next I [ Cancel ]
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Name Creation Process

NEW! The next step is the Name Creation process. Enter the relevant name
related information for the account; this can include information such as the
Daytime and Nightime contact telephone numbers.

&2 MSGovern

Managemant Solutions for Govemmaent

@ Individual © Company

Prefix | Doctor (]
*First Name lHenrv
Mid Name [
*Last Name lem
Phone Day
Phone Night  [212-555-1213 [N
Suffix =

[
Address Line Before I

*House No W
Direction [ﬁ
*Street Name  [B6th
Street Suffix m
Direction [_E|
Secondary Address Indicator | Penthouse E
S
Address Line After l
*City lNew York

State / Province | New York [=]
“Zip Code |10027
*Country | United States |z|

E-mail Address lhpym@theavengerﬁ.crg

Pr’eviousl Next ] Cance\l

At thq___CQqﬁljm_chount Creation confirmation screen, click Create Profile.

Gt cin

” User Information

User Name drand24
e-mail oolaniyan@govern.net

” Account Details

Daniel Rand
105 150th Ave
New York NY

Confirm

Back J [ Cancel N—I [ Create Profile
L
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When the Account Creation process is complete, you will be at the main
landing page. The next time that you log in with your username and password,
this is the page that will be displayed.

Account Creation Email Message Authentication
option

For added security, there is an option for Email Message Authentication during
the eProfile Account Creation process. This means that a user will not gain
access to a created account until they have responded to a system generated
email message to confirm their identity. , App Config > Web Config > Manage
Web Sites: Web Sites form > eProfile tab > Profile group: Confirm Profile
Creation by email.

When a user creates an account online, a confirmation message will be sent
to the e-mail address that the user specifies during the account creation
process. This option is enabled in the

45 MSGovern

Managerr ent

Your account: clintBarton is created but need to be activated.

* Check your emails and validate your email address.

2 MSGovern

ent

e User is not activated. Check your emails and activate your account.

—
- Q’Iease correct the following: )
t

Enter your Account ID and Password

Account ID ldintBartnn

Password l

&2 MSGovern i

Management Solutions fc emment

Francais

Your account: Name44566 is already activated.

!
* Your account is already activated. -
Back
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4 M%Govern

Management Solutions for G nent

Account Creation

Create an Account ID and Password. Password must be between 6 and 16 characters long. It must contain letters. Numeric characters and
special characters are allowed but optional. Special characters allowed: !@#%$% ~&*()_+{}

Account Name CBarton

Repeat Password sssssss
E-mail address cbarton@starkindustries.com )

How can we identify you? |I don’t have an account. =]

I don't have an account.
Use an Accou r't associated with my name.

|Lsern Plup rky Ideﬂhﬁcahm Number.
Use my ST Account.
lUse mv utility Billing Account. l

Note: The body of the e-mail message, and the e-mail subject field can be
customized using the Govern New Administration (GNA) Resource
File Editor. See below.

Customizing the Account Creation Notification Message

NEW! As with most modules in Govern, administrative customizing is done by
making entries in specific keys in the resource file.

To modify the Account Creation notification message...
1. In the Govern New Administration (GNA), select Utilities > Editor >
Resource File Editor...

2. Select File > Open (Ctrl + O)

Navigate to the directory where GovernNet.en.resources and
GovernNet.fr.resources are located. Refer to the Modifying Text in the
Resource File Editor section of the Govern New Administration (GNA)
Release 5.1 user guide for details about editing resource files.

Select and open one of these files in the Editor.

Click File > Find on the .NET Resource Editor main menu bar or click Ctrl
+ F on your keyboard, to locate the text you want to modify.
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Govern Resource files contain specific Modules, Functions, and Key names
used to identify and modify content. The specific ones that are used to identify
the Subject and Body of the account creation email are as follows:

Module Function Key Details

WwB WEB_WP_NA_CREATECONFIRM | EMAILSUBJECT | Email subject line.

wB WEB_WP_NA CREATECONFIRM | EMAILBODY Content that will appear in the
email body.

Sample Structure of the Message

An example of the default message that is sent is as follows:

The internet account for firstName lastName, has been created; this account
is related to relatedAcctName.

...where...

* firstName — First name of created user.
* |lastName — Last name of created user.

* relatedAcctName — Name of the account that the internet account is
related to; i.e. emartineau.

Comprehensive Landing Page Report

The landing page or Home page is a generated report containing links
to the various components that make up the user profile. Components include
a link to the users profile, and can include associated properties, when
allowed, users can also add additional locations. Associated permits and
licenses are listed, with the option to add new ones, or modify the ones that
are existing. Also displayed are outstanding account balances, and a link to
settle them.
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&3 MSGovern

Management Solutions for Covernment

govern Hello JULTIA GOVERN

Home My Profile Online Services My Profile Setup Administration (eGov) Link Sign Qut

Version: 5.1.1307.4 Manage Your Properties

Manage Your Self-Reported Tax Account

Manage Your UB Accounts
Back to Your Account g

»

&5 MY HOME

J

l EDIT MY PROFILE

ADD MORE L OCATIONS

Internet Account :

JULIA GOVERN

govern
oolaniyan@msgovern.com

1600 MAIN St W Suite 620
ST-LOUIS MO 62007

2

MY PROPERTY LOCATIONS

Tax Map No.

179-105-600-8
179-105-600-9
179-105-601-2
179-105-601-3
179-105-702-0

Property Location
95 Castle Hill Ct

89 Castle Hill Ct

91 Castle Hill Ct

93 Castle Hill Ct
102 Castle Hill Ct

2 LOCATIONAL PERMITS/LICENSES

m
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ePermit Administration

Planning your ePermit Setup

As with the standard permit setup, several of the ePermit parameters can be

defined at more than one level. This section describes how

each of these

settings is applied, according to the level at which it is set. See ePermit -

Planning Your Setup on page 153.

Land Management Parameters

This section describes the ePermit parameters set at the organizational level,
for all departments, through the Land Management Parameters form. See
ePermit - Defining Parameters for the Organization on page 165.

Permit Parameters

This section describes the ePermit parameters set at the departmental level,
through the Permit Parameters form. See ePermit - Defining Parameters for

the Department on page 168.

Permit Type Maintenance

This section describes the ePermit parameters set at the permit type level,
through the Permit Type Maintenance form. See ePermit - Defining Permit

Type Parameters on page 170.

Permit Activity Setup

This section describes the Permit Activity Setup. The setup is the same as the
setup for the standard permit. This section is included for informational
purposes. It is important to review the activities initiated through the ePermit

application, to ensure that the application can be submitted
Defining the Activity Setup on page 190.

. See ePermit -

Page 152
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ePermit - Planning Your Setup
[[] Overview

eComponents

Within Govern, there are modules that lend themselves to online access and
manipulation. Govern eComponents are the modules that are configured for
online use. The following eComponents are set up and maintained through
Govern for Windows GovAdmin application:

*  ePermit

» elicense

* eComplaint

* eComplaint (Anonymous)
» eGrievance

* eRequest for Services

Refer to eComponent ltem Kinds on page 266 for a description of the
eComponents.

The same Land Management forms, used in the standard permit setup, are
completed with additional ePermit parameters. This guide describes these
additional parameters. Refer to the Permits & Inspections reference guide for
details on the standard permit setup.

The ePermit parameters are defined at four levels, from general to specific:

» the System level through the System Registry Maintenance form. Refer to
the eProfile section of this guide for the required setup.

» the Organizational level through the Land Management Parameters
form. See ePermit - Defining Parameters for the Organization on
page 165.

* the Departmental level through the Permit Parameters form. See ePermit
- Defining Parameters for the Department on page 168.

+ the Permit Type level through the Permit Type Maintenance form. See
ePermit - Defining Permit Type Parameters on page 170.
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As with the standard permit setups, there are three ePermit parameters that
can be defined at more than one level. This section describes how each of
these settings is applied, according to the level at which it is set.

Note: Ensure that these parameters are properly defined for your

configuration.

The ePermit parameters that can be defined at multiple levels are as follows:

+ User ID for Web-generated System Activities: See User ID for Web-

Generated System Activities on page 154.

* Accept Secondary Permit Types: See Accept Secondary Permit

Types on page 156.

* Accept Building / Unit Links: See Accept Building / Unit Links on

page 160.

The applicable forms, for setting these parameters, listed from most general to

most specific are, as follows:

Form

Level

Priority

Land Management Parameters

Organization

Permit Parameters

Department

Permit Type Maintenance

Permit type

Most Specific

Most General

The most specific level, at which the option is selected or defined

overrides the other settings.

User ID for Web-Generated System Activities

This parameter can be defined at two levels: the organizational level, on the

Land Management Parameters form (2) -

Parameters > Land Management >

Page 154
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Parameters..., or the departmental level, on the Permit Parameters form (1) -
Maintain > Department:

. Permit Parameters

File Edit Help
Department IBuiIding Cepartment
General T Permits T Mizcellaneous T eGovernment T Matify

]

¥ Provide 'wWeb Access to this Departmem

(’EI zeild for web-generated System-activitie

IMS Govern Solution Team

\I;_%,

v Accept Secondary Permit Types
¥ Accept Building # Unit Links

Call External Inzpector After |2 Days

. Land Management Parameters
File Edit Mainkain Help
— Department:

Central Cash - Land Management
Citizens Services

City Clerk,

Community Development Board

Conzervation Department

User ID for Web

Generated

System Activities

Department of Public 'Works Exit
Electical LI
General Parameters (All Departments)
General T Fermits TMisceIIaneousT Inzpections T G/ & AR T gl

Department to be uzed on the 'Web
IWeb [E Components)

,Ll_serld for web-generated System-Activities

=

(

IMS Govern Solution Team
[

¥ Accept Secondary PermitT ypes
¥ accept Buiding / Unit Links

Dizplay Department/Function
 Mone

" Department

' Department & Function

Define the User ID for Web-Generated System Activities parameter to
create a sender for the e-mail and interdepartmental notification messages
generated through the Activities associated with the ePermit applications. In
addition you will need to identify how to Complete / Initiate the Activity.

Interdepartmental Messages and E-mail messages

Interdepartmental notification messages are sent from the user, associated
with this user ID. E-mail messages are sent from the e-mail address defined
for this user on the User Maintenance form in Govern Admin. Refer to the
Super User reference guide for details on the User Maintenance form.
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Define the user as follows:

* Enter the user ID on the Land Management Parameters form, to use the
same sender for all messages sent from all users, from all departments,
within the organization, or as a default address to be used by departments
that have not defined another sender.

* Enter the User ID on the Permit Parameters form, for the applicable
departments, to create a sender for the users within the selected
department, only.

The user ID defined at the most specific level is used; i.e, if this parameter is
defined at both levels, the address entered for the department overrides the
one entered for the organization.

Note: This parameter must be set at either the organizational or
departmental level for all departments maintaining ePermits.
Otherwise, the messages defined for the activities and activity steps
are not sent.

See Interdepartmental User Notification and External Client E-mail
messages on page 194 for details on sending messages from activities
generated through the ePermit applications.

Accept Secondary Permit Types

The Accept Secondary Permit Types option can be set at three levels: the
organizational level, on the Land Management Parameters form (1), the
departmental level, on the Permits Parameters form (2) or at the permit type
level on the Permit Type Maintenance form (3):

Page 156
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& Permit Parameters

2] x]
File Edit Help
Depatment IAssessUr‘s Office
General T Femitz T Miscellaneous T &b ]
¥ Provide Weh Access to this Department |
. Land Management Parameters ﬂ E
Userld for web-generated System-Activities Bie Edit Maintain  Help
IAdministratwa Account j - Department

Azsessor's Office
¥ Accept Secondary Pemit Types

Central Cash - Land Management
Citizens Services
City Clerk.
Community Development Board
Call Externgfinspector After |2 Days gonsetrvatl?n P;plj!tnlffntk
epartment of Fublic [ul %4
Electrical ﬂ

General Parameters (All Departments)
General T Permitz T MiscellaneousT Inspections T GAL & AR
Department to be used on the ‘Web

v Accept Secondary PermitT ypes
|web (E Comparents) = [ Aceept Buiding # Urit Links

Uszerld far web-generated System-Activities Display Department/Function
IMS Govern Solution Team j " None
" Department

' Department & Function

. Permit Type Maintenance

e 3
File Edt Maintain Help
Department Building Department
Peimit Type cert_ocoup -
Deescription Cettificate of Dccupancy | Acce Pt Seco I‘Idary Permit Tvpe |
General T Seguences T eComponents ]
[V &dd this type to the E Component 'Web Pages
v Accept Secondary Permit Types [v &ccept Building / Unit Links V' Use Contractar's Restriction
o et Fiamas Ltk \/_\ [ Restiction doesn't apply to homeawners
i Restricted ta the fallowing property types*k ' Mame Type Contractor's License Restrictions
Caommercial _I Audio System Installer ;I Septage Hauler Permit Application ;I
Exempt Authorized Agent Burial
Industrial _I Eride LI B Septic System Installer LI i}
[~ Required
r— Multimedia Cod
Documents ;I Sub Code
build_pl.
Ll lan «|R I j
I j_ [¥ PRequired
—eSearch
Style Group
|By Pemit ID [Permit) = |

I NI 4 IEditing Exizting Record [3/49]

» | M
Hew | Save I Delete | Activity Steps | Lolumnz |

Browse | Exit |

When this option is selected, Secondary Permit Types are displayed on the
ePermit Web pages, as in the following screen shot.
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olaniyan Hello Dr Olusegun Olaniyan ¥
Home  Online Services  Your Profile  Links  Sign Qut Help?  English
Version: 4.5.3

ePermit Application

Select your application type

Please Select an Application Type

|Buildimg Department Building Permit OTFD - Stove

You Can Attach Permit Sub Type to this Application
™ Building Department Building Permit OTFD - Additions
I Building Departmant Building Permit OTFD - Alterations
™ Building Department Building Permit OTFD - Deck
I Building Department Building Permit OTFD - Detached Garage
™ Building Department Building Permit OTFD - Fences

Building Department Building Permit OTFD - Fire Protec!

The user can then select secondary permit types, as required, for the primary
permit type.

See ePermit - Primary and Secondary Permit Types on page 162 for details
on secondary permit types.

This is equivalent to selecting the primary and secondary permit types in the
Permit Type list box under the General tab of any Permit function in
Govern.NET. The following screen shot displays a building permit with a
primary and secondary permit types, in the Permit Type list .

General

Exported Flag o
Permit Type Estimated Cost

” Gross Floor Area (Sq Ft)

Refer to any permit function in the User section of the Permits & Inspections
guide for more information.

Linking Secondary Permit Types to an ePermit

To make secondary permit types available for an ePermit application, select
the Accept Secondary Permit Types option. This option can be selected on

Page 158
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the Land Management Parameters, Permit Parameters or Permit Type
Maintenance form.

The most specific level, at which the option is selected overrides the
other settings.

Land Management Parameters: If the option is selected on the Land
Management Parameters form, secondary permit types are available for all
permit types, regardless of whether or not it is selected on the Permit
Parameters and Permit Type Maintenance forms.

Permit Parameters: If the option is selected on the Permit Parameters form
secondary permit types are available for the permit type, even if it is
deselected on the Permit Type Maintenance form.

Permit Type Maintenance: If the Accept Secondary Permit Types option
is selected on the Permit Type Maintenance form, secondary permit types are
available for the permit type, regardless of whether or not the option is

selected on the Permit Parameters and Land Management Parameters forms.

Setup Procedure

Set this option as follows, depending on how you want use secondary permit
types:

1. To use Primary Permit Types only, deselect this option on all forms.

2. To accept Secondary Permit Types for some departments but not all,
maintain this option from the Permit Parameters form:

+ Deselect this option on the Land Management Parameters form.

» Select this option for the applicable departments on the Permit
Parameters form.

» Deselect this option for the other departments.

» Deselect this option for the permit types on the Permit Type
Maintenance form.

3. To accept Secondary Permit Types for some permit types but not all,
maintain this option from the Permit Type Maintenance form:

» Deselect this option on the Land Management Parameters form.
» Deselect this option on the Permit Parameters form.

» Select this option for the applicable permit types on the Permit Type
Maintenance form.
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* Deselect this option for all other the permit types on the Permit Type
Maintenance form.

4. To make Secondary Permit Types available for all permit types, maintain
this option on the Land Management Parameters form:
+ Select this option on the Land Management Parameters form.
+ Deselect it on the other forms.

Tip: If you want to accept Secondary Permit Types for some permit types but
not all, maintain this setting from the Permit Type Maintenance form and
leave the option deselected on the other forms.

Accept Building / Unit Links

Like the Accept Secondary Permit Types option, this parameter can be
defined at the organizational level, on the Land Management Parameters form
(1), the departmental level, on the Permits Parameters form (2) or at the
permit type level on the Permit Type Maintenance form (3):

&.Permit Type Maintenance 2] x]

File Edit Maintain Help

&, Permit Parameters

Fle Edit Help Drepartment Evilding Department

Depatment  [PssessorsOfice | Pemil Type bida_historic l Accept Building / Unit l
Description Building Histaric
General T Permits
General T Seqguences T eComponents ]
¥ Provide Weh Access to this Department

¥ #dd this type to the E Component ‘Web Pages AS

Userld far web-generated Spstem-Activities

v Accept Secondany Permit Types /IV Accept Building # Unit Links
IAdmiﬂislralive Account ﬂ

[ Restriction doesn't apply to homeowners

[V Use Conltractar's Restiction
¥ Accept Propery Links

| Accept Secondary Permit Types
e - Restricted to the follawing property type: Contractor's License Restictions
v iccept Bulding £ Unit Links Commercial ;l Alarmn Spsterns Technician ;'

Septic Sypstem Ingtaller =
/i Exempt Applicant Business Certificate
Industrial LI H Architect LI i) Director of Public Health LI H
Call Externgifinspectaor &fter |2 Days 'l vI j
. Land Management Parameters 7] x|
File  Ei Maintain  Help

Building and Zoning Division
Central Cash

Community Development
Community Prezervation Division
Electical Department

MName Type:

Save

1

Engineering Division Exit
Ervironment Division ;I
(AL}
General Paramsters (All Departments) 2]
General T Pemite T Misce\laneuusT Inzpections T G/L & AR Teﬁovemmenl J Browse Exit |

Department ta be uged on the 'web

I~ Accept Secondary PemitTypes
IEulIdlng and Zoning Division j I tooept Buiding / Unit Links

Userld for web-generated System-Activities Display DepartmentFurction—————

I j = Mone
" Department
" Department & Function
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This option is used to link specific buildings or building units to a permit. It
performs the same function as linking buildings or units from the Links tab on
a Permit function in Govern.

Tl:n Buildings

i 380 - [ Hinkle Boad
Bldgld ?10382 0 Hinkle Road

Add | Rermnoe |

Select this option if you want to grant the applicant the right to link buildings or
units to a permit type on the ePermit Web page, as in the following screen
shot:

Hello Dr Olusegun Claniyan vV

Home  Online Services  Your Profile  Links  Sign Out
Version: 4.5.3

ePermit Application

OTFD - Additions 9 Clearview Dr 110-101-200-0

Link the Application to a Specific Location on the Property

Link the Application to a Specific Location on the Property

[ 9 Clearview Dr

Select All UnSelect all

Previous Step Next Step

M“ﬂl’*wr\"","‘u

Note: The same setup applies to the Building / Unit Links as to the
Secondary Permit Types option.

Refer to any of the permit functions in the User section of the Permits &
Inspections reference guide for further information.
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ePermit - Primary and Secondary Permit

Types

Overview

Every permit must include a Primary Permit Type and may include one or
several Secondary Permit Types.

Secondary permit types are linked to the primary permit type, when both types
apply to the same property and share other information and requirements. For
example, a property owner applies for a permit to build a swimming pool with a
storage shed and surrounding fence. You can create a single permit
application, with the swimming pool defined as the Primary Permit Type and
the fence and storage shed defined as Secondary Permit Types, rather than
creating three separate applications.

The use of secondary permit types is not applicable to every project. For
example, if both a swimming pool and stable are to be built, it is better to
create two separate permits. Although the property and the property owner
may be the same, the building requirements, inspections, licenses, and time to
completion are completely different.

Linking Primary Permit Types to an ePermit

The Primary Permit Type is used as a reference for the permit. The following
rules apply:

1. Activity Steps: Only the Activity Steps associated with the primary permit
type are executed. See ePermit - Defining the Activity Setup on
page 190.

2. Sequence Numbers: If sequence numbers are defined by permit type on
the Permit Type Maintenance form, those that are defined for the primary
permit type are used.

Alternatively, sequence numbers can be defined at the organizational or
departmental levels, through the Land Management Parameters or Permit
Parameters forms.

Page 162
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Permit Types

Permit Kind Mext Application Seq MHext Permit Seq Mext Certificate Seq
Animal License &k 10007007 | &k 10007002 b4 10007003
Approval AP 10007001 AF 10007002 AF 10007003
Bonds Etd 10007001 BN 10007002 BN 10007003
Building Permit BL 10007001 | BL 10007002 BL 10007003
Business License BS 10007001 BS 10007002 BS 10007003
Decision DC 10007001 DC 10007002 DC 10007003
Electrical Permit EL 10007001 | EL 10007002 EL 10007003
General Permit GM 10007001 GM 10007002 G 10007003

Refer to the Permits & Inspections guide for details.

User-Added Columns: Added columns are included for both the primary
and secondary permit types.

In Govern, if the same field is used for both, a drop-down list appears on
the Forms tab of the Permit function. To view the value entered for each
permit type, the user needs to select the type from the drop-down list:

Fermit Type E stimated Cost

=| |s00

1\-"inEI Sidini

On the Web, the values of the user-added fields are displayed separately
on the Summary page of the ePermit application, under the headings
Primary Type Information and Secondary Type Information. For details on
creating user-added columns for the ePermits, see User Added Columns
for the ePermit Types on page 186.

ePermit Application
OTFD - New Single Famity % Shadyrest Dr 110-103-400-0

Application Confirmation

General Information

The application will be lssued on the following property
The application will be linked to the following building

Primary Application Type
OTFD - New Single Family

Secondary Application Typa
OTFD - Deck

The application will be linked to the following names
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4. Names: Name types are included for both the primary and secondary
permit types. The Name Types are selected on the Permit Type
Maintenance form. For details, see Name Types on page 178.

emartineau Hello Dr Eric M Martineau JR
Home  Online Services  You l=  Administration  Links  Sign Out English
Version: 4.5.3

ePermit Application

OTFD - New Single Family 9 Shadyrest Dr 110-103-400-0

Application Confirmation

General Information
Department Building Department
Application Kind Building Permit
Primary Application Type OTFD - New Single Family
Secondary Application Type OTFD - Deck
OTFD - Detached Garage
OTFD - Fencas
OTFD - Fire Protection System
OTFD - Fireplace
OTFD - New Two Family

The application will be issued on the following property
110-103-400-0 9 Shadyrest Dr

The application will be linked to the following building
9 Shadyrest Dr

Primary Application Type

OTFD - New Single Family
Use A-1 - Assembly
EXPIRATION_DATE
Construction Type Wood & Concrete
Estimated Cost 185000.00

Secondary Application Type
OTFD - Deck
Estimated Cost 7500.00

The application will be linked to the following names
Architect Olusegun Olaniyan
General Contractor Abiola Olaniyan

Billing Information
Dr Eric M Martineau JR
7042 Louis-Hébert
Montréal QC H2E2X2

Invoice
Application Fee $51.00
Convenience Fee $1.00
Total Payment $52.00

Payment Method - Electronic Fund Transfer
Bank ID 669845612
Account Number 4500123896

Note:

It may take several minutes to process your order, depending on the speed of your modem
or Internet connection. Please DO NOT click the PROCESS button more than once.

[C]All the information is correct. Process my application.

Process

Previous Step

5. Fees: See ePermit - Defining Fees for the Application on page 196, for
complete details.
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ePermit - Defining Parameters for the

Organization

Overview

ePermit parameters for the organization are defined on the Land Management

Parameters form.

To access the Land Management Parameters form, from Govern’s main

screen, select Tools > System Administration (Govadm32.exe)

OR

Click Application in the Side Navigation Bar to display the application, click

System Administration

In System Administration select Parameters > Land Management >

Parameters. Then select the eGovernment tab to access the parameters for

the ePermit pages.

. Land Management Parameters
File Edit Maintsin Help

—Departments

Central Cash - Land Management

Citizens Services

City Clerk

Cammunity Developmert Board

Conzervation Department

Department of Public Works ;I

Azzessar's Office -
Building Cepartment

General Parameters (All Departments)

Save

Department to be used on the Wiskh
IWeb (E Components) j

Userld for web-generated System-Activities
ISegun Olanivan j

|

v Accept Secondary PermitTypes
v &ccept Building £ Unit Links

Dizplay DepartmentFunction
" Mone

i Department

f* Department & Function

Ezit

General T Permits TMiscelIaneousT Inspections T GiL & AR TE?E.':'.E[D.TEH‘EI
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Department to be used on the Web: This parameter is reserved for
future use.

UserlD for Web-generated System Activities: Make a selection from
the drop down menu to indicate the User ID that will be used when Web based
System Activities are initiated or completed. See User ID for Web-Generated
System Activities on page 154 for details.

Accept Secondary Permit Types: When this option is selected,
Secondary Permit Types are displayed on the ePermit Web pages. See
Accept Secondary Permit Types on page 156 for additional details.

Accept Building / Unit Links: This option is used to link specific buildings
or building units to a permit. It performs the same function as linking buildings
or units from the Links tab on a Permit function in Govern. Select this option to
grant the applicant the right to link buildings or units to a permit type on the
ePermit Web page.

Display Department / Function: These options control how the permit
types, both primary and secondary, are displayed on the Web.

+ Select None to display the permit types, by name only, without the
department or function, as in the following screen shot.

» Select Department to display the department, where the permit types are
maintained with the name.

» Select Department / Function to display the department and function with
the name of the permit type.

Home  Online Services  Your Profile  Administratien  Links  Sign Out Help? English

ePermit Application

Select your application type

Please Select an Application Type

Building Department Building Permit OTFD - Alterations -
You Can Attach Permit Sub Type to this Application

[l Bu Building Permit

Bu
[0 8u
BuI

[T Building Department Building Permit OTFD - Fi ction System

Building Department Building Permi

Structure

[F Building Department Building Permit OTFD - Repair Residentia

et o AN i il il =TT aes )
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Note: The function is equivalent to the Permit Kind; i.e., Building Permit,
Electrical Permit, General Permit, Plumbing Permit, Permit to Name,
Animal License, Business License, License to Name, Approval, Bond,
Decision, Prosecution or Appeal (Table: VT_SY_ PMKIND1) and to
the Workflow Kind; i.e., complaint, Grievance, Request for Services or
Workflow (Table: VT_SY_ PMKIND2)

Note: The Display Department / Function is selected only at the
organizational level, on the Land Management Parameters

.Click Save to save your ePermit settings. Refer to the
e Permits & Inspections guide for full details on the Land
Management Parameters form.
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ePermit - Defining Parameters for the
Department

Overview

ePermit parameters for the department are defined on the Permit Parameters
form.

To access the Permit Parameters form, from Govern’s main screen, select
Tools > System Administration (Govadm32.exe)

OR

Click Applications in the Side Navigation Bar to display the application, click
System Administration

In System Administration...

1. Select Parameters > Land Management > Parameters.

2. Click to select a department from the List of Departments column; select
Maintain > Department.

3. Select the eGovernment tab to define the ePermit parameters.

. Permit Parameters
Eile Edit Help
Department |Elui|ding Department
General T Permits T Mizcelaneous T eGovernment T Potify ]

¥ Frovide Web Access to this Department

W Accept Secondary Permit Types

¥ &ccept Building § Unit Links

Call External Inspector Aﬂeri Days

Save Exit
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Provide Web Access to this Department: Select this option to provide
Web access to the permit types, defined by the current department. Once
selected, all other options are enabled.

Note: The current department is displayed in the Department text box at the
top of the form.

User ID for Web-generated System Activities: For a definition of this
option, see User ID for Web-Generated System Activities on page 154.

Accept Secondary Permit Types: For a definition of this option, see
Accept Secondary Permit Types on page 156.

Accept Building / Unit Links: For a definition of this option, see Accept
Building / Unit Links on page 160.

Permit Parameters Command Buttons

Select Save to save your ePermit settings. Refer to the Permits & Inspections
guide for full details on the Permit Parameters form.
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ePermit - Defining Permit Type
Parameters

Overview

In addition to the standard permit type parameters, you need to define the
following information, on the Permit Type Maintenance form, for each permit
type that you are making available over the Web. This includes the secondary
permit types, as well as the primary permit types:

* Name Types

* Property Types

* Multimedia Codes and Sub-codes
* User Added Columns

If the following options are not defined at the organizational or departmental
level, they need to be defined for the permit type. This is in reference to the
Govern hierarchy of Organization > Department > Permit, wherein at this level
the options can be overridden at the Department, or Organization level.

See ePermit - Planning Your Setup on page 153 for more information on
these options.

* Accept Secondary Permit Types
*  Accept Building / Unit Links

The Property Link option is defined by permit type only.
* Accept Property Links
To access the Permit Type Maintenance form:

In Govern Admin, select Parameters > Land Management > Parameters.
Highlight the applicable department in the Departments list box.
Select Maintain > Definition of Type > Permits.

Select the eComponents tab.

o b~ 0w Dbd =

Navigate to the first permit type to which you are providing Web access.
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To create a new permit type, for the Web, follow the procedures described in
the Permit Type Maintenance section of the Permits & Inspections guide.
Then, define the ePermit parameters, as described in this guide.

w,. Permit Type Maintenance
File Edit Maintain Help

Department Building Department
Permit Type ot _nesw _single
Description OTFD - Mewy Single Family
General T Sequences T eComponents ]
v addthis type ta the E Component YWeb Pages
¥ Accept Secondary Permit Types I~ Accept Building  Unit Links v Use Contractar's Restriction
W] e ey s I~ Restriction dossnt apply to homeowners
—Restricted to the following propery types Mame Types Contractor's License Restrictions
Comnercial Architect - Septic System Installer
Industrial & Construction Supervisor - & Anirmal Control Officer R
| = I 1 | [
I~ Reguired
—huttimedia Codes
bl _plan ﬂ Sub Code
Documents -
ef | [~
[ | o
—eSearch
Style Group
| =] [permits H

| I4| 4 |Edi‘ting Exigting Record (14/43) » | bl|
[esns | Save I Delete | Activity Steps | Columns | Browwse | Exit |

There are four types of ePermit parameters that need to be defined on the
eComponents tab.

* General eComponent Permit Type Parameters
* Property Types

*  Name Types

» Contractor’s License Restrictions

* Multimedia Codes and Sub-codes

* eSearch

© 2015 Harris Govern Page 171



=
7.2 HARRIS
eGovern — Public Self \ GOVERN

Service Portal

In addition, you need to open the General tab and select the Permit Kinds.
See Permit Kinds on page 185.

Note: The parameters selected on the eComponents tab affect the ePermit
types on the Web only. If the same permit types are used in the
standard Govern applications, they are unaffected by the selections
made on this tab.

You can add a full description to the VT_USR_PMTYP table, where the permit
types are saved. Add the description through the Validation Table Header
Setup form in Govern Admin. Refer to the Super User guide for details on
creating validation tables and codes.

Link to Full Description of Permit Type

NEW! On the eComponent Web pages. The full description appears as a link
beside the Primary Application Type. The user selects the link (A) to display a
description of the permit type.

Note: The Full Description link appears only if a full description exists for

the permit type.
govemn Hello MS Govern
Ma Page Déclaration de travaux Votre profile Fin de session Halg? English
Version: 5.1.1307.4
ePermit Application
it sperr

e N 1660 - 1662 Rue 12F  7436-20-4546-00-0000
DTR 00 - Dicclaration de Travaux

Application Type Information
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General eComponent Permit Type Parameters

Add this Type to the eComponents Web Pages: Select this option to
provide Web access to the current permit type and to enable the other ePermit
parameters. The permit type will be added to both the Permit Type and
Secondary Permit Type drop-down lists, on the General Information page of
the ePermit application.

Accept Secondary Permit Types: For a definition of this option, see
Accept Secondary Permit Types on page 156.

Accept Building / Units Links: For a definition of this option, see Accept
Building / Unit Links on page 160.

Accept Property Links: Select the Property Links option for the permit
types that are applicable to more than one property; for example, a fence that
is shared by two or more properties or a road that is shared by several
properties. Otherwise, deselect this option.

Note: The Accept Property Links option is available only by permit type, on
the Permit Type Maintenance form.

Restrict Permit Types to Contractors and
Homeowners

The convenience of applying for a license online is not without its drawbacks.
There will be occasions when it will be necessary to ensure that individuals
that are applying for permits are indeed qualified to request the permit type.

There is an option that allows the eProfile name to be used to determine if the
person applying for a permit is the owner, or a licensed contractor. Govern is
able to do this because each eProfile name is linked to the NA_NAMES table,
and therefore can determine if it is linked to a License to an Individual, Permit
to an Individual, or the Owner of the property. If the name is linked to a License
to an Individual, the system will check the type of individual license, and
whether the license has expired. If the license type matches the permit type,
and has not expired, then the user can proceed with the application process
for the Permit. If the users license type does not match the permit, they would
not be allowed to apply for the permit.
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In certain circumstances, homeowners can also apply for the same type of
permits as a contractor, e.g. Plumbing permit. An option also exists for these
type of permits. The eProfile is checked to see if the user is also the
homeowner, if that is the case, they are also allowed to apply.

w. Permit Type Maintenance BE
File Edit Maintain Help
Department Building Drepartment
Fermit Type koo _historic
Description Building Historic A
General T Sequences T eComponents
IV acd this type tothe E Component Weh Pages m
[~ Accept Secondary Permit Types [~ Accept Building f Unit Links ' {ize Contractor's Restriction:
I— Accept Property Links 2 Restriction doesn't apply to homeowners
—Restricted to the following property types Matme Types Cortractor's License Restrictions
I I Septic System Installer
lid i
| =1 =g -
I~ Reguited J
—Muttimedia Codes { 2
I Sub Code
ef | [~
I j_ I~ Reguited
—eSearch
Style Group
| = [
I4] 4 |Ediiting Existing Record (1/49) » | N|
[deny | Save I Delete | Activity Steps | Columns | Browse | Exit |

Configuration options to restrict permit types to contractors and homeowners
on the eComponents tab (A) of the Permit Type Maintenance screen in
Govern Admin.

Use Contractor’s Restriction: When the Use Contractor's Restrictions (1)
option is selected, selected permit types are restricted to contractors.

Restriction Doesn’t Apply to Homeowners: When the Restriction
doesn't apply to Homeowner option (2) is checked then certain selected permit
types that are restricted to contractors will be available to homeowners. In
addition, restrictions won't apply if the current eProfile is the owner of the
property.
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Contractors License Restrictions
[ Permic ypeMantenance @K
File Edt Maintain Help
Department Building Department
Permit Type otfd_newe_two
Description (OTFDr - Mewy Twa Family

General T

Sequences

T eComponents ]

¥ add this type to the E Component YWeb Pages

¥ Accept Secondary Permit Types

[ Accept Property Links

[~ Accept Building f Unit Links

v Use Contractor's Restriction
[~ Restriction doesnit apply to homeowners

ri

/_ Contractor's License Restrictions A

—Restricted to the following property types Mame Types
Architect - Septic System Installer -
= Construction Supervisor - Director of Public Heafth =l
| 2 N =4 =
[~ Reguired Agent of Board of Health -
: Animal Cartral Officer +——
—Mul.hmed\a Codes Azsistart Town Clerk
bawiiled_patan ﬂ Sub Codds Assistart Parking Clerk
Documents =l - I j Auxillary Police Officer
- Board of Appeals
I j I Reguired Board of Lssessors
— Board of Health =
eSearch J

Group

Style
b ——— e TN

"“...‘J‘\_ril‘--_r“‘"-.._,ku’.-d\_.

The Contractor’s License Restriction (A) drop down menu will become active
only when the Use Contractor’s Restrictions option is selected. When active,
the drop down menu will contain a list of all permit types having the type
License to Name or Permit to Name.

Note: The system does not filter by department because contractor licenses
can be issued by different departments.

To configure the option in Govern Admin...

1. Select Parameters > Land Management > Parameters...

2. Click to select a department from the Department List, e.g. Building
Department.

Under the menu, select Maintain > Definition of Type > Permits...

In the Permit Type maintenance for, click to select the eComponents tab.
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5. Click Browse to select the permit type that an application can be made for;
click to select the eComponents tab (A).

. Permit Type Maintenance ﬂ E L
File Edit Maintain Help
Department Building Department
Permit Type otfol_repair
Desctiption (OTFD - Repair Residential A
General T Sequences T eComponents
¥ Add this type to the E Component Web Pages m
[ Accept Secondary Permit Types [~ Accept Building [ Unit Links ¥ Use Contractor's Restriction
B A B s [ Restriction doesn't apply to homeowners
|—Restricted to the following property types —| |—Name Types | |—C0ntrac,10r = License Restrlcmons—|
Ingpector of Wiring -
Inzpector of Plumbing -

6. Enable the contractors restriction option by selecting the Use
Contractor’s Restriction option (1).

7. Inthe Contractor’s License Restrictions group (B), click to select the
licenses that are to be restricted to contractors; multiple selections (2) can
be added to the list, or, select a license and click R (3) to remove it from

the list.
. Permit Type Maintenance ﬂ E
File Edit [Maintain Help
Department Building Department
Permit Type otfdl_repair
De=zcription (OTFD - Repair Residential
General T Sequences T eComponents ]
[V 2ddthis type to the E Component Web Pages
[~ &ccept Secondary Permit Types I accept Building § Unit Links v Use Contractor's Restriction
W] S B e m; Restriction doeznt apply to homeowners
4 7
—Restricted to the following property types Mame Types Contractor's License Restrictions J 3 )
I I Inspector of VWiring =] 1
Inspector of Plumking
R B P ] }J =
| = | El i, Vomn
I~ | Reguited Director of Emergency Management s 2 )
—Mur.tlmedla (GeE=s Tawn Hall Display Committes
build_plan ﬂ Suly Cods Tratfic Management Advisory Committee
Documents =1 I j Traffic Supervisar
- Transportation Committes
I j I™ | Required Traveling Meals Coardinator
= TreasurerTax Collector 7
—eSearch
Style Froup
4] 4 [Estting Existing Recard (17/54) » [¥]

ey | Save I Delete | Activity Steps | Columns | Browrse | Exit |

Note: When a selection is added to the list, it will no longer be available in
the drop down menu, until it has been removed.
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8. If a homeowner can also apply for this permit, select the Restriction
doesn’t apply to homeowners option (4); this will allow a homeowner to

also apply for the permit type.

9. Click Save to save the options.

Property Types

If the ePermit type is applicable to certain property types, only, select those
property types, from the Restricted to the following property types drop-
down list. For example, the permit type may be applicable to commercial and
industrial properties but not residential.

Note: If the ePermit type is applicable to all property types, you can leave

this list box blank.

R: To remove a property type, highlight it in the list box and click R.

Property Types are used for classifying properties, according to use; for
example, residential, commercial or mixed use. They can be used as a basis
in creating models for property assessments and appraisals.

Govern provides the following property types in the validation user table, VT _
USR _PROPTYPE:

Code

Description

0

Mixed Use

Residential

Open Space

Commercial

Industrial

O | | W|DN

Exempt
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The codes for these property types are reserved. You can add other property
types using other codes but it is important not to change the codes provided
by Govern, since they are used internally.

Tip: To create other codes of the same type, name the code with the same
initial digit; for example, different Residential types can be assigned the
codes 10, 11, 12, 13, 14, etc.; where in the case of 10, Residential is the
principal type and Mixed Use, is the secondary type.

Name Types

Names Types: Select all the name types that can be applied to the current
permit type, from the Name Types drop-down list.

Note: For the ePermit permit types, you need to define both the optional and
required name types.

Required: If a name type is required for the permit type, highlight it in the list
and click Required. In order for the ePermit application to be completed, all
required name types must be entered. If the user does not enter a required
name type, a message appears:

Please Correct The Following Errors:
*Prime: Confractor or Bulder 15 required,

Other name types may be added but are not mandatory for the permit
application.

R: To remove a name type from the ePermit permit type, highlight it in the list
box and click R.

Name Types are used for classifying individuals and companies, according to
their role in the permit process, for example, permit applicant or property
inspector.

Govern provides the following name types in the validation user table, VT _
USR _ PMNAME:

Code Description

appl Applicant
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Code Description
contact Primary Contact
insp Primary Inspector
owner Owner

Like the property types, the codes for the name types are reserved. You can
add other name types but it is important to keep the codes provided by
Govern.

Defining Name Types

In Govern, when a user creates a standard permit, the following name types
are automatically added if the corresponding options are selected on the
Permit Parameters form, in Govern Admin.

» The property owner is automatically listed as an Owner if Automatically
Assign Owner is selected.

* The property owner is also automatically listed as the Applicant if
Automatically Assign Applicant is selected.

* Theinspector is assigned, according to availability and Inspection Territory
if Automatically Assign Inspector is selected (Tables: PC_AREA and
PM_INSPECTORS)

However, for the ePermit application, these options are not applicable.
The Name Types need to be defined for each ePermit permit type.

On the Web, the applicant is automatically created from the user profile of the
person completing the ePermit application.

Select the Applicant name type so that the user can select a different applicant

from the Web page, when completing the application. Otherwise, you do not
need to select this option.

Multimedia Codes: Select the Multimedia Codes that apply to the permit
type, from the drop-down list (Table: VT_USR_ DEPINF).

R: To remove a multimedia code, highlight it in the list box and click R.

Required: If a multimedia code is required for the permit type, highlight it in
the list and click Required.
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Sub-code: Select the Multimedia Sub-codes that apply to the multimedia
code (Table: VT_USR_<table name>, where table name is the name of the
multimedia sub-code table, as entered on the Multimedia Code Maintenance
form in Govern Admin).

Note: To select a multimedia sub-code, you need to highlight the applicable
multimedia code. This enables the Sub-code drop-down list.

Search Styles and Groups

Note: It is necessary to specify Search Styles and or Groups.

Select either a Search Style or Style Group from one of the drop-down lists:

Style: Select a Search Style from the drop-down list. The search styles are
user-defined and are created through the Web Search Configuration Toolkit. A
Search Style launches an SQL query. It is linked to all the Objects that appear
on the Search page, including the search criteria and labels, of the ePermit
application.

Group: Select a Group from the drop-down list. Like the search styles, the
groups are user-defined and are created through the Web Search
Configuration Toolkit. A group launches a series of search styles.

Note: You can assign either a Search Style or Search Group to a menu item,
not both.

For details about Search Styles and groups, refer to the Dynamic Search Style
Management section of the Govern New Administration (GNA) release 5.1
guide.

Search Style Long Descriptions displayed on Web

In releases prior to 4.5.3 of the eGovern - Public Self Service Portal and
release 4.5.3.1 of the Web User Interface, the Web site would only display the
value entered in the Short Description field of the Dynamic Search Style
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form. Users of release 4.7 and greater will note that the value entered in the
English Long Description field is now used.

Make a Search By On web Site

( Code: pcOccupant C By Parcel ID
€ By Tax Map

By Business/ Property Occ
C By Subdivision & Lot

P e e T English Long Description:
By Business/ Property Occ By Business{ Property Ocq

' By Property Location

Sk L W W

' By Business/ Property Occ

C By TX Mailing Index
€ By UB Mailing Index

_’»A-A-’ F}Lﬂjﬂr _EW‘N-UJ S

Users of release 4.5.3 of the eGovern - Public Self Service Portal and 4.5.3.31
of the Web User Interface can update their functionality to display the name
entered in the English Long Description field by performing the following
procedure...

Note: The following steps are intended for users with release 4.5.3 of the
eGovern - Public Self Service Portal , and release 4.5.3.31 of the Web
User Interface. Verify your installed release version before updating.

To perform the update...

WARNING: Prior to performing the following, make a back up copy of your
WebUserInterface folder, specifically the following two (2) files
Web.config and Styles.css. These two files will be overwritten
and will need to be replaced with your original copies.

1. Download WebUserlInterface 4.5.3.31from the MS Govern FTP site.

2. Replace the existing WebUserlInterface folders and files with the new
version.

3. From your backup location of your WebUserlnterface folder, locate the
web.config, and the styles.css files and copy them to the overwritten
folder.

4. Open your web.config file using a text editor like Notepad or Notepad++.
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5. In <appsettings> section, paste the following line...
<add key="GovernSoftware.DescriptionType" value="Long"/>

<appSettings>

<!--
<add
<add
<add
<add
<add
<add
<add
<add

<add key="GovernSoftware.DescriptionType” wvalus="Long"/>

M5Govern configuration file--»
key="MSGovern.GovernNetConfig" walue="C:\M5Govern\Deployments\CMSTe=t\GovernNetConfig. xml™ />

key="GFovernSoftware

key="GovernSoftware.
.UploadDirectory™ wvalus="C:\Dummny'"/>
.UploadMaxFileSize" value="5048576"/>
Version_dnet" wvalue="3"/»

key="GovernSoftware.

key="GovernSoftware
key="GFovernSoftware
key="GovernSoftware

key="GFovernSoftware.

Ty A ety

.WebSite Id" wvalue="1"/>

DefaultPage™ value="WEEPROFILE"/>

DizplayBuildVerszion™ walue="Off"/>
TracelkrTransactionResponse” value="0ff"/>
o \MS5Govern\Deployments\CM5_Demo\Reports\"/>

<!-—<add key="GovernSoftware.GisServerName" wvalue="mtldev0l"/> —->

<!-——<add key="GovernSoftware.GisGeoDataBaseName" wvalue="Layers@Juneau"/> —-->

<!l-—<add key="GovernSoftware.hutolLogin.Login™ wvalue="+53fJF+/cy3EnUGebrJBESb5i/a+yclok" /> —->
<!-—<add key="GovernSoftware.AutoLogin.Password" value="47rYbcSvyxetMEXE6ZnEn6QwFOKG4tNog™ /> ——>
</appSettings>

6. Save the change.

Note: After performing the above modification, there is no need to perform
an IS reset.

After the update, users will note that the name entered in the Long Description
field of the Dynamic Search Styles form is now displayed on the Web site
description.

Make a Search By -

(s : C By Parcel !
e i On Web site aﬂ:er update...

Busi Pri 0Oc
syl sl el € By Subdivision & Lot ?
English Short Desaiption: Fnolich | nnn Nacrrintinn:

By Business/ Property Occ By Business/ Property Occupant

C By Property Location !

C By TX Mailing Index

C By UB Mailing Index
P"j IO e R 3

TIP: Modifying AppSetting section of Web.config file

When editing is required in the <appSettings> section of the Web.config file,
features of the IIS Manager allow you to make modifications to the file with
minimum interaction with other parameters. Insertion of new parameters and
modifications to existing parameters can be made with relative ease. For
example, to make the modification described in step 5 above:
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1. In the Internet Information Services (11S) Manager, locate the Website that

is to be modified (A).

™

Internet Informatien Services (IS} Manage

—
@ t’/’ ‘3 b DOVTLML » Sites » eGow » WebUserdnterface »

File  Wiew Help

Connections

b &) Default Web Site
A--@ eGov

» -] aspnet_client

o 71 images
»-[] Repaorts @
> [ uploads

P

Wehl_lserlntsﬁace
App_Dat

% App_The WebUsernterface

£l

b

b

be ] AR
b -2 aspnet_client
-] bin
o .7 Common
b

b

b

b

b

b

b

b

b

b

b

b

b

b

b

b

CommonContrals

7 CommonPages
Custarn
| CUSTOMCONTROLS
EM
Error
FR
Images
il
| In_Mahile
B
~ Multimedia
NA
Pr
Report
| RESOLRCE
Crint

9 MebUserlnterface Home
IE,

Filter: - Go %ShowAH Group by 5
3 E -
53 < * B 9

NET MET MET Errar MET MET Profile  .MET Trust
Authorizg orpilation Pages Globalization Lewels
_| ,
o - ab| ]
Application | Authentic,, Compression Configurat.,  Connection Default
Settings Editor Strings  Document
ey = ’ﬁ
CEJ = ‘?
Directory  Error Pages Handler HTTP Logging  Machine Key
Browssing Mappings  Respon..
= i = =
= ol = B 8 &
MIME Types  Modules Output  Pagesand  Request  Session State
Caching  Controls  Filtering

SMTP E-mail S5l Settings

1

=1 Features Wiew || Jj Content Wiew

Actions

2 Explore

Edit Permissions...

[E Basic Settings..

Wiew Virtual Directories
Manage Application A
Browse Application
Browse 8080 (http)
Advanced Settings..

o, Install dpplication From
= Gallery

@ Help

Online Help

2. Locate the Features View tab in the center pane and ensure that it is

selected (1).

3. Inthe center pane, double click on the Application Settings icon (2).

4. Place your pointer in the middle of the pane and right click to display a
floating menu; select Add...

@@ |3 b BMTLNL v Sites » eGov b WebUsednterface »

File  Wiew Help

Connections

- 3 Default Web Site

46 eGov
bl | asphet_client

images
Reports
uploads
\Webllserlnterface
| App_Data

AT T T

f )

| App_Themes
=] AR
| aspnet_client
1 bin

| Common

“| CommonCantrols
CommonPages

CUSTOMCOMNTROLS
EN

Errar

°] FR

| Images

N

1 In_Mobile

>
>

>

>

>

>

>

i

> Custom
>

>

>

>

>

>

i

~ AR

9 Application Settings
H=l

Use this feature ta store name and value pairs that managed cade applications can use at

runtirme,

Group by: Mo Grouping =

MName Walue Enitry Type
GowvernSoftware DefaultPage WVEBPROFILE Local
GovernSoftware DisplayBuildyersion Off Local
GowvernSoftware TracefeTransactionResponse  Off Lacal
{ GovernSoftware UploadDirectory CADummy?, Lacal
GovernSoftware UploadiaxFileSize 5048576 Local
GowvernSoftuware Wersion_dnet 3 Lacal
GovernSoftwiare WebReportDirectaryPath CiinetpubtmaamootyD...  Lacal
GovernSoftware WifebSite_ld 1 Local
MEGavern.CopyFilesfndFoldersLocally FALSE Lacal
MEGovern.GovernNetCaonfig CAMSGoverm\Governh...  Local
MEGovern.SynchFileAndFalders FALSE Local

Add.,

@ Help

Online Help

|8 @ -
Actions
Add..,
@' Help
Online Help
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5. Inthe Add Application Setting form, enter the following into the Name:
parameter, GovernSoftware.DescriptionType, and Long in the Value:
parameter.

Marme:

GowvernSoftaare.DescriptionType

Walue:

Lu:ung| I )

| o

6. Click OK to enter the new parameters.

Note: When entering parameter values, ensure that no additional spaces or
characters are added. The new entries can be viewed by loading the
Web.config file into a text editor.
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Dynamic Search Screen Interface

govern Hello JULIA GOVERN
i " oy : " 0 Help?
Home My Profile Online Services My Profile Setup Administration (eGov) Link Sign Qut
Version: 5.1.1307.4
Please complete the following step(s)
Select

Please Make a Selection
Predefined Selections
C Property: 95 Castle Hill Ct
€ property: 89 Castle Hill Ct
C Property: 91 Castle Hill Ct
€ property: 93 Castle Hill Ct
€ Pproperty: 102 Castle Hill Ct

Make a Search By
€ By Parcel ID R
€ By Tax Map
€ By Subdivision & Lot

€ By Property Location |
€ By Property Owner

€ By Business/ Property Occ
€ By Related Name

€ By TX Mailing Index

C By UB Malling Index

€ By Saved Dataset (P_ID)
€ From PC__EXTERNAL

[l

In the display, when a user is logged in under an eProfile, when a Dynamic
Search is used to retrieve a Name ID (NA_ID), the eProfile Name ID (NA_ID)
is displayed. Previously when a Dynamic Search is used to retrieve a Parcel
ID (P_ID), the system would also show a list of parcels that are attached to the
current eProfile account.

Permit Kinds

The Permit Kinds are defined by Govern and are used to classify permits,
according to general purpose, such as building or electrical permit. The Permit
Types are more specific categories and are user-defined. In Govern, they are
selected for the permit kind. However, a permit type can be applicable to more
than one permit kind. For example, a commercial additional can be applicable
to a building permit, general permit, electrical or plumbing permit. Permit Kinds
are not specific to the eGov. Refer to the Permits & Inspections guide for full
details on the Permit Type Maintenance form.
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User Added Columns for the ePermit Types

Click Columns to add fields or columns to the eComponent

Colurnnz | Web pages. This is equivalent to adding columns to the
Dimensions or Forms tab in Govern.

Note: The added columns are applicable to the selected permit type only.
They are the same for both the standard permit and the ePermit

You need to define the display order and access right properties for the added
columns, using field setup mode in Govern, as follows:

1. Launch Govern for Windows.

2. Open the applicable function for the permit type.

3. Select the permit type on the General tab.

4. Open the Dimensions or Forms tab.

ﬁn (1) Building Department.Land Management - Building Permits

General Summary Inspections | Conditions
FPermit Type ARCHITECT Contractor =]
IEluiIding Historic j I Berkshire Fence Co.
Engineer Basement Size |
I |{| 4 |Editing Existing Record (1/1) [ 3]
[y | Save I Delete | Brovvse | Histary | Fee Report Exit

5. Select Setup > Field Setup Mode.
6. Double-click in an added field.
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i, Field Setup x| |

[~ System Field
¥ Empty Yalue Accepted

—YalidationType

Mo Walidation

" System Takle
 User Tahle

" Date

" Date & Time

= Time

{* Mumeric

" Currency

" Currency (Mo Decimal)
" Field Mask

{~ Logical Expression
! TruefFslse

= Wemo Field (BLOS)

=TAB=

|1 33

imirmum

Wicth

|25E|1

Mzximum

jo

[~ Locked Field
[T Uze Spell Check

3E+30

[~ Link Formula

[~ Link Logical Expression

—eCamponents

.

Display Crder
ISI:I

Display Access Level

Calumn Mame

|BASEMENT_SIZE

[ allow Modification %
Update &ccess Level

Ilnternei wyith prafile

|

Ilnternet subzcriber j

e

-

oK

Securty

Cancel |

The Tab, Width, Minimum and Maximum fields apply to the Govern
application only, the Validation table, applies to both Govern and the Web.
Refer to the Permits and Inspections guide for full details.

The Column Name field displays the column corresponding to the

selected column.

Note: The Allow Modification, and Update Access Level parameters are
for future use; there is no effect if these parameters are selected.

7. Enter the Display Order under eComponents. This is the order that the
field is displayed on the Web page. This applies to the customized fields
only. All the standard fields are displayed first, on the page.
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Select the lowest access level, at which you want to display the field, from

the Display Access Level list: Refer to Priority of Access Level below for
details about priority.

¢ Intranet Admin

* Intranet User

* Internet Subscriber

* Internet with Profile

* Internet without Profile

9. Select the lowest access level at which users can update the selected

column.

10. Click OK on the Field Setup form.
11. Repeat steps 6 to 10 for each added field.

12. Save the function in Govern.

Priority of Access Level

Higher access levels have automatic access. For example, if you select
Internet with Profile, the Internet Subscriber is also able to see the field.
However, the field is not displayed to a user with Internet without Profile

access rights.

Below is a list of the Internet/Intranet access level.

Priority Binary Reference .
Level for Crystal Reports Details
1 16 Intranet Admin - Set this security level
(Highest) to make this menu accessible to
Administrators within the organization.
2 8 Intranet User - This is the Security level
for a user within the organization.
3 4 Internet Subscriber - When selected,

the security level is set to that of a
subscriber.
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Priority Binary Reference .
Level for Crystal Reports Details
4 2 Internet with Profile - This menu
selection will be accessible by internet
users with a saved profile, i.e. only
internet users with a profile will be able
to see this menu.
5 1 Internet without Profile - This menu
selection will be accessible by internet
(Lowest) users with no saved profile, i.e. all

internet users will be able to see this
menu.
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Overview

For each permit type, you need to create Activity Steps and then link the steps
together to create an Activities Setup. An Activity Step represents a stage in
the permit process; for example, application, review, inspection or certification.
The Activities Setup represents the process. Each Activity Step can include
one or several System Activities. For example, for the review step, you can
include the plan, zoning, building and site reviews. Each system activity can
generate a number of actions, including inspections, business rules, e-mails
and interdepartmental notifications. Each activity step can also generate
e-mails, interdepartmental notifications, the next activity step and a fee.

To open the Activities Setup form, from Govern’s main screen, select Tools >
System Administration (Govadm32.exe)

OR

Click Applications in the Side Navigation Bar to display the application, click
System Administration.

In the System Administration:

1. Select Parameters > Land Management > Parameters.

2. Next, highlight the Department and select Maintain > Definition of Type >

Permits.
3. Inthe Permit Type Maintenance form, click Activity Steps.
! !
Logical Expression E
| 2 3 =l
—work Codes Type:
ﬂ
=l
4| 4 |Editing Existing Fecord [1/53) » I NI
Hew | Save Delete " hctivity Steps [4 Lolumnz | Browse E it |
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. Activities Setup - Permit

Department Permit Type Step Number Description
|Building and Zoring Division J4ACC - Addi T Mise Acce Comm Blda) [10 |
Activities — Fee Calculation
0000 (Application [nguing Fisad Amount I—
00150 [Application Accepted)
Method [£4EC Fee =]zl
Initiate at I j
[~ Allow Fee & GAL Ovenide
GAL Revenue Account # 1 24
GAL Revenue Account #2 Fee Description
r Shatu: r Default Answer
Code I j Initiate at I j ICompIetion Status 1 j
—Mext Step Number For
Status 1 Statuz 2
ﬁves =zl [0 [lNo B
Statuz 3 Status 4
[ISpeciaI j _il | (Iﬂestarl j _il
v Automatically intialize the nest step
I ‘I 4 |Ed|t|ng Eizting Record [1/23) M
Hew | Save I Delete Browse | Muotify Uzer | Matify Clisnt Exit |

There are no additional ePermit parameters for the Activities Setup. This
setup is the same as for the standard permit. There are, however, some
differences in how the Activities Setup, System Activities, Fees, E-mails and
User Notification messages are handled internally.

It is recommended to review the Activities Setup for all the permit types to
which you are providing Web access.

Activities Setup

Note: In this section of the guide, the screen shots and descriptions refer to
the Activities Setup for the Permit Types. The Activity Setup forms for
the Offense and Workflow Types are the same, except that the Fee
Method and Status fields are not included. Refer to the Permits &
Inspections guide for further information.

For an ePermit application, a validation is performed on the Activities Setup,
by following the default order of activity steps. The default order is defined
according to the Default Answer defined for the Next Step Number For field:
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G/L Revenue Account #2 Fee Desciiption
| ! 1
— Status r— Default Answer - 1
Code I j Iitiate &t I j ICompIetion Statuz1 =7 hd
—Mext Step Murber Far /1
Status 1 5 2
[IYes o I3 R Mo ==l ]
Status 3 Status 4
[ISpeciaI j _iI | ’7|F|estalt j _il |
W Automaticaly initialize the nest step
I NI 4 IEditing Ewisting Record [1/23) 4 I HI
Hew | Save I Delete | Browsze | Matify U zer | Motify Cliert | E xit |

If, by following the default order, an endless loop is created; for example, if
from Step 100, the default for the next step is 200, then 300, then 400, then
back to 100, there can be no end to the activities. In this case, the ePermit
application terminates, a message is displayed to the Web applicant and an
email message is sent to the Webmaster.

In Govern for Windows, the default order is displayed on the Activities
function. No validation is made. If there is an endless loop, the activity steps
continue to be added until the user closes the function.

¥ (1) Assessor's Office.Activities K Ed
|GA.RA- Private Carage
Step |.t’-‘n.ctivit_l,J ~ | [rate Starked | Completed On | Statuz | Reference # |Userld | Azzign to | Total Time ﬂ
0] Application |nguiry 11172007 10 govern
..... AT &opication A ccepted —_|_11/1/2007 | tE0goven| | |
[320] Iz Prop Regulated Under Chap 53 [fema]”r’ 320
[322] Regulated by Starrmwater Mamt Boundan? 322
[340] Survey 340
[360] Mizcellaneous Documentation Received? 360
[320] Hiztory Certificate OF Oocupancy 3an
[390] lzzue Permit 390
[400] Action[r'=lnz M= E:-ttS—.ﬂ«mend A= Henw] 400 -
‘I'liﬂ\ P P L T Y vkl o™ Fio.... mn AT LIJ
Comments tultiredia Link Code it =
;I I j Itizte Bemove
;I Multimedia | Complete | Browze |
|I4| o4 |Edii isti Jave I eyl |
iting Eizting Record [1./3] M =
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The Activities Setup is otherwise executed for an ePermit application, exactly
as it is for a standard permit application.

System Activities

Each activity step includes one or several System Activities. With the following
exceptions and notes, the activities are executed for the ePermit application
exactly as they are for a standard permit application.

Multimedia Codes

If a multimedia code is required for an Activity that is initiated by the ePermit
application, an empty record is created for that code. This entry needs to be
completed in Govern, once the application is submitted.

New Permit, Offense or Workflow Generation

If a new permit, offense or workflow process is generated through an activity,
associated with the ePermit application, the first activity step for the new
process is not automatically initialized. It needs to be started manually. This
rule also applies to the new permit, offense or workflow processes, generated
through an activity associated with a standard permit.

Business Rules

If a business rule, associated with an activity initiated through the ePermit
application, is not valid, the application cannot be submitted.

Similarly, in Govern, if a business rule associated with an activity is not valid,
the permit cannot be saved.

Note: Only the business rules defined for the Activities that are linked to the
Primary Permit Type, through the Activity Setup form, are executed.

Fees

For details on how fees are applied to the ePermit application, see ePermit -
Defining Fees for the Application on page 196.
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Interdepartmental User Notification and External Client
E-mail messages

If an interdepartmental message or external e-mail is associated with an
activity or activity step, generated by the ePermit application, it is sent from the
user defined in the User ID for Web-generated System Activities field on
either the Land Management or Permit Parameters form. See User ID for
Web-Generated System Activities on page 154 for details.

E-mail messages can be created and associated with an Activity or Activity
Step through the Notify Client by E-mail form, in Govern Admin. These are
sent through the server using the SMTP Parameters defined on the System
Registry Maintenance form. For example, you can set up an e-mail to be
automatically generated and sent to the contractor and building owner on
completion of an activity called, Application Accepted. If the activity or activity
step is initiated through the ePermit application, the e-mail is sent from the
user defined by this parameter, using the e-mail address defined for the user
on the User Maintenance form.

Similarly, user notification messages can be created and associated with an
Activity or Activity Step through the Notify User form, in Govern Admin. If the
activity or activity step is initiated through the ePermit application, the
message is sent from the user defined by this parameter. The default
department of the user is also included if one has been defined on the User
Maintenance form. For example, you can send a message to notify the users,
in a department, that a permit application has been accepted and to provide
them with the information they need to complete the next activity step.

The message is sent to all the individuals and companies linked to the ePermit
application. However, if the following fields are defined for the message,
through Govern Admin, they are ignored if the activity is generated through the
ePermit:

+ Dynamically Modify User List
* Dynamically Modify Message
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. Motify Client by E-Mail K Ed
Department Type Step
Building and Zoring Division JasCC - Addi To Misc Acce Comm Bldg! {10

— E M ail Information

Message Subject & pplication Accepted

Thiz meszzage iz 2ent to notify wou that your Bulding Permit Application ;l

essema e has been accepted.

[~
Completion All Status ~ Additional Infarmation |

v Dynamically Madify Client List

Initiate at

[ Dynamically Madify Message Test

Save | Delete E xit |

Otherwise, the System Activities are generated for an ePermit exactly as they
are for a standard permit application. This includes the generation of:

* Automatically scheduled inspections or hearings
* Unscheduled inspections

* Time cost codes

* Report generation

* Permit starting and expiration dates

* External client e-mails

Refer to the Permits & Inspections guide for further details on e-mail and user
notification messages.
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Application

Overview

Fees are defined on the Activities Setup form, in Govern Admin, and are
applied to the ePermit, when the activity step is executed, in Govern or from
the Web.

These fees are calculated and displayed on the Final Summary page of the
ePermit application, beside the heading Total Estimated Fees:

Default Activity Steps for the Selected Permit Type I

Previous Step | Next Step

Default Activity Process
Application Accepted Fee: $10.00

Zoning Compliance Review
Building Code Review

Fire Review

Electrical Review

Plumbing R

Planning Review

Issue Building Permit Fee: $10.00

m

Building Inspection Fee: $1.00

Issue Certificate of Occupancy?

End of Process

Total of Estimated Fees $21.00

Permit Application Fee $0.00

This calculation is made by calculating the fees associated with the Default
Activity Steps for the ePermit, according to the rules described in this section.

Note: Fee Displayed = Fee of Default Workflow + Fee of first activity
only (if fee is configured)
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A Default Activity Step is a step entered in the Default Answer For parameter

of the Activity Setup form, associated W|th the ePermit.

I U=l =l |E0mpletlon Statusz 1 Ll
I jT ¥ Allow Fes & GAL Dvenide
G4L Revenue Account i 1 4/R Class
| | i
GL Reverue Account #2 IFEE Deseription m
Skatuy rDefauIt Anzwer N
’750‘:‘9 I j Initiate at I ;l ICompletion Status 1 j}
Mezt Step Mumber For =
Completion Statug 1 Completion Statug 2
IVIYes j _1| ‘ ’V INU jil ‘
Completion Status 3 Completion Status 4
(INotNeeded j_il | ‘ ’7|F|estalt ﬂ_il | |
¥ Butomatically initialize the next stepé
I Nl 4 |Editing Existing Fecord [1/5) [ AL
MHew | Save I Delete | Browse | Maotify U zer | Matify Client | Ezit |

Applying an Application Fee to an ePermit

You can link a fee to the ePermit, to be paid when the application is made.
To set up this type of fee:

Launch the Activities Setup — Permit form, in Govern Admin.
Scroll to or create an activity for the acceptance of the application.

Enter the fee in the Fee Amount text box or select a Fee Method, from the
Method drop-down list.

4. Select Initiation, from the Initiate at drop-down list.
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Step Mumber Description
.nm Bldg | [10 |

— Fee Calzulation

2 Fixed Amount |$?5_UU
Method BACC Fee 2
F || Iritiate at Initiation hd

] t| ¥ AllowFes & G/L Overide

Fee Description

I
Default Arswer

vI IEompIetionStatus1 ﬂ

I il =

W -

The amount is displayed on the Final Summary page beside the title Fee
Charged at Application Creation. This fee needs to be paid immediately.
Otherwise, the application cannot be submitted.

Note: This rule is applicable only if the fee is to be charged at the /nitiation of
the activity.

Rules for Applying Fees to an ePermit

All fees associated with the Primary Permit Type are charged. See Rules for
Applying Fees According to Fee Type on page 200. The fees associated with
the Secondary Permit Type are charged, according to the Activity Step
Number and the Type of Fee:

Rules for Applying Fees According to Step Number

A fee linked to a Secondary Permit Type is charged only if the Activity Step
that it is linked to is assigned the same Step Number as an activity step
associated with the primary permit type. Otherwise, the fees associated with a
secondary permit type are not charged.

Note: The Activity Steps do not need to be the same, they just need to be
assigned the same Step Number.
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. Activities Setup - Permit

Department

Permit Type

Step Mumber Descrptian

IBuiIding and Zoning Divizion

Activities

J&ACC - Addi To Mise Acce Comm Bldg) 10

000710 [Application [nguirg]
00150 [Application Accepted)

Method

G/L Revenue Account # 1

G/L Revenue Account #2

 Fee Calculation

Fixed &maunt |$?5_ oo

Initiate at

|mcc Fee

IInitiation

¥ Allow Fee & GAL Overide N

Fee Description

 Status r Default Answer
Code I j Initiate at I j ICompIetion Statuz 1 j
— Mest Step Mumber For
Status 1 Status 2
’7|Yes 3 B [ [Na R
Status 3 Statuz 4
’7|Special j_il I [IHestalt j_il I
v Automatically initialize the nest step
I HI 4 IEditing Eristing Record [1/23] Ald)
Hew | Save I Delete | Browse | Motify User | Motify Client | E it |
For example, if a fee is associated with Step Number 100 in the Activity
Setup of the Secondary Permit Type and the Activity Setup of the Primary
Permit Type also includes an activity step with a Step Number 100, the
fee for the Secondary Permit Type is charged, even if the Activity Steps
are different.
Prima Secondary Secondary Total Fee for
Condition Permi?fl' e Permit Type | Permit Type | Activity
ype | A B Step
Activity Step 100 100 200
Number
Fee $40.00 $25.00 $30.00
Fee Charged $40.00 $25.00 Not charged | $65.00
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Rules for Applying Fees According to Fee Type

Two types of fees can be defined on the Activity Setup — Permit form and
linked to a permit type, Fixed Amount and Fee Methods. Critical to the eGov
user are any fees that are set at the initialization of the first activity.

Refer to the Fee Computation Setup section of the Permits & Inspections
guide for further details on Fee Methods.
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ePermit - eRenewal process

One of the features of the eGovern — Public Self Service Portal is eRenewal.
With eRenewal, Municipalities can offer the option for users to renew specified
permit types through an online process. eRenewal can be configured for any
Govern activity step that allows renewal.

Configuring eRenewal

The following example is based upon a preexisting Workflow that generates a

Business License.

STEP 1 - Select a Renewal Process

To configure eRenewal, we will use a renewal process for a Business License.

-
B3 Permit Type Maintenance

2 |

File Edit Maintain Help

Drepartment |Cilizens Services
Permit Type BUSLIC
Drescription |Business License

General T

Seguences T

Iv 2dd this type ta the E Component Web Pages

™ Accept Secondary Permit Types

™ Accept Building # Unit Links

™ Accept Property Links ™
Restricted ta the fallowing property twpes Mame Types
Applicant J ‘ J
-
Multimedia Codes
IMGDE Sub Code
| Sl r
eSearch
Style Group
‘ j |Search by Property j
4| o4 |Editing Existing Recard [1/2) (A1)
Mew | Save | Delete | Activity Steps | LColumnz | Browsze E it |

T e
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When we Browse the activity steps, we see a renewal step (25) with an
associated fee method, i.e. a Business License fee (BLFee).

Browsing
Terdl enbar ofiows 5 o

Tatals| Step number| Activity number | Long Description Mext lewel 1| Mext level 2| Mext level 3[ Mext level 4| Status change code | Fived fee amount| Fee method

¥ ¥ ¥ ¥ L ¥ Il
BLFea_

r i T T T T T T -

f‘w\
ro
o
o
LSali=
EE
g
=
@
=
oy
o
@

S
o
@
ro
o
w
=1

1
j
|_h‘.-~__‘ofﬂm D ,;.’*HIJM..——‘/

At activity Step 25, the license renewal step, the Method is set to Business
License Fee, and the Initiate at field is set to Completion Status 1.

ULl L] Department Permit twpe Step Number Description
AL Flevarusn Accoun I3 | IE\hzens Services IEus\nEss License 25

Stahus _ | Activities [T Mandatary Activity — Fao Cslklfm

Lot [PenedLcerae =] e () [O0025 [Rerew License] Fivedémount [

Hest Step Humbes For i p— ~
%ﬂ F{ Method IBusiness License Fee ;I _il
Comypheten Stsha Initiate at Completion Status 1
- - ﬂ I omplehon atatus ;Ij

¥ Batomsicaly mbskze the net tfep LI + || T Allow Fee & G/L Overide

A A i Evivirng Rcund 204] AsR Class

e [ Gwe | ped ILand Management ;I
Fee Description
IHEnewaI Fee
Statu: Default Answer
(CDdE I LI Initiate at I d (IEnmpIEhnn Status 2 LI
Mext Step Mumber For
Complation Status 1 Completion Status 2
’7|ves EE ‘ ’7|Nn =]zl [ ‘
Completion Statug Completion Status 4
’7|Nut Needed ;I_tl | ‘ ’VIFlestarl ;I_tl | ‘
¥ Automatically initialize the nest step
I 4| 4 |Editing Existing Record (3/4) | 21|
Hew Motify Usger Maotify Client
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STEP 2 - Set the Renewal Period

In the Permit Systems Activities screen, under the Page 2 tab, the Expiration
group is configured. The License is set to expire in 1 year, and the Initiate at
parameter is set to Completion Status 1.

[ Permit System _

File Edit Help
|| Department Reference Mumber Description
ICilizens Services 25 IHEnew Licerse
Page 1 Page 2 T Page 3 T Page 4 ]
r~ Starting i~ Creating N
Number/Date  Starting at [ PemitLicerse
| I LI I~ Offense
I workflow
Iritiats at I ;I Kind I LI
~ Expiration A Department I LI
Number/Date Expiration at Iniiate at I LI
|1 IYears ;I Type I LI
Initiate at ICUmpIetiUn Status 1 j
M -
‘ Business Fules | Matify Lser | Matify Client | Action Query | ‘
I [LIK] IEdlhng Existing Record [3/4) biM
Hew | Save | Delete | Browse | Exit |

STEP 3 - Set the Response

Next click the Page 4 tab; in the eRenewal group, select the Allow eRenewal
option. At this point you will also need to specify the response that is sent to
the activity so that the process will continue. In this case it will be the
Completion of Status 1. Set the Response parameter to Completion Status1.

[ Permit System _

File Edit Help

|| Department Reference Mumber Description

ICilizens Services 25 IHEnew Licerse

Page 1 Page2 | Page3 | Page &

Target Date,/Tim Fenewal

Murber of days Number of hours [V allow eRenewal

I I Response ICompIetion Status 1 ;I

I~ Accept a start date lower than the pravious activit [NET Only)

Business Fules Matify Lser Matify Client Action Query | ‘
I [LIK] IEdlhng Existing Record [3/4) biM
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STEP 4 - Verification in Activities Function

In Govern for Windows, the Business License is ready for renewal. We can
launch the Activities function for verfication

-4 (1) Citizens Services.Land Management - Business License

General T MNames T Links T Summarg T Forms T Inspections T LConditions T Ewents ]
Last Fee Assessed $66.00
License Type License Puipose
Business License J e
Business Licenss
Reqistration Number Start Date
J Expiration Date
- .
Restrictions Business Type Mb. of Employees
- =l Iz
e
Hew | Save Delete Browse History Fee Exit

14| 4| Editing Existing Record [1/1]

3]

Looking at the Activities function, we see that we are at step 25, Renew

License.

u ) Gt i [ =l

Goonal | Mamer | Lk | Suwnay | | grapectens | Contiors | Eves |

0o Foe Atsreind 26 0
Licencs Ty Licerie Pusgose.
i s =]
(1) Citizens Services.Activities
et Business Licans2
—= I
Rashicions - Buiress Type
Step |Acl|wty | Date Started ‘ Completed On ‘Slatus | Reference # ‘Uselld | Aszsign to | Total Time Spent | Target Date
Application Accepted | 9/29/2011 9/29/2011 Yes 10 govern
01 9/23/2011 Yes 20 govem u

e | Save Dt Bt | 1

1] A | it Eosstieg Rcand (171)

Renew

—
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Initiating the eRenewal

When the activity step is ready for Renewal the eComponent is ready for
input. The logged in user can select Online Services > eSubmit > Permit or

License Renewal.

govern Hello JULTA

Home My Profile Online Services My Profile Setup Administration (eGov) Link Sign Out HEE

(TR I kL7 d Property Information
ePayment »

JeSubmit » | Apply For a Permit

ePermit Ap
1 os| Request for Information
File a Complaint

Request an Appeal

OTFD - Detached Garage 91 Castle Hill Ct  179-105-601-2

The eRenewal Application form is presented and we see the Business
License renewal; the entry is selected (A)..

& MSGovern

Management Solutions for Govemment

govern Hello JULTIA GOVERN

Home My Profile Online Services My Profile Setup Administration (eGov) Link Sign Out L

Version: 5.1.1307.4

Select your application

Back to your Account

Permits by Names

Business _
Catbificate L02013004 5/16/2013 6/3/2021
—

Permits by Properties
Business = .
i Select Certificate BL2013002 5/15/2013 6/3/2021 ;

When the item is selected, the renewal form is to be completed; the
associated fees are indicated. The progress of the process can be monitored
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through the application process indicator displayed along the top of the
screen.

Version: 5.1.1307.4

eRenewal Application

Application selection | Application detail

Application detail

Previous Step ] Next Step I j

fPermit Number: W N
Permit Date [5/15/2013 B
Expiration Date |6I3.f2021
Total Fees W

Purpose

Change by eGov 1

Permit Types |Business Cerlificate

o J

At the next step, relevant multimedia documents can be attached to the
record.

Version: 5.1.1307.4

eRenewal Application

Application type | Select a properly | 0O Richard Permit Application | Add individuals or companies

91 Castle Hill Ct  179-105-601-2

Add the documents associated with the application.

Previous Step I Next Step
Add a Document to the Application | *Building Plans Iz[
Document Location
Add Document ] Cancel ]
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In the final step the eRenewal process is summarized and ready for
settlement. Payment can be effected through ePayment.

Version: 5.1.1307.4

eRenewal Application

Application selection | Application detail | Activity Steps | Payment method w

Hello JULIA GOVERN
Home My Profile Online Services My Profile Setup Administration (eGov) Link Sign Out
Version: 5.1.1307.4
eRenewal Application
Application selection | Application detail Payment method | Payment | Confirmation
PRy  Aspcaonscecion| | Pament | Contmaton
Credit Card Information l

Previous Step Next Step [

The 2013 Harris Customer Conference is sch: Type: | Visa [=]
Number:

Month Year

Expiration date: m m
Name as it appears on card: [JULIA GOVERN
Address as it appears on card: [W
7ip code / Postal code as it appears on card: (52007

After settlement, looking at the Activities function in Govern, the completed
activity step will be seen.

FIY FIOIS UImNS DSIWILED Fry CIUINS DSLUR mUEINSL U (SEOY ) L g o

1307.4

eRenewal Application

‘Application selection | Application detail Payment method | Payment | Confimation | Appiication Completed
Ls

Application Completed

Application Confirmation l
Previous Step
General Information
Department City Clerk
Application Kind Business License
Primary Application Type Business Certificate

The application will be issued on the following property

Primary Application Type
Business Certificate

Registration number 132456798
Business type al

Number of employees 1111

License Purpose eGov renewal 1

Billing Information
I TA GOVFRN
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eRenewal Confirmation

An additional notification of completion is sent to the user in the form of an
email confirmation message.

@ Rules @ Mark Unread ﬂﬁ
T
3 Team E-mail »

Sent:  Thu 9/29/2011 2:05 PM
1 Eric Martineau

Subject: Fwad: - Confirmation of payment

| Please do not reply to this mail

Pavment Sucessfully Processed.

|| Receipt: WB_RP 00002215

Billing Information
| MS Govemn
95 Castle Hill
North Sea, MA us 11968

Invoice
Description

Convenience fee

Payment Grand Total

Payment Method - Electronic Fund Transfer (EFT)
Bank ID
Bank Account Number
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ePayment - Setting the Web Parameters
Overview

The ePayment tab is used for configuring and maintaining the default
parameters for the ePayment data.

Note: Web ePayments parameters are in the Govern NetAdmin (GNA). See
Web Site Manager on page 62 for details of related parameters.

To access the form in GNA...

1. Select Application Configurations (tab) > Web Configuration > Manage
Web Sites...

2. In Web Sites form, click to select the ePayment tab
Govern New Administration (GNA)

- a x
i M Options

Parameters  Application Configurations | Editors  Utilities  Windows  Help

F\& B © & @ P Q& @ & B & N

Manage Manage OpenWeb  Roll Forward Real  Personal Motor AirCraft Boat Business _Accounts Mass Utility Matix
Web Site b Skin Config Editor | Exclusion Property = Property = Vehicle = Excise~ Excise~ Tax+ Receivable= Appraisal~ | Biling= | Configuration
eb Configuration General Govern Tax CAMA Billing Matix

B Manage Web Site X

1 - Ms Govern

2 - M5 Gavern - Beta ,_rWEDS“E L \

Web Site 1d [I | web site Name [Ms Gover | ( Menusetup |
Webskin [ MSGOVERN ] web siin Preview

\ eProfile G{ePa','mErt 3’ et [ emspection Y o \

<,

[ Live Made M User Canfirmation Required Mirisans pay,,,anmmmq ;123‘00‘
Cashier ID [we.ch_ |bisptay X previous Payers | 3
Receipt Prefix |WB,RD, ‘Business End Day 11:59 PM EE
Default Installment  Totel | Block RE Payment After 12,-31/21005'3
[0 bisable eSearch Multiple Selection (] Deactivate Weekend Batch No (A Disable Payment Aute Selection
(O Disable Overpayment (0 Disable Payment Less Than Minimun

\w = I
8 Allow ACH
ACH Batch Suffix [WB_AC |
Check Image Path
Business End Day 1seeml+]

Web Sites Manager Command Buttons

Menu Setup: Click Menu Setup to open the Web Site Menu editor and

create and edit your site menus. See Defining the Web site Menus on
page 33 for details.

Web Skin Preview: Click WebSkin Preview to display a preview of your
web skin in a window.
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New: Click New to create a new Web site.

Note: When you click on New, the button changes to Cancel; this will allow
you to cancel the creation of the current record. The Cancel button is
present until the new record is saved.

Save: Click Save to save your new Web site, or any changes that have been
made to an existing site.

Delete: Select an existing Web site from the Web Sites list on the left hand
side, click Delete to delete the site.

Closing the Editor

To close the editor, click the Close Window button in the upper right hand
corner of the form.
Govern New Administration (GNA)

_'Fili_ Options Parameters Application Configurations Editors Utilities Windows Help

PO E © & € 5@ S B @ F

Manage Manage OpenWeb Roll Forward Real Personal Motor  AirCraft Beat Business Accounts Mass Utility M:
Web Site Web Skin Config Editor Exclusion Property = Property - Vehicle = Excise~ Exciser Tax~ Receivable - | Appraisal ~ Biling~ | Config
Web Configuration General Govern Tax CAMA Billing M

'5 Manage Web Sif

1 - Ms Govern
2 - MS Govern - Beta

Web Site 1 or 2 \
Web Site Id |1 ‘ Web Site Name [Ms Govern

Web Skin [ MSGOVERN

[ General \f eProfile I(EPa',fm&rt \I-' ePermit \( elnspection '“- eRemittanci
[D Live Mode b User Confirmation Required Minimum Payment Amcuznkl:
Farkiar ID lwe rH | Nienton ¥ Dramdime Dmrmre |
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Web Sites Manager ePayment tab

The Web ePayment Parameters form is used for setting and maintaining the
default parameters for the ePayment data.

Govern New Administration (GNA)

Options  Parameters | Application Configurations  Editors  Utilities  Windows  Help

B & B © & @ 2 QL@ & B @& W
Manage Manage OpenWeb Rl Forward Real Personal  Motor  AirCraft Boat Business Accounts Mass Utility Matix
Web Site Web Skin Config Editor Exclusion Property = Property ~ Vehicle * Excise~ Excise~ Tax+ Receivable~  Apprasisal=  Biling~=  Configuration
Web Configuration General Govern Tax CAMA Billing Matix
B Manage Web Site X
s (s EER i
Web Site 1d [I | web Site Name [Ms Govern | ( Menusewp |
Web Skin [ MSGOVERN ][Wah&km Prsvlaw]
( . General \f eProfile '\IE aPayment i}‘ \( elnspection \f \( 1
[ Live Mads kA User Confirmation Requirei Minimiam paymenmmum‘ 5123‘D0|
Cashier D [we_cH_ | isptay X revious Payers | El
Receipt Prafic  [WB_RP_ |Business £nd Day 1159 PME}
Default Instaliment Total ] Block RE Payment after 12,-31/210053
[0 Disable eSearch Multiple Selection [] Deactivate Weekend Batch No A Disable Payment Auto Selection
[0 Disable Overpayment [ Disable Payment Less Than Minimun
,—( ACH \f Credit Card / Debit Card / Check ’ ”'.I Site Seal Script = \ \
A Aliow ACH )
ACH Batch Suffix [WBAC |
Check Image Path | |
Brsiiness B oy 11:59 PM EE|
G ience Fee
Whraerain| $1.00] Masimum | 5100 percentage 0 |
Web Site Manager - ePayment tab Parameters
Live Mode: The MS Govern ePayment sub-system can be used in two
modes: Live Mode, and Test Mode (default mode). Test Mode allows you to
perform simulations on the system with credit card providers in “test mode”.
When the Live Mode option is selected, the sites are to be live on the internet.
Select this option to run the Web site in a live environment.
User Confirmation Required: Select this option to display a confirmation
of transaction prompt when an online transaction is initiated by a user. When
not selected, transactions will be completed without a confirmation.
Minimum Payment Amount: Enter the minimum amount that can be
accepted for an ePayment, in dollars and cents. If the user enters an amount
that is less than the minimum payment value specified in this field, an error
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message is displayed. The user will need to correct this amount in order to
complete the ePayment transaction.

Cashier ID: Enter a prefix for the cashier ID; this ID is comprised of this
prefix followed by the effective date.

Display X Previous Payor: In this parameter “X” represents the number of
previous payers that will be displayed in the list.

Home  Online Services  Your Profile  Links  Sign Out Help? English

Step 3: Select Previous Payer, if you have already made an ePayment, or select a New Payer
and fill in the parameters.

* Web User T Previous payer
Hidalgo Exports Olusegun Claniyan
1224 B7th Ave 2245 Regent Ave.
MNew York NY 1002% Montreal QC H4A4 2R2

s

T New Payer

Receipt Prefix: Enter the sequence that will be used as a receipt prefix. It
consists of a maximum of three characters and is used as a prefix for receipt
numbers (Table: USR_KEY_ RECEIPT)

Business End Day: Enter the
end of the business day, in hours

and minutes. This parameter is used

for calculating interest and penalty :\_ L)

elnspection

Minimum Payment Amaunt]| s122.00]

Display ¥ Poevicuss Pagers | |
|5k T

Block RE Payment After | 12,’31/210{!@
Charges' Charges on payments hNo (A Disable Payment Auto Selection
accepted after this time will be n Minimun

calculated as of the next business == oo
day. As an example, if you enter
4:00 P.M., depending on the
Interest Method selected, interest on payments received at 5:00 P.M. may be
calculated as of the next business day. Interest on a payment received Friday
evening is calculated from Monday morning or the next business day if the

I ]
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Monday falls on a holiday. Otherwise, payments are processed and accounts
are updated in real time.

Note: It is important that this parameter is set because this value, when

applicable, can affect the result of interest calculations; verify the
Interest Method that you are using.

Modifying the “Business End Day” Parameter
The Business End Day parameter (A) can be modified as follows:
1. Click in the parameter to highlight the current value.

The numbers must correspond to the hours, minutes, and time of day, i.e. AM
or PM. The format is as follows: HH:MM AB

...where HH is the hour of the day, MM is the minutes, and AB is the time of
day, i.e. AM or PM

Default Installment: Select the A/R installment for which payment is
currently due: first, second, third, fourth or total (Table: VT_ SY_INSTALL). By
default, the installment due is selected on the Web page, as in the following
screen shot.

Note: Leave this field blank if you do not want the default installment to be
selected on the Web page.

This field is required for Real Property Tax payments only.

Home My Profile Online Services My Profile Setup Administration (eGov) Link Sign Out
Version: 5.1.1307.4

Accept the default or enter the amount you want to pay- j

Previous Step Next Step
Description Details Amount To Pay
Type Amount

Real Estate 2011 ;:;:Hmen: $3,686.12
Tax Map Number: 172-105-601-2 Fourth £7,372.24
Property Location: 91 Castle Hill Ct Installment $3,686.12 L\\,

Total Amount: $7,372.24

The 2013 Harris Customer Conference is scheduled for October 30th to November 1st, 2013 at the Gaylord Palm in Orlando, M i
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Block RE Payment After: Specify the date after which all Real Estate (RE)
payments will be blocked. This option might be used when you want to enforce
the requirement that payments must be made by the end of a closing fiscal
year.

Modifying the “Block RE payment After” Parameter

The Block RE payment After

parameter (A) can be modified as ™ = | (_Mens Setve |
fO”OWS ] [Web Skin PrEwewJ
1 . C“Ck |n the parameter to num Payment Amnunl| S123.[]O|‘
highlight the date/month/year. s xpeiouraes | ]
ess End Day 11:59 PM Ezl
2. Type_ the DD/MM/YYYY & Pt At p—
reQUlred. + Payment Auto Seleo 4 October, 2016 >0 6
OR o : ;5: 6 r s
1. Click the Calendar (A) button 5 @
to display a calendar; selecta — o511z s 4 s
]
date. =

There are Left and Right Arrows on either side of the month that will allow you
to scroll through the months of the year (1). To scroll through the years, Click
the cursor to display the year ranges. Select your year range; click to select
the month, and finally the date (2).

Note: On the calendar, click the current system date is always highlighted.

Disable Dynamic Search Multiple Selection: Select this option to
disable the multiple selection feature.

Friday Batch Number used for Week Processes

Deactivate Weekend Batch No. For Batch Processes, each Week
day a batch number is generated. This would also apply for weekend days, i.e.
Saturday and Sunday. When selected, this option will not generate a new
batch number for Saturday or Sunday, the batch number for Friday will be
used for both weekend days.

Note: By default, the system will generate a batch number for Saturday and
for Sunday.
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Payment Auto Selection

Disable Payment Auto Selection: During the ePayment process,

ACH Batch Suffix |WB_A-: ‘

Check Image Path| ‘

. 5 (2]
Business End Day 11:58 PM

multiple accounts are by default selected. The Disable Payment Auto
Selection option will change the default behavior; as there will be no auto-
selection of payments, the user will select which payments are desired.

L . —
Default \nstallmant[ Total ] Block RE Payment After 12/31/2017
[0 Disable eSearch Multiple Selection [ Deactivate Weekend Batch No A Disable Payment Auto Selection
[ Disable Overpayment [ Disable Payment Less Than Minimun
e - ~ .,
ACH q [ Credit Card / Debit Card f eCheck | Site SealScript ) Payment Option
| 1l Il |
,—‘ ~
FA Allow ACH

Convenience Fee

Minimum | 51-UO| Maximum | $1 ‘UO| Percentage |D ‘

Automated Clearing House (ACH) is a secure payment transfer system that
provides a centralized clearing facility for Electronic Fund Transfer (EFT)
payments, occurring within the U.S. and Canada. You can use ACH for all
your electronic payments; for example, to validate authorized debits from your
clients’ accounts for recurring payments. Click the ACH tab (1), to set required
parameters.

ACH tab Parameters

Allow ACH: Select this option to enable ACH transactions.

ACH Batch Suffix: Enter a suffix for the deposit number for ACH payments.
This is appended to the Effective Date of the ePayment.
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Check Image Path: Enter the path to the directory where the example ACH
check image is stored.

BT e S e U P L o N s,
BT TAREE

A s B
T
THE GBI O f
DOLER: @ ===
FOHIE T iMAN |J|| Imlllllflﬂu
NCLFTSEAN WU R 1T
Hib
ROO00GPESLG| [V 2ILSEPE™| (DD
i ! TS TR
Bank ID Account Check

Number Number

This is the default image displayed during the ePayment process when the
user enters the Bank ID and Account Number. You can replace this default
with another image. The above is an example of a standard image.

Business End Day: Enter the end of the business day, in hours and
minutes, as it applies to ACH. This parameter is used for calculating interest
and penalty charges. Charges on payments accepted after this time will be
calculated as of the next business day. As an example, if you enter 4:00 P.M.,
depending on the Interest Method selected, interest on payments received at
5:00 P.M. may be calculated as of the next business day. Interest on a
payment received Friday evening is calculated from Monday morning or the
next business day.

Note: When this parameter is set, it will override the value set in the global
business end day parameter. See “Business End Day” on page 213.

Convenience Fee group (ACH tab)

A convenience fee is charged for each credit card transaction made through
the ePayment component, to cover the associated costs, such as, the 2.5%
charged by the credit card company.

Note: The Convenience Fee charge is a fee that is imposed by the city or
municipality. Some external processors, e.g. Nelnet, will charge a
convenience fee, but this charge is administered within Nelnet’s
transactional domain and is outside of the Govern system.

To set up a convenience fee, you will need to set the following parameters.
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[ Disable eSearch Multiple Selection [0 Deactivate Weekend Batch Mo A Disable Payment Auto Selection

[ Disable Overpayment [ Disable Payment Less Than Minimun

Minimum: Specify a minimum convenience fee.
Maximum: Enter a maximum convenience fee.
Percentage: Enter the percentage of the payment to be charged for the
Convenience Fee. A confirmation screen showing the calculated amount

based on this percentage, is displayed to the payer before the transaction is
completed.

Credit Card / Debit Card / eCheck tab

s Ve ™~ ™
Credit Card / Debit Card / eCheck I-' Site Seal Script -”-' Payment Opticn |

[ Amex Vendor Account [ Pay Pal ] [ Manage ]
bz Batch Suffix Credit Card | WE_CC
WA Master Card
A visa Batch Suffix Dedit Card | WB_DC
Batch Suffix eCheck _WB_EC
Business End Day 11:39 PM EZI
fA Allow Credit Card [ Allow Debit Card [ Allow eCheck
r Convenience Fee
Use Secondary Account Fee [ ] [ Manage ]

Minirmum

S5.DO| Maximum| SS.DO‘ Percemtage|0

This tab (A) contains the parameters that are required for configuring credit
cards, debit cards, and eChecks.

Credit Card / Debit Card / eCheck tab Parameters

Govern is able to support a selection of Electronic Fund Transfer (EFT)
providers / interfaces. Currently, the providers / interfaces available are the
following:

*  CryptPay
« HPG

* jCart

* ICVerify

Note: The ICVerify EFT is only valid for Govern for Windows, and should not
be used in the eGov.

* Pay Connexion
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* Moneris
* Nelnet (QuikPAY)
+ Paymentus

* PayPal

+ Point and Pay
+  UNIPAY

* US Moneris

*  Your Pay

Note: To configure your Electronic Fund Transfer (EFT) vendor account, see
the Manage parameter below.

Note: Refer to Appendix E - Electronic Fund Transfer (EFT) section of the
Govern New Administration (GNA) guide for additional details about
supported providers.

Vendor Account: Click on the parameter (A) to display the list of vendor
accounts that are available.

Credit Card / Debit Card / eCheck

~
ite Seal Script Pay on
)
Manage @

O Amex WVendor Account
b Batch Suffix Credit Card | WB_CC
M Master Card
M Visa Batch Suffix Dedit Card |_WB_DC
Batch Suffix eCheck | WE_EC
Business End Day 11:58 PM

M Allow Credit Card [ Allow Debit Card [ Allow eCheck
¢ Convenience Fee

Use Secondary Account Fee [ J [ Manage ]

Minimum SS.UO| Maxw’mum| SS.DO| Percentage|0

Manage: Click Manage (B) to display and manage the selected vendor
accounts in the Vendor Account Management form. Depending on the vendor
that is selected, the Account Management form (B) will display any required
parameters.

Note: To configure your Electronic Fund Transfer (EFT) vendor account, you
will need to contact the vendor and obtain the information that will be
entered in the Vendor Account Management form (C).
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[l s e s e MINIMUmM Fayment Amoun

& Web Site Accounts MR :IDisplay X Previous Payers
r Account - [general] :IBusiness End Day

Processor [ Fay Pal J Block RE Payment After

Account Type [ General Charges J atch No M Disable Payment Auto Selec

Partner |FayPaI | Than Minimun

Vendor |MSGovernMerchant | a ~, / at

\I‘I Site Seal I:l'::_"_'-‘a._—lht.f pticn .I
User |MSGovernMerchant | " 4
(] [ Manage ]

— — |

Port a3 |

Time Qut |30 | :I

e 5 |

11:58 PM Eﬂ
ebit Card [ Allow eCheck

[ New } [ Save ] [ Remove J [ Exit J

T\ Wanage

SS.DO| Maximum |

Electronic Funds Transfer Process

The Electronic Funds Transfer (EFT) process is similar for each of the
providers / interfaces. For example, PayPal offers the Payflow Pro product for
processing Credit Card and Debit Card payments. Payflow Pro is a secure
online gateway for sending billing information to banks. Banks, authorize,
process, and manage payments that come from online requests. These online
requests containing billing information for orders, are transmitted through the
certified, secure connection that is provided by the Payflow Pro payment
gateway.

The Govern system supports PayPal's Payflow Pro and other EFT provider

transactions by providing forms that contain parameters that are supplied to
the user by the EFT provider.

Steps for Setting up an EFT Provider

User requirements for EFT provider transactions are as follows:

1. A credit card account from the city or organizations business bank to be
supplied to the EFT provider.
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2. An account created by the EFT provider.

Note: This account is not to be confused with a standard web account like a
PayPal account that is typically created online.

3. If Governs’ eComponent is to be hosted on the city’s IIS server, a
certificate from VeriSign, DigiCert, or any other Certificate Authority (CA) is
required. If not, the city must be able to ‘sign’ the site for security and
correctly use the HTTPS protocol.

All Govern required configuration parameters should be requested from the

EFT provider when an account is opened.
Govern New Administration (GNA)

Fﬂe"_ Options Parameters Application Configurations Editors Utilities Windows Help

B & B © & & P QL & & B <

Manage Manage OpenWeb Roll Forward Real Personal Motor  AirCraft Beat Business Accounts Mass Ut
‘Web Site Web Skin Config Editor Exclusion Property = Property ~ Vehicle ~ Excise~ Exciser Tax~  Receivable = Appraisal ~ Bill
Web Configuration General Govern Tax CAMA Bil

@ Manage Web Site X

A e o)
[ Web Site Accounts ~ 0 x ‘ Web Site Name IE
 Account - [general] A
Processor e [ Pay Pal ] @. =— i T
Account Type [ General Charges ] =quiT MG Bayis
Partner |FayPaI ‘ |D\sp!ay X Previo
Vendor |MSGovernMErchamt ‘ |Bu5|nass End Da
User |MSGovernMErchamt ‘ J Block RE Paymer
Password | ********** ‘ [ Deactivate Weekend Batch No A Disable Payment,
Port |‘M3 ‘ O bis Payment Less Than Minimun
Time Out [0 | _@—\\\ P
/ Debit Card / eCheck Site Seal Script Payment O
Tender |C ‘ 1" -
iccount L Pay Pal }[ Manage J
ffix Credit Card
( hless ) ( B ) ( Remove I ( Bt b Desit cara
LLLL | 1

The configuration parameters provided by the EFT Provider, e.g. PayPal, are
to be entered in the Account form (C).

When configuring the EFT interface, use the Credit Card/Debit Card/eCheck
tab (B) under the ePayment tab (A) of the Website Manager.

Note: No additional information is required, i.e. file layout information, header
file specifications, etc.
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Specify a Batch Suffix for Credit Card/Debit Card/eCheck

Usually there are multiple transactions that occur on a daily basis. When these
transactions are processed it is often necessary to determine the origin of the
transactions. This suffix is for the deposit number and is appended to the
Effective Date of the ePayment. By specifying a Batch Suffix you are able to
quickly determine, the Electronic Funds Transaction (EFT) transaction, and its
origin. For instance a batch suffix can be used for quick identification of Web
transactions.

Batch Suffix Credit Card / Debit Card / eCheck: Enter a batch suffix for
any of the required parameters, i.e. Credit Card, Debit Card, and / or eCheck.

Note: Not all providers support Debit Cards and eChecks. Verify with your
preferred supplier..

Business End Day: Enter the end of the business day, in hours and
minutes, as it applies to Credit / Debit / eCheck transactions. This parameter is
used for calculating interest and penalty charges. Charges on payments
accepted after this time will be calculated as of the next business day. As an
example, if you enter 4:00 P.M., depending on the Interest Method selected,
interest on payments received at 5:00 P.M. may be calculated as of the next
business day. Interest on a payment received Friday evening is calculated
from Monday morning or the next business day.

Note: When this parameter is set, it will override the value set in the global
business end day parameter. See “Business End Day” on page 213.

Allow Credit Card: Select this option to allow credit card transactions.
Allow Debit Card: Click on this option to allow debit card type transactions.

Allow eCheck: Select this option to allow eCheck type transactions.

Convenience Fee

The convenience fee is used for specifying a supplementary charge for a
transaction. This feature will allow you to specify a threshold amount, and or a
percentage value of the full payment. In addition, if required, you are able to
specify an alternate Automated Clearing House (ACH) account to divert the
convenience fee charges to.
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Convenience Fee group

Use Secondary Account Fee: Use the Use Secondary Account Fee
option to specify a secondary ACH for handling convenience fee charges.

Minimum: Specify a minimum amount to charge for the convenience fee.

Maximum: Enter a maximum amount that will be charged for the
convenience fee when entered this amount will override any percentage
amount that exceeds the entered value.

Percentage: Enter the percentage value that will be applied to the payment
amount for the convenience fee when the minimum value is exceeded.

Note: A value must be entered in this parameter; if the option is not required,
then a value of zero (0) must be enterd in the parameter.

Specifying a Flat Rate for the Convenience Fee

When a Percentage value is not specified, i.e. set to zero (0), and a value is
entered in the Minimum parameter, a flat rate will be charged for the
convenience fee.

To specify a flat rate for the Convenience Fee...

1. Enter the amount that is to be your flat rate in the Minimum parameter.

2. Set the Maximum and the Percentage parameters to zero (0).

Tip: A quick way to ensure that a flat rate is specified is to enter the same
value in the Minimum and Maximum parameters.
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Disabling the Convenience Fee option
LJ isable Uverpayment LJ Lsable Payment Less | han Mimimun
I"/-V ACH V\I Credit Card / Debit Card / eCheck \‘!/' Site Seal Script 7\"‘/-7 Payment Option V\I
\
O Amex Vendor Account [ Pay Pal } [ Manage J
e Batch Suffix Credit Card
KA Master Card
W visa Batch Suffix Dedit Card
Batch Suffix eCheck
Business End Day 11:59 PM EZI
M Allow Credit Card ] Allow Debit Card [ Allow eCheck
( rConvenience Fee iy

Use Secondary Account Fee [

) Gt

Minimum

$5.00‘ Maximum|

$5.00| Percentage|0

AVER2012_5QL1

Complete the following steps to ensure that the convenience fee option has

been disabled.

To disable the Convenience Fee option...

1.

In the Convenience Fee group, click to select the Use Secondary Account

Fee drop-down menu (1) and select the blank option from the drop down

menu.

Default Instal\ment[ Total

J Block RE Payment After

=]
12!31;2017

[0 Disable eSearch Multiple Sef end Batch No A Disable Payment Auto Selection
[ Disable Overpayment CryptPay Less Than Minimun
= _ HPG = _ _
‘-'/ ACH \I Crel |Cart \I'/ Site Seal Script \”-'/ Payment Opticn \I
ICVeri h
O Amex Wi =y . i Pal } [ Manage J
~ Pay Connexion
O Discover
By Moneris | CC
WA Master Card
X I Nelnet oC
M viea Paymentus F
B{ Pay Pal LEC
Point and Pay
Ey 11:59 PM EZI
UNIPAY
M US Moneris Miow Debit Card [ Allow eCheck
- Convenience Fee ——j YOU Pay
Use Secondary Account Fee H Manage
Minimum e’ $5.00) Maximum| 55‘00‘ Percentage’[l—e
L\L JJ

VER2012_5Q1_1

2. Set all parameters to zero (0), i.e. Minimum, Maximum, and Percentage.

3. Click Save.
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[ General \( eProfile \ ePayment [ ePermit \( elnspection | eRemittance \( Others \

. N
[ Live Mode A User Confirmation Required Minimum Payment Amounl| 5123.00|
Cashier ID ‘WB_CH_ ‘Display X Previous Payers | 3|
Receipt Prefic | WB_RP_ |Business End Dey 11:50 PM Eﬂ
Default Instaliment| Total ] Block RE Payment After 12/31/2017 Eﬂ
[0 Disable eSearch Multiple Selection [[J Deactivate Weekend Batch No KA Disable Payment Auto Selection
[ Disable Overpayment [ Disable Payment Less Than Minimun

pay! 1
' .‘\\ _f"- .‘\\ B _/"- .‘\‘
I-' ACH ”-' Credit Card / Debit Card / eCheck \ Site Seal Script I" Payment Option | -

lalt="Wildcard 55L Certificates” border=0 id="ss_img" src="//seal.terminatorssl.com/SiteSeal/images/alpha_noscript_115-35_en.gif" title="55L Certificate”> </a» </

<span id="s5_img_wrapper_115-35_image_en"> <a href="http://www.terminatorssl.com/ssl-certificates/wildcard-ssl. htm!|” target="_blank" title="55L Certificates™> <img
| span > <script type="text/Javascript” src="//seal terminatorssl.com/SiteSeal/alpha_image_115-35_enjs"» </script»

N

The function of the Site Seal under the Site Seal script tab (A), is to inform
visitors that your Web site is secure. In order for a site seal to work, you should
have purchased a secure certificate from a provider like Verisign. A script (B)
that is similar to the following may be provided:

Example:
<I-The Certificator Site[c] Smart Icon tag. Do not edit. -->

<script type="text/javascript" src="https://
sealserver.thecertificator.com/seal.js?style=normal"></script>

<l-end Certificator Smart Icon tag -->

The provided script should then be copied and pasted into the text parameter
under the Site Seal Script tab. This script is included in the page when it is
generated.

Note: Depending on your certificate provider, you will need to contact them
for full configuration instructions.
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Payment Option tab
-'/- ACH -\ -'/- Credit Card / Debit Card / eCheck -\“-'/- Site Seal Script -\I( Payment Option \

| 1l
Force Full Payment B

—
—

’-I Subsystem
Aircraft Excise Tax

Bankruptey

Boat Excise Tax

Business License

Ceed

Delinquency Collection
Land Management

Land Management 2
Misc. Billing

Matar Vehicle Excise Tax
Personal Property Tax
Real Property Tax
SefReportedTa M
Special Assessment
Tax Deferral

Tax Title

[ Ol 00 Od Ol Ol O

Tax Title (LM)
Tax Title (PP}
Utility Billing

D] O] O]

2.50QL1

Use the Payment Option tab (A) to enforce which subsystems (B) require that
a full payment be made when users are using the Web.

Custom Error Messages

In the event of errors occuring during transactions or processing, a custom
default error page is displayed by default. This setting is located in the
Web.config file.

| 8 mtp/ Mocathost/(Soaighyadsibeghessiliptrnl))/C ommonPages/ErrarPage a3y pxTaspenompath =/ WebP rofile \WEB_WP_Frame.aspx P-ex|@m

ire Browser WabEx v

Sorry, an unexpected error occurred during the process of your request

* - The database connection have an invalid serial number

* Could not load eProfile login page.

Continue browsing

View the setting of this parameter...

1. With a text editor, locate and open the web.config file.

Page 226 © 2015 Harris Govern



=\
7.2 HARRIS

AN

GOVERN ePayment - Setting the Web
Parameters
2. Locate the customErrors parameter; ensure that the switch is set to “On”.
<customErrors mode="On" defaultRedirect="~/CommonPages/ErrorPage.aspx"/>
To have error messages display ASP.NET exception stack traces, set the
parameter to “Off”.
3. Locate the customErrors parameter; change the switch to “Off”
<customErrors mode="Off" defaultRedirect="~/CommonPages/ErrorPage.aspx"/>

Note: Set customErrors mode="On" or " " to enable custom error
messages, "Off" to disable.
Add <error> tags for each of the errors you want to handle.
"On" Always display custom (friendly) messages.
"Off" Always display detailed ASP.NET error information.
"RemoteOnly" Display custom (friendly) messages only to users not
running on the local Web server. This setting is recommended for
security purposes, so that you do not display application detail
information to remote clients.

Web Site Manager - elnspection tab

Select the elnspection tab to configure options for the Mobile inspection
module.
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Web Site Manager - elnspection tab Parameters

Allow Change Department: Select this option (1) to allow inspectors to be
able to work outside of their department. When this option is not selected,
inspectors can only work within their assigned departments.

Web Site

.lz‘lE‘ 1 Of 2\

Web Site 1d |1

| Web Site Name |Ms Govern

‘[ Menu Setup T

WebSkin | MSGOVERN

] [Web Skin Preview]

™ ™~ 7 ~ Y ) .Y
\l eProfile \l ePayment \l ePermit \ elnspection [ eRemitancz |/ Others |

General
KA Allow Change Department ’

-,
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Web Site Manager - Report Tab

The parameters under the Report tab (A) are used to specify Crystal Reports
that are used by the eGovern — Public Self Service Portal.

Web Siteld 1 Web Site Name Ms Govern

Web Skin San Innocenti

Crystal Reports
Database Na

Server Name |,
User Id

Password

Web Site Manager - Report tab Parameters

Crystal Reports group (Settings for SQL Databases)

Database Name: Specify the name of the Web Information database.
Server Name: Enter the name of the Web Information Database.
User ID: Enter the user ID that is used to access the database.

Password: This parameter should contain the password that is used to
access the database.

Crystal Reports group (Settings for Oracle Databases)
Database Name: Leave this field empty.

Server Name: Enter the name of the Oracle Database instance.

© 2015 Harris Govern Page 229



=N\
7.2 HARRIS
eGovern - Public Self N GOVERN

Service Portal

User ID: Enter the user ID that is used to access the database.

Password: This parameter should contain the password that is used to
access the database.
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eRemittance

The Self-Reported Tax subsystem is designed to enable organizations to
report the sales tax from local businesses that are classified as self reported
tax. In keeping in line with this aforementioned Govern functionality, the
eRemittance form offers user the convenience of making Self-Reported Tax
(SRT) submissions online.

When accessing the eRemittance, users will note that it is launched without a
search screen. This is because only the accounts linked to the eProfile are
listed.

Note: The Self-Reported Tax forms that are created in Govern for Windows
are not compatible with the eComponent Web pages, therefore those
forms must be reproduced using the Self Reported Tax editor.

Home My Profile Online Services My Profile Setup Administration {eGov) Link Sign Qut Help?
Version: 5.1.1307.4

ERemittance

Account Number: 00001330

,

SALES/USE TAX RETURN

JULTA GOVERN
1600 MAIN St W Suite 620

Account Number 00001330 Business Name ST-LOUTS MO 62007 b
Reporting Period Monthly Date 8/22/2013
Period Covered * 2 [=] Due Date 2/1/2013
Zero Filer [
1) Gros Sales and Service |0.00 5) City Sale Tax

2A) Bad Debts Collected |0.00 6) Excess Tax Collected  |0.00

2B) Total Line 1 && 2A 7) Adjusted City Tax

3A) Non-Taxable Service |0.00 8) Vendor's Fee Deduction)| Apply Discount B

3B) Sales to Other 9) Total Sales Tax

3C) Sales Shipped Out  [0.00 10) City Use Tax
3D) Bad Debts Charged

Room Rental

0 11) Lodger's Tax

3E) Trade-Ins ! 12) Total Tax Due

3F) Gasoline &&
Cigarettes 0! 13A) Late Filing (Pen)

3G) Sale to Gov/Rel/Cha [0.00 13B) Late Filing (Int)

T
T
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Creating an eRemittance form

eRemittance forms are created with the Self Reported Tax editor in Govern
New Administrator (GNA). See Self Reported Tax Editor on page 236 for
details.

Filing an eRemittance Report

Hello Dr M5 GOVERN IR

Test Report  Sign Out

M Property Based Information
Name Based Information
Payment 3

Submit ’ Welcome!
Self-Reported Tax 4 rrdntly contains the following references:

eFiling {(No Report)

Properties SRT Information 2
S = °
&2 MSG .
o2 MSGovern
Management Solutions for Covemment
mscommomz___ wne G e
Main Online Services  Your Profile  Administration Links  Test Report  Sign Out Help?

|| version: 5.0.9.15

' ERemittance

Select your Account

7~ -
Account Year
Sele 00001371 2011
Sele§ ) 00001373 2011
Select 00001387 2011

Depending on your menu structure, and how your eRemittance filer page is
launched, after selecting the account, you can select the period to be filed.
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Period Number Displayed with Date

On the eRemittance form, now the Date, Due Date (B), and the corresponding
Period (A) covered are displayed in the form. Previously, only the Date and

Due Date were displayed.

Main Online Services  Your Profile Administration Links  Test Report  Sign Out Help?

ERemittance

Account Number: 00001371

SALES/USE TAX RETURN |

Dr MS GOVERN IR
95 CASTLE HILL Ct

Account Number 00001371 Business Name SOUTHAMPTON NY 11968-
5524
Date 1/14/2013 o
Period Covered* Due Date 7/1/2011

Parking Space *

Parking Price

Parking Revenu 1

1. Click Select to select the account and display the eRemittance form.

2. In the eRemittance form, complete the required parameters; click
Continue.

3. If a calculation is required for the form it will be performed.
Note: For the example used here a calculation is performed and prior to

submission, a mandatory declaration under penalty of perjury must be
selected

4. Atfter accepting the mandatory declaration, the Process button becomes
active; click Process to submit the form.

eRemittance Workflow - Payment option

The eRemittance workflow gives users, after the submission phase, the option
to settle any amounts owing. Option are to pay immediately, i.e. Pay Now, or
pay at a later period, i.e Pay Later.
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After a submission, a summary screen is displayed. The payment option
buttons are displayed.

Total Amount

Total Amount Without Charges
Under/Over Payment $2,570.88
Total Penalty

Total Discount

Total Interest

Total to Pay

m

( [ Pay Laler I Pay Now )
@ i'an.. Y & R |- [o0% |-

FERIOD 1 DATE g5/01/2011 ACCOUNTpp001371 2011 SALES/USE TAX RETURN
COVERED DUE HUMEER CITY OF DURANGO
TAXPAYER'S NAME AND ADDRESS 949 EAST SECOND AVENUE DURANGO,CO 81301-5109
(970) 375-5033 FAX: (370) 375-5038 wwawdurangogav.org
BUSINESS Dr MS GOVERN JR
HABRESS 55 CASTLE HILL Ct COMPUTATION OF TAX

CITY, ST, ZIF  SOUTHAMPTON, NY 11568-5524 AMOUNT OF CITY SALES Tax -~ RATE S 3% OF

Si5s rax couseTen

5
6
1 GROSS SALES AND SERVICE
7 ADJUSTED CITY TAX (40D Lir=s § and &)
24 TOTAL OF DEDUCTION LINE DEDUCT 3 1/3% OF LINE 7
ADD 8AD DEETS COLLECTED B [Venders Fee showed f paid by Gus date)
28 TOTALLNES 1824 e s

mw TAAELE
D|*

TOTAL S4LES TAX {Line 7 Minus Line 8)

10 CITY USETAX

® SAE TO QTHER.

11 LODGER'S TaX

12 TOTAL TAX DUE {Add Lives &, 10 and 11)

EE) BAD DEB’FSCH-\RG =)

E LICE! EAERS
D |* sn._ssw-r-sn auT
u

174 LATE FIING FEES  mmnmy  mum. s e inin

If not required, this option can be disabled by an administrator through the
Govern New Administration (GNA) release 5.1.

To enable or disable the Pay Now or Pay Later option in the eRemittance
workflow in the GNA...

1. Select Application Configurations > Web Configuration... > Manage Web
Sites...

GIS Configuration
Self Reported Tax Editor

Manage Web Skin... *
Open Web Config Editor
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2. In the Web Sites form, click to select the Self Reported Tax (A) tab

3. Click to select Show Pay Later to enable the option; deselect the option to
disable it.

[ website Emﬂ 10f1 )

Web Site1d 1 Web Site Name Ms Govern - B

Veb S MSGOVERN - B Y leb.Skin Preview]
¢ Repe

A
al eProfile ePayment f ser Reported Tax \ elnspection

iled Generated Periods

iCart eRemittance Interface

The eGovern - Public Self Service Portal is able to send users to iCart, where
they can perform an inquiry through the CMS Interface.

The following are the required parameters:

* Field
* Data
* Description
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Self Reported Tax Editor

The Business Tax form is used to design the layout of SRT entry forms in the
SRT OpenForm. To assist in the design process, after each field has been
positioned, a preview of the layout can be seen under the Preview tab..

5n (GNA) Vear —lalx]

nParameters | Application Configurations | Editors  Utiities  Windows  Help  Year

R P& B O & @ Paa@ € B @

Gls Manage Manage OpenWeb  Roll Forward Real  Personal Motor AirCraft Boat |Business | Accounts Mass Utility
iization Tool |~ Web Site Web Skin Config Editor ~ Exclusion  Property = Property * Vehicle  Excise v Excise+| Tax= |Receivable = | Appraisal + | Billing ~
Web Configuration General Govern Tax @ | Copy To Vear AMA | Utility Billing

l% Department Maintenance I ) General Parameters ] J Categories (2015) l @ Categories Form Setup (2015) X ] General Parameters
-Cai

(Q Ca(egnnes Form Setup %)
Category:

] [ Categories Form Setup h

Note: The preview is an approximation of the layout and not a true What You
See Is What You Get (WYSIWYG) representation of the designed
layout.

To display the Business Tax Editor...

Govern Mew Administration {GMA) Year - ol x|
BEEE opicn  SywemPasmewen  Application Confguratios  Fdton.  Unitier  Windows  Help  Year

ﬂ&&,@@ﬂ'@@mﬂgﬁ@ﬁﬁﬁeﬁ@

Gis Gis GIs nage Manage OpenWeb  Roll Formand Feal  Personal Mot ArCraft  Boat  Business  Accounts
Parameters Teohip Symechronization Tool Weh e Web i Confgfdor | Ewchuom | Property - Propery- Ve - Bxciie- Bwine-  Tax-  Recenbie - .-apun- !IIAg

GIs Canfiguration Web Carfiguration General Goverm Ta CAMA_ Lnilzy Biling

Geraral Parametars | i Department Mastesance | & General Pacaeneters | 1 Categores (2015) | & Categaries Foem Satug (2015] %

Year Deparimant Categery: |
[ 0] [[Sotes Tax Beparenamn. Govern New Administration (GNA) Year

Dptions System Parameters Application Configurations Editors. Utilities Windows Help Year

Setun LA

ﬁ— 3
B ) = W @& B & & & B«

ADCONACE GIS G GIS Manage Manage OpenWeb Roll Forward Real Personal  Motor  AirCraf
PR orms Setting Parameters Tooltip Synchronization Tool |~ Web Site Web Skin Config Editor Exclusion Property = Property ~ Vehicle = Excise
s Row 32| conn GIS Configuration Web Configuration General Govern T
:xg:«: 8 show kel ontop o the | [ 3 A/R General Parameters | @ Department Maintenance | @ Genersl Parameters | @ Categaries (2015) | @ Categories Form Set
ADCONACT 2o Labed e This Frtd r Self Reported Tax

Add Bad Dekts B s Hidden

Jutek Exewit Tan Csllmctad TobEequence: | 83 Year: Department: Category:

Adjusted City Tax

e 2014] (" Seles Tex Department ] ([ selestUse Tax

Aumeunt of City Sakes Tax

Assessment Fee
£ Sales o Other Lic. Dirs Setup Preview b

But Address Corel Acet

Business Phone
. Sales Shipped Out of Oty Gross Sales and Services

Initial Use Return :l Grocery Amt. Sub. t
Total Gross Sales & Serv. $0.00| Grocery Tax

A Non-Taxable Service Sales $0.00] Addl: Excess Tax Col

Add: Bad Debts

V6.0.1503.504 - BTL60_CTVTSE1, 504

B. Sales to Other Lic. Dirs. $0.00| Adjusted City Tax

C. Sales Shipped Out of City $0.00| Current GEQ Code |:| Retailers Fee

E. Trade-Ins for Txbl. Resal

w (| e wr | e
=3 = = =
=1 =} 1= 1=}
=] =] =] =]

Page 236 © 2015 Harris Govern



=\
7.2 HARRIS
Ao GOVERN

Self Reported Tax Editor

-lo| x|

&

Utility
Billing =
Utility Billing

r AirCraft Boat  Business | Accounts Mass
=2~ Exciser Excise~| Taxr |Receivable~ | Appraisal ~

@ Copy To Year AMA
Farm Setup (2015) X (@l General Parameters
@ Categories

w Categories Form Set%u

» Categories
» Categories Form Setup
Periods

Govern Tax

Select the General Parameters form.

Note the Next Account Number field.

o b~ »

entered in the Increment parameter.

1.In the GNA ribbon, select the
Application Configurations tab.

2.In the Govern Tax group, click
the Business Tax icon to display
the available forms.

Options include:

*Copy to Year
*General Parameters

If an increment value is required for each new account number, it can be

6. Click the Check Link to Permits and / or the Check Change Date

options.

7. Click the Save icon or use the Ctrl + S keyboard combination, to save your

settings.

Business Tax Editor Command Buttons

Save: Click Save to save any changes made to the form.

@ A/R General Parameters ]fas Department Maintenance ] @ General Parameters x[ 9 Categories (2015) ] 9 Categaries Form Setup (2015)

Z
e
SRT General | Parame ters q 5 B

Save (Keyboard shortcut: Ctri+S)
MNext Account Number 8 P

A Check Link to Permits (Create Missing Filing Process)

WA Check Chanae Date (Create Missina Filina Process)

Business Tax Editor Parameters

OpenForms Settings group

The following parameters are used to control the positioning of the parameters
that are filled out on an ST Business Tax form.

© 2015 Harris Govern
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Row / Column: The Row and Column parameters are used to specify the
horizontal / vertical positions of the field.

WARNING: Always assign a Row and Column position value otherwise the
values in these fields will not be computed. This can lead to
errors in calculated values. This rule is regardless of whether the
field is hidden or not.

Column Span: Column Span allows you to specify the number of columns
that the field will spread over.

Show label on top of the control: When this option is selected, the text
label of the field will be presented on top of the field.

No label for this field: Select this option to display the field without any text
label.

Govern New Administration (GNA) Year -

Options  System Parameters  Application Configurations |~ Editors  Utilities  Windows ~ Help  Year

i & P&TBE € & PR S B D

GIs GIS GIS Manage Manage OpenWeb Roll Forward Real Personal  Motor AirCraft Boat Business  Accounts Mass Utility
Parameters Tooltip Synchronization Tool |~ Web Site Web Skin Config Editor |~ Exclusion Property = Property ~ Vehicle = Excise Excise~ Tax~+ Receivable ~  Appraisal = | Billing =
GIS Configuration Web Configuration General Govern Tax CAMA Utility Billing

[ @ A/R General Parameters ]% Department Maintenance ] @ General Parameters [ @ Categories (2015) ] @ Categories Form Setup (2015) x|
 Self Reported Tax

Year: Department: Category:
2014] (" Sales Tax Department ] [ Lodging Tax )
Setup Preview \
I—M \
Current GEO Code B
Gross Sales and Services $0.00 Amt, of City Lodging Tax $0.00 I:l
Label on top
Geo Code 2
No Label at all
Total Gross Sales & Serv. Total Lodging Tax Geo Code 3
| 1 |
$0.00, £0.00
N
Label beside Estimated Return
IS
Total Late Filing
E. Sales to Other Lic. Dlrs, $0.00 -
$0.00
C. Sales Shipped Out of City

Is Hidden: Select the Is Hidden option to hide the row; see Adding Blank
Spaces and Columns in a Layout on page 242.

Tab Sequence: Enter a tab sequence number to control the order that the
fields are cycled through when the user presses the Tab key. See Changing a
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Form Tab Sequence on page 243.

Note: The default for the appearance of labels is on the left hand side of the
parameter.

Web Site Settings group

Users of the eComponents that provide Self Reporting Tax, (i.e. eRemittance),
reporting functionality to their clients can also control the presentation of these
forms. These parameters will help to specify how the forms will appear
through a web browser. Refer to the eRemittance section of the Govern
eGovern - Public Self Service Portal release 6.0 user guide for additional
details.

Row / Column: The Row and Column parameters are used to specify the
horizontal / vertical positions of the field.

WARNING: Always assign a Row and Column position value otherwise the
values in these fields will not be computed. This can lead to
errors in calculated values. This rule is regardless of whether the
field is hidden or not.

© 2015 Harris Govern

Page 239



eGovern — Public Self

\= GOVERN

Service Portal

Column Span: Column Span allows you to specify the number of columns
that the field will spread over.

o 8O o

{ Fiing information )

General Information

3) Total of Deduction

4) Total Net Taxable

! s
Column Span = 2; this
column width is
determined by widest
object in columns.

Note: Column widths when specifying spans values are determined by the
width of the largest object in each of the columns.

Show label on top of the control: When this option is selected, the text
label of the field will be presented on top of the field.

No label for this field: Select this option to display the field without any text
label.

Required control on the web site page: There are instances when a
field may be required to be completed prior to proceeding to the next page or
section. This could be a Completed By field that acts as a signature, or a
mandatory date.

Customizing Address fields with the SRT Editor

For an SRT report, part of the report will require the entry of the users address.
An address can usually require a Street address, a secondary Apartment or
Suite number and possibly a third field. Additional fields would be needed for
the City, State, and Zip Code. These fields can be lined up in the same

Page 240
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column, The street address parameter will have the label displayed on top of
the field and the secondary apartment number or suite parameter can be
displayed without a label. The Layout would look approximately like the
following, note that the address fields span over 2 columns:

Note: To reproduce the following example, you will need to have created an
SRT category with the required address fields.

To have your fields reproduce the above...

Self Reported Tax Definition(CMSDEMOZ_IXMTLN1_SQL)

Self Reported Tax —l

Year: Department: Category:
(= DDuBER)

Preview
Self Reported Tax Definition List
ADDRESS1 ] [ seift Reported Tax Definition 250f71 \

ADD

ADD OpenForms Settinas Web Site Settings
any
STATE Row: 1 Column: 1 ColumnSpan: 2 Row: 0 Column: 0 ColumnSpan: 1

B Show label on tap of the control B Show label an top of the control

B No Label For This Field B No label for this field

B Is Hidden B Required control on the web site page
Tab Sequence: 0 B s Hidden

Tab Sequence: 0

1. Inthe GNA select Setup > OpenForms Configuration > Business Tax Edi-
tor.

2. In the editor, enter the year and select the Department and Category that
contains the field that will be in the SRT form.

3. Click and select ADDRESS1 under the Business Tax Definition List
column.
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4. For ADDRESS1 enter 1 and 1 in the Row and Column parameters; the
column Column Span should be set to 2 (columns).

5. Configure ADDRESS?2 as 2 and 1 for the Row and Column parameters,
but select the No label for this field option; again set the Column Span
to 2.

6. Repeat the last step for ADDRESS3, noting that the Row and Column
values are 3 and 1; be sure to select the No label for this field option.

You can click the Preview tab to preview the layout.

Repeat the previous steps for the City and State fields, remembering to
increment the numbers entered for the Row.

This Business Tax (SRT) editor should be used by all administrators that
prepare SRT forms required for filing periodic reports.

Adding Blank Spaces and Columns in a Layout

The Business Tax Editor allows the insertion of blank lines and columns as a
means of creating visual breaks to enhance a form layout.

Govern New Administration (GNA) Year - o] x

Options  System Parameters | Application Configurations | Editors  Utilities  Windows  Help  Year

i, ® P& T © & @ 0@ S B @

GIS GIs GIS Manage Manage Open Web Roll Forward Real Personal Motor AirCraft Boat Business Accounts Mass Utility
Parameters Tooltip Synchronization Tool ~ Web Site Web Skin  Config Editor Exclusion Property ~ Property ~ Vehicle~ Excise~ Excise® Tax= Receivable~ | Appraisal ~ Billing =

GIS Configuration Web Configuration General Govern Tax CAMA  Utility Billing

[@ A/R General Parameters |G Department Maintenance | @ General Parameters | @ Categories (2015) | @ Categories Form Setup (2013) x|

rSelf Reported Tax

Vear: Department: Category:

2014] [ Sales Tex Department ] [ sales/use Tax )
Setup BH > ¥ ﬁ[:}" \‘-/ Preview '\.‘

Self Reperted Tax Definition List ~

N ST ] r Seif Reperted Tax Definition & it gofos \

ADCONAC2 )
¢ OpenForms Settings L] Web Site Settings

ADCONAC3

ADCONACA Rows: 4| Column: 3| Column Span: 0 Row: 4 Column: 4| Column Span: 4]

RUCONG [ Show label on tap of the control [ Show label on tap of the control

ADCONACE . ]

ADCONACT r This Field [0 No label for this field

o

Add: Bad Debts ( A Is Hidden , jred control on the web site page
Add: Excess Tax Collected r )
- - Tab Sequence: | 17 & Is Hidden
Adjusted City Tax
ETeguence | 22

Adjustments for Prior Per
Amecunt of City Sales Tax
Assessment Fee

B. Sales to Cther Lic, Dirs.
Bus. Address Consol. Acct

Bertmmee Pl

To create a a blank line...

1. Open the Business Tax editor.
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In the OpenfForms Settings group, specify a new row or column.

Click to select the Is Hidden option.

Click Copy all OF settings to Web (1),

to ensure that the sequence is

repeated in the eComponent Web form.

TIP: When modifying the layout, use the Preview tab to verify your layout.

Changing a Form Tab Seque

nce

Using the tab key the user is able to sequentially jump from field to field,
depending upon the sequence that was set by the form designer.

‘Govern New Administration (GNA) Year _|lo] x
Options. System Parameters Application Configurations Editors Utilities Windows Help Year
GIS Manage Manage Open Web Roll Forward Real Personal Motor AirCraft Boat Business Accounts Utility
Parameters Tooltip Synchronization Tool = Web Site Web Skin Config Editor Exclusion Property * Property ~ Vehicle + Excise> Excise* Tax~* Receivable ~ Appra\sa\ Billing =
GIS Configuration Web Configuration General Govern Tax CAMA  Utility Billing

[ @ A/R General Parameters [ @ Department Maintenance | @ General Parameters | @ Categories (2015) | @ Categories Form Setup (2013) x|
~Self Reported Tax

Year: Department: Category:

2014] [ Sales Tex Department ] [ sales/use Tax )
= 2y .
Setup > v |m| @ ‘.-/ [F—— \_‘
‘

Self Reperted Tax Definition List -~

A Non-Taxable Service Sales E r Self Reported Tax Definition B (flr| 90fos ‘\

ADCONAC2 ) ) . A

 OpenForms Settings 5 | [Web Site Settings

ADCONAC3

ADCONACA Row: 4| Column: 3| ColumnSpan: | © Row: 4 Column: 4| ColumnSpan: 0

ADCONACS [0 Show label on tap of the control [0 Show label on tap of the control

ADCONACE 0 . 0 .

ADCONACT No Label For This Field No label for this field

Add: Bad Debts f [ Required contral on the web site page

Add: Excess Tax Collected

L Tab Seqence

Adjusted City Tax

Adjustments for Prior Per Tab Sequence: 22

Amount of City Sales Tax

Assessment Fee

B. Sales to Other Lic. Dirs.

To change the tab sequence of a field...

1.
2.

In GNA open the Business Tax editor.

Tab Sequence: field.

In the OpenForms Settings group, enter the new sequence number in the

© 2015 Harris Govern
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3. Click Copy all OF settings to Web, to ensure that the sequence is
repeated in the eComponent Web form.

TIP: When changing the tab order, review the previously existing tab order.
When completed, use the preview
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Overview

To process Web ePayments, complete the following steps:
1. Post the Web ePayments to A/R, for credit card and ACH payments.

2. Generate an ACH file for the bank, in Govern Batch Processing, for ACH
payments only.

Posting Web ePayments to A/R

To transfer your payment records from cash collection to the payment
summary in A/R, run the Cash Collection (Payments) Posting process.

Note: Once records are posted, they cannot be modified or deleted.

To access this process, from Govern’s main screen, select Tools > Batch
Processing (Govbat32.exe)

OR

Click @ then select Account Receivable > Cash Collection Posting... (A)

# Govern Batch Processing GOVERN DEMO

File | Accounts Recsivable Mass Appraisal  Special Assessment  Miscelane: - - = .

S0C  Load Lackiox Entries. . 1 Cash Collection (Payments) Posting 7 x|
Load Gav One Payments... A _
Cash Collection Posting... r Criteris Selection
Past Dated Payment Posting. Department
AR adjustments Posting. .. N
in s e U ITreasurerJ‘CDIIedor's Office vl
AfR Deposit Posting. ..

Refunds Posting. ..

> - Depost Mumber Cashier Id.
o e Al g | [12345 - p2a3 91 [4545a500
&1~ §13,411.72
&2 ~ 521 14071 Cperstor Id.
emar20100723 ~ $2,819.05 [6as634
gowe = $63.00 Crate From Diate To
|71/2009 |6z12010

Effective Date From  Effective Date To

GIL Reference GiL Cash Account Owerride

IB454B423 IEIQ‘I 5466

Start e Ezit

Complete the following parameters and click Start (B) to launch the process.
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Department: Select the department where the Web payments are saved.

Deposit Number: Select the deposit number or numbers for the process.
This deposit number is comprised of the effective date the payment is
processed, followed by the suffix, entered on the ePayments tab form in
Govern NetAdmin (GNA). See Specify a Batch Suffix for Credit Card/Debit
Card/eCheck on page 85.

Cashier ID: Enter the Cashier ID for the payment. This is comprised of the
effective date the payment is processed preceded by the prefix entered on the
Web EPayments Parameters form in Govern Admin.

Date From / Date To: Enter the range of dates to use when selecting the
payments to post.

Note: If this field is left blank, all non-posted payments will be processed.

Effective Date From / Effective Date To: Enter the dates in which the
payments will be effective From and To.

G/L Reference: Enter the G/L reference to be stored in the G/L accounting
file.

G/L Cash Account Override: Enter the G/L Cash Account number for the
override.

Note: You can leave all fields on this form blank in order to post all payments.

Refer to the Batch Processing chapter of the Accounts / Receivable guide for
details.

Generating an ACH File

Run the ACH Web Payment Extraction process to generate an ACH file
containing your posted ACH payments, for the bank. You can also re-extract a
previously-generated file.

To access this process, from Govern’s main screen, select Tools > Batch
Processing (Govbat32.exe)

OR
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Click @ then select Account Receivable > Generate ACH Web Payment

File... (A)

& Govern Batch Processing GOYERN DEMO

Fle | Accounts Receivable Mass Appraisal  Special Assessment  Miscellaneous Bill
po( Load LockBox Entries... ﬂ
——  Load Gov One Payments. ..

Cash Collection Posting... b
Post Dated Payment Posting. ..
AR Adjustments Posting. ..

PRy I S S S 2

BarCi e, i,

Ty . ACH WEB Payment Extraction
Batch Deletion of AR Transactions...

Extract an As of Date AfR Detail Table... Output File Name

Creation of a Refund (/P Export File... Izm 00729_A tt

A Load Account Reconciliation File of Refunds. ..
EXS

c

S covern
& CuickGoy

Resulting File Mame

(S overmianickGov 2010072948

' New File
¥ | Exclude Payment not Pasted
Payment From Date  To Date
Jsnzo1a [pra0r2010]

Leave Blank for all payment

(" Re-Extract Existing File
ACH File 1D ACH Extraction Date

Complete the following parameters and click Start (B) to launch the process.
A file containing the ePayments that have been posted but not previously
extracted is generated. An ACH File ID is automatically assigned when you
open the process. This is preceded by the current date.

The ACH File ID is an alphabetic character. A is assigned to the first extraction
file generated for the day, B to the second and so on to Z; then, a numeric
character is assigned: 0 to 9. A total of 36 files can be generated per day.

Output File Name: Enter a name for the generated file. By default, the file
name is the current date followed by the ACH File ID.

Drive Path: Select the drive and directories where the file is to be saved.

Resulting File Name: The full path and file name of the output file are

displayed in this field.

New File: Select this option to generate an original file.

© 2013 MS Govern
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Exclude Payments Not Posted: This option is always selected, since the
process extracts posted payments only. The option is displayed for
informational purposes only.

Payment From / To Dates: Double-click in the date fields and select dates
from the pop-up calendar to refine the file extraction. You can leave one field

blank to include only the payments from or up to a specific date or leave both
fields blank to include all payments.

Re-extract Existing File: Select this option to generate a copy of a
previously-extracted ACH file.

ACH File ID: Enter the ACH File ID assigned to the original file. This
parameter is defined above.

ACH Extraction Date: Enter the ACH Extraction Date assigned to the
original file. The ACH Extraction Date refers the date that was current at the
time the file was extracted.

When the process is complete, the ACH file will be generated at the location
that was specified.
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“Sys is undefined” Error Page

Symptom: When trying to access the Website page, a Sys is undefined
error page is displayed.

Solution: One possible solution for the Sys is not defined error page is to set
the AppPool Managed Pipeline mode to Classic.

Open the IIS Manager

In Windows...

1. Click to select Start > Control Panel.
In the Control Panel, select Administrative Tools.

In the Administrative Tools start the 1IS manager by selecting Internet
Information Services (IIS) Manager.

4. In the Internet Information Services (lIS) Manager, locate the Application
Pools (A).

5. Double-click on the application pool (B) to display the Edit Application Pool
form.

6. Under the Managed pipeline mode parameter, select the Classic option
from the drop down menu (C).

& Internet Information Services (I[S) Manager l [ .i: =
@ v ‘;’ » IKMTLNL » Application Pools ‘ @ )-:I\ w_@|v

File  ‘iew  Help

Connections Actions

- QQ' Application Pools

‘; Add Application Pool...

4 ..kij TXMTLML (HARRIS oolaniyan)

Set Application Pool Defaults...

e This page lets you wiew anpeasnaca tha lick of 2ne icn ool oethin con .
i<l Application Pools Application pools are assq Edit App\icatinn_ Application Pool Tasks
(8] Sites applications, and provide [ ———————————————
I Filter: _ B Stop
| MEGovern — )
Name der & Recycle.
(5 ASP.NET w0 MET Framework wersion: e Edit Application Pool
| QASD,NETV4,U Classic [.NET Framewark w4.0,30319 - o D Basic Settings..
2 Recycling...
I — AERNET Al Dz, Mdanaged pipeline mode: c R scyeing X
L2¥ Classic MET AppPool - e Advanced Settings...
L) Defaultipy fregrate T e Rename
D oGov Integrated I,
2 e r || X Rermove
t=_?I\«1SGO\1'em e —_—
Wiewr Applications
[ ok [ conar | @ Help
| Online Help
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7. Click OK.
8. Right click on the Application Pool and select Recycle.

Error running Reports on eGovern — Public Self
Service Portal Web sites under 64-bit Windows

Symptom: The. DLL’s for eGovern — Public Self Service Portal that are used
by the reports are written in 32 bit. When the eGovern — Public Self Service
Portal is installed on a 64-bit platform, although the Web site will run, the
reports will not function.

Solution: It is necessary to enable the 32-Bit Applications flag for the
Application Pool in IIS.

In Windows...

1. Click to select Start > Control Panel.
In the Control Panel, select Administrative Tools.

In the Administrative Tools start the IIS manager by selecting Internet
Information Services (lIS) Manager.

4. In the Internet Information Services (IIS) Manager, locate the Application
Pools.

5. Double-click on the application pool to display existing Application Pools.
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6. Right-click on the Application Pool for the eGov Web site and select
Advanced Settings from the menu (B).

7.

flag (1) and click to set it to True (2).

Advanced Settings

(2] = |

El (General)

MET Frameuwvark Version
Enable 3 & cati
fanaged Pipeline Mode

MNarme
Queue Length
Start Automatically
= CPU
Lirnit
Lirnit Action
Lirnit Interval {minutes)
Processor Affinity Enabled
Processor Affinity hask
= Process Model
Identity
Idle Tirme-out {minutes)
Load User Profile
Mazimurm Worker Processes
Ping Enabled

Enable 32-Bit Applications

w2l

True

False ! L

T

True

0

Modction
5

False
4294967295

ApplicationPoolldentity
20

False

1

True

Ping Maxirmurn Response Tirme (seconds) 490

[enable32BitAppOniing 4] If set to true for an application pool on a 64-bit aperating system, the
wotker processies) serving the application poolwill be in WOW64 Mvindows on Wind cws64)
mode, Processes in WOMEA mode are 32-hit processes that load only 32-hit applications,

[ ok

J |

Cancel

8. Click OK to accept the change.

P~
@ &) [+ DMTLNL » Application Paols & @ -
File  Wiew Help
Connections Lo Actions
re qsl Application Pools =
Ll ? & Add Application Pacl..
'

«5 JiMTLN“HARm\W"’"‘Y“”) This page lets you view and manage the list of application paols on the server, Application poals SetApplication| Aol
o) Application Pools are associated with worker processes, contain one or more applications, and provide isolation Application Pool Tasks
>8] Sites amang different applications. »

Filter: Go - [ Show All | Group by No Grouping - B siop
Marne ’ Status MET Framework... Managed Pipeli., Identity & Recycle..
(AP INET v Started w0 Integrated Application Edit Application Poal
LS ASPNET w40 Classic Started w0 Chassic application | | [£] Basic Settings..
P ASPNET w40 DefaultippPasl Started v Integrated Application Recycling..
(2 Classic NET AppPasl Started a0 Chssic Application Advanced Settings..
\F DefaultdppPasl Started  vii Integrated Application Rename
= o
;,,E;EGW dd Application Pool.. cqrated Application || ge o
Y6 tad Applicati T
(AR Set Application Pool Defaults... earate pplicatian View Applications
Start @ Help
B Swop Onling Help
2 Recycle..
[F]  Basic Settings...
Recycling..
Advanced Settings.. N
Rename
K Remove
Wiew Applications
o @ Hep 5

9. Right click on the Application Pool and select Recycle.

In the Advanced Settings form, locate the Enable 32-Bit Applications
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Crystal Report Not Working

Symptom: Reports are not appearing or generating after search is
requested.

Solution: When the Crystal Reports that are used for displaying search
results as reports generate an error message, one possible solution is to
perform a required preinstallation step. Refer to the Step 3 - Installation of
Crystal Report Runtime on page 8 for details of actions to take.

License Not Valid Error when opening
eProfile.error saved in Event Log

Symptom: After installing eGov and attempting to access the eProfile
system, an error is thrown. The following errors can be seen in the error log
file.

——————— Exception Log Entry -------

General information

Additional information:

ExceptionManager.MachineName: WEBSERVER

ExceptionManager.Site Identification Key:

ExceptionManager.Database Connection Key: GOVERN_PROD_CH-FIN-UB_SQL
ExceptionManager.Timestamp: 11/22/2011 11:13:14 AM

ExceptionManager.FullName: ToolsFramework, Version=4.0.0.0, Culture=neutral,
PublicKeyToken=null

ExceptionManager.ApplicationDomainName: /LM/W3SVC/11/ROOT/WebUserInterface-1-
129664555935303906

ExceptionManager.Thread Identity:
1) Exception Information:

R R O R R

Exception Type: GovernSoftware.ToolsFramework.Exceptions.GovernException
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Messages:
1- You are not allowed to use the eProfile system. Please check with the city.
2- Could not load eProfile login page.

MessageCount: 2

Message: Govern Exception

Data: System.Collections.ListDictionaryInternal

TargetSite: Void Page Load(System.Object, System.EventArgs)

HelpLink: NULL

Source: App Web gmO2nhia

Stack Trace information

LR R E RS S S SRR SRR EREEEEEEEEEEEEEEEEEEEESS

at GovernSoftware.WebUserInterface.WebProfile.WEB_WP_NA Login.Page_ Load (Object
sender, EventArgs e)

at System.Web.UI.Control.OnLoad (EventArgs e)
at System.Web.UI.Control.LoadRecursive ()
at System.Web.UI.Control.LoadRecursive ()
at System.Web.UI.Control.LoadRecursive ()
at System.Web.UI.Control.LoadRecursive ()

at System.Web.UI.Page.ProcessRequestMain (Boolean includeStagesBeforeAsyncPoint,
Boolean includeStagesAfterAsyncPoint)

khkkhkkhkhkhkkhkhkkhkhkhkhhkhkkhkhkdkhkhkdhkhkkhhkdkhhkhhhkdhdkhkhrdkhhkdhhkhx*x

END OF EXCEPTION

LR R RS SRR SRR SRR SRR SRS EEEEEEEEEEEEEEEEES
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Solution: Contact MS Govern Technical support to obtain a valid license to
access the eProfile.

Note: After obtaining the appropriate licensing information, it will be
necessary to create a new deployment with the MS Govern DeployEZ
application. Refer to the DeployEZ user guide for details. In addition,
the Internet Information Service (IIS) will need to be restarted after
installing the deployment applications.

Server Errorin ‘/WebUserInterface Application

{88 The webResousce, xd hadisr must be regetsred in | | K- B - 0 - Pome Saety- Todse -

Server Error in 'fWebUserInterface' Application.

The WebResource.axd handler must be registered in the configuration to process this request,
<{-- Web.Config Configuration File -->

<configuration>
<system.web>
<httpHandlers>
<add path="WebResource.axd" verb="GET" type="System. Web.Handlers. AssemblyResourceLoader” validate="True" />
</httpHandlers>
<fsystem.web>
</cenfiguration>

nnnnn

Symptom: When trying to access the Website page, a Server Error in ‘/
WebUserlInterface’ Application error page is displayed.

Solution: One possible solution for the above error page is to set the
AppPool Managed Pipeline mode for the eGov to Classic.

1. Click to select Start > Control Panel.

2. In the Control Panel, select Administrative Tools.

In the Administrative Tools start the IIS manager by selecting Internet
Information Services (1IS) Manager.

4. In the Internet Information Services (lIS) Manager, locate the Application
Pools.

5. Double-click on the application pool (B) to display the Edit Application Pool
form.
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6. Under the Managed pipeline mode parameter, select the Classic option
from the drop down menu (C).
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Click OK.

Right click on the Application Pool and select Recycle.

Crystal Reports Processing Jobs Limit issues

WARNING: Making modifications to the Windows registry should only be
carried out by experienced users with system administrator level
a. Extreme caution should be used when proceeding as errors
can render your system inoperable.

System performance issues arising from multiple users requesting Crystal
Reports may be caused by a Crystal Reports error related to Print Job
limitations on a Web server. The PrintJobLimit key is by default set to a value
of 75; the recommended number of requests for optimum performance. When
eGovern Crystal Reports are requested by multiple users, reports may stop
working. Changing the value in the registry key to -1 (maximum number of
requests = unlimited), can avoid this problem but may affect system
performance.

To modify the registry key...

1. In the Windows Start button, search for the Registry Editor utility
(regedit.exe).
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2. Look for HKEY _LOCAL_MACHINE > SOFTWARE > Business Objects >
[Crystal Reports Version] > Report Application Server > InProcServer >

PrintJobLimit.

Double click on the PrintJobLimit key to display the edit string.

4. Change the value of the string (A) to -1.
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Note: The above is a non-exhaustive resolution to the issue. Additional
details and recommendations for designing reports may be found on
the SAP website

Issues Contacting Server by Server Name

Symptom: When a server is located in the “Network DMZ”, Govern may not
be able to contact the server by the Server Name used in generating the

connection key.

Solution: When this server cannot be contacted by its name, i.e. resolved,
the IP address of the server should be substituted for the Database Server

Name.
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For Example:

When attempting to connect to the following...

Database Server Name: KENOBI (IP address = 192.168.50.100)
Database Name: LANDTITLES

Database Type: SQL (SQL 2005)

Following Govern.NET standards of <DatabaseName>_ <DatabaseServer-
Name>_<DatabaseType>, the Connection Key would be:

LANDTITLES_KENOBI_SQL

Note: The parameter names are separated with the underscore character “

After attempting to connect using the above connection key, replace the Data-
baseServerName with the /P address of the server. The resulting Connection
Key would be...

LANDTITLES_192.168.50.100_SQL

If the issue is related to the resolution of the of the server name, a substitution
with the IP address should resolve the connection issue.

Note: Should the IP Address of the Database Server change, it will need to
be modified in the Connection Key.
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APPENDIX A: Glossary

Term

Definition

Access Level

A level of security. Within the eProfile, there are five levels of security
for five types of users: Internet Without Profile: Users without an
eProfile account; Internet With Profile: Users with an eProfile account;
Internet Subscriber: Users with an up-to-date subscription plan;
Intranet User and Intranet Administrators.

Anonymous User

An unauthenticated user. Anonymous User or User Without Profile
status can be assigned to some menu options and items in the
eProfile. Certain restrictions apply.

Appeal

A request to reexamine the result, final judgment or ruling of a lower
court. You can create your own Appeal Types and activities and assign
all the attributes available to the Permit Type.

Application Type

See Permit Type.

Approval

An authorization of the amount to be borrowed in order to pay for a
property, following a financial assessment of the borrower. An approval
type and process can be defined in Govern.

Automated Clearing House
(ACH)

A system that provides electronic funds transfer (EFT) between banks,
included with Govern’s ePayment solution, for paying bills and permit
fees, over the Internet, directly and securely from a bank account.

Bond

A written certificate, issued by a business or government organization
defining a debt, the terms of payment and any other obligations. In
Govern, bond types and activities; such as dates for payment and
interest accumulation, can be created and maintained. You can create
your own bond types and activities and assign all the attributes
available to the Permit Type.

Complaint

A formal statement filed against another person or entity, expressing
dissatisfaction or a violation of rights. In Govern, complaint types and
activities, such as a request to file a response or to appear in court, can
be created and maintained. You can create your own appeal types and
activities. and assign all the attributes available to the Workflow Type.

Decision

A conclusion reached by a court of law or tribunal to resolve a dispute
or argument. A decision process can be initiated through a System
Activity. You can create your own decision types and activities and
assign all the attributes available to the permit type.
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Term

Definition

eComplaint

An electronic complaint submitted over the Internet. Govern’s
eComplaints solution is similar to the ePermits solution. It provides
online access to citizens and tracking and maintenance features for
Govern users.

eComplaint (Anonymous)

Functionally the eComplaint Anonymous is the same as the
eComplaint, with exception that no profile is required for submitting.

eComponents

An electronic component. Govern’s eGovern — Public Self Service
Portal package includes the eProfile, ePayment and ePermit solutions.

eGovernment

Government information and services made available over the
Internet.

E-mail

An e-mail message can be associated with an activity or activity step
and automatically generated at a specified point, such as the initiation
or completion of the activity.

ePayments

An electronic transaction made over the Internet. Govern’s ePayments
solution includes ACH and credit card payment management.

ePermits

An electronic permit initiated over the Internet. Govern’s ePermits
solution provides online access for submitting both simple and complex
permit applications that can include multiple permit types, multiple
name types and multiple additional documents.

eProfile

A set of data portraying a citizen or user. At this time, the eProfile
includes name and address information, properties, UB accounts,
ePermits, ePayments.

eProfile Account ID

A unique combination of six to 30 characters that identifies a user. Only
alphanumeric characters are accepted.

eProfile Password

A unique combination of up to 16 characters that identifies a user. The
password is encrypted in the database and kept secret by the user.
The minimum length, type of characters and security level are
determined by the organization.

eRemittance

An online variation on the Self Reported Tax submittal form. The online
version of the form must be created with the Self Reported Tax Editor
in Govern NetAdmin release 4.7 and greater.

eRenewal Activity steps that allow renewal can be configured to allow the user to
perform this renewal action online. Settlement of any associated fees
is carried out through the ePayment process.

Grievance A Complaint filed against a government organization; for example, to

dispute a decision or ruling. Using the same forms as for a complaint, a
grievance type and process can be created and maintained.
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Term

Definition

Hit

A request logged by a Web server. Each time a user selects a property,
in the eProfile, to make an inquiry, make a payment or access an
eComponent, it is considered a hit. The user can make as many
inquiries or access as many eComponents as required in the same hit,
for the selected property. For example, a user can select a property,
view the tax billing information, make a payment and apply for a permit
in a single hit. However, if the user selects a different property to view
the tax information on that property that is considered a second hit.

Key Type

A classification for Land Management data. In Govern, there are three
key types: Permit, Offense and Workflow. For the Web, the Permit Kind
comprises Building, Electrical, General, Plumbing Permits, Approvals,
Bonds, Decisions, Prosecutions and Appeals and the Workflow Kind
comprises Complaint, Grievance and Request for Services and
Workflow.

Menu Level

A reference to the menu or submenu at which a menu option appears.
The eProfile can include up to five menu levels, as defined by the
organization. All options on the main menu bar are considered Top
Level; options accessed from the Top Level options are second level
options; options access from the second level are third level options
and so on. For example in Web Portal > Tax Information > Payment
History; Web Portal is a top level option, Tax Information a second and
Payment History a third level option.

Mobile Inspector

An application designed for the inspector who needs up-to-the-minute
information, while working in the field, Govern’s Mobile Inspector
solution provides online real-time wireless access to the Land
Management subsystem.

Multimedia Codes and sub
codes

A classification and subclassification providing options for linking
various document types to a permit.

Offense

An infraction of a law, rule or code. In Govern, you can create an
Offense process, following a setup similar to the one defined for the
permit type. You can create Offense types and assign activities to
define and track the process. You can then associate name types,
fees, inspection scheduling, multimedia codes, a new offense, permit
or workflow process and link multiple properties as for a permit. In
short, you can assign all the characteristics available to the permit type
with the exception of fee methods.

An offense can be initiated through an activity associated with the
ePermit application.
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Term

Definition

Permit Type

A user-defined classification under Permit Kind. For example, under
the Building Permit Kind, you could have renovation, new construction,
commercial or residential permit types. Additional columns and activity
steps can be defined for the permit type.

Primary Permit Type

The main permit type associated with the permit. All permit
applications must include a Primary Permit Type. The activity steps
and sequence numbers associated with the primary permit type are
followed. All fees associated with the primary type are charged.

Prosecution

The process of pursuing formal charges against an offender, in a court
of law. In Govern, prosecution types and activities, such as the initial
complaint and court dates, can be created and maintained. The
prosecution type uses the same forms as the permit type. In Govern,
Prosecutions fall under the Permit Type category. You can create your
own prosecution types and activities and assign all the attributes
available to the permit type.

Request for Services

A formal statement and process to ask for services from an
organization. Using the same forms as the Workflow type, request for
services types and activities can be created and maintained.

Search Group

A combination of two or more Search Styles that are launched, as a
unit, in the order specified in the search sequence.

Search Object

An item appearing on a Search page, such as a search criterion or
label. To display search objects on a Search page, you need to link
them to a Search Style.

Search Style

A Search Style launches an SQL query and displays the Objects that
appear on the Search page, including the search criteria and labels.

Secondary Permit Type

A permit type that can be linked to the primary permit type on the
permit application, since the property, requirements and other
information are the same for both types. The activity steps and
sequence numbers associated with the secondary permit type are not
used. Fees are charged only if they are linked to an activity step that
has the same number as an activity step in the primary type setup.

Subscription Plan

An arrangement for providing access to the eProfile. Subscribers can
be charged by hit, by subscription period or by profession. The
organization can create four different types of subscription plans and
an unlimited number of plans of each type.

Subscription Period

A period of time during which a subscription is active. A variety of
subscription periods can be selected, from one day to one year.
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Term

Definition

Universal Naming Convention
(UNC)

A standard for specifying the directories where servers, files and other
resources are located on a network.

The UNC standard uses a double backslash to identify the computer
and single backslash for the directory; for example,

\\GovernServer\Govern\DotNet\version3.1\

The drive letters; such as ¢: and d: are not entered.

Workflow

A series of activities that define a business process within an
organization. Workflow activities can include tasks, procedures, the
request for and input of documents and required tools as well as other
processes. Created on Land Management forms, similar to those used
for permits, you can associate name types, fees, inspection
scheduling, multimedia codes, a new workflow, permit or offense
process and link multiple properties as for a permit.

A workflow can be initiated through an activity associated with the
ePermit application.

In Govern, the Workflow Type comprises Complaint, Grievance and
Request for Services as well as Workflow.
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APPENDIX B:eComponent Item Kinds

When the option for eComponent is selected in the ltem Kind parameter, the
following options are available for selection under the ltem Name parameter:

Note: eComponents that are described as “<CUSTOM>" are components
that have been customized for specific clients.

eComponent Item Name Description

Access Rights This is an administrative screen used to set up
user rights, or to reset them to default; this link
will be reserved for those with Administrator
credentials.

Account Information This option to link to the user modification compo-
nent. The user will be able to change their
account details such as password, name and
address, etc., if permitted.

Account Information (Admin) Select this option to access the administrator
version of the Account Information. An adminis-
trator will be able to search for names and
change account details.

eComplaint Use this option to configure the eComplaints
component.
eComplaint (Anonymous) This option will configure the eComplaints (Anon-

ymous) component. Refer to Anonymous
eComplaints on page 37

eGrievance When selected, this option will connect your
menu to the eGrievance component.

ePayment Selecting this option will allow you to attach the
online payment component.

ePermit This option is will set your menu to link to the
ePermit component. See ePermit - Planning Your
Setup in the

eProperty Information <CUSTOM> For linking your menu to the custom
property information component, select this
option.
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eComponent Iltem Name

Description

eRemittance

Use this option to link your menu to the eRemit-
tance component for Self-Reported Tax
submissions. Refer to eRemittance on page 231.

eRenewal

This option will link your menu to the eRenewal
component that allows online renewal of certain
permit types. Refer to ePermit - eRenewal
process on page 201.

eRequest for Service

This is the option that is used for the Request For
Service (RFS) component.

GIS <CUSTOM> Select this option to use the GIS
custom component.
Home Select this option to have the menu link to the

designated home page.

JP Morgan Payment Inquiry

<CUSTOM> Select this custom component when
using the JP Morgan Payment Inquiry system.

MB Payment Select this custom component to use the Misc.
Billing ad hoc payment component.
Modify User Select this admin option to link to the User Modi-

fication component. This allows you to be able to
search for other user profiles. Not to be confused
with Dynamic Searches.

Multimedia Documents

When selected, this option allows the viewing of
Multimedia documents in the database through
the Reports.

Properties

This links to the component that will add or
removes properties to accounts.

Properties (Admin)

This is the Administrative version of the Proper-
ties components. This allows administrators to
display current users and their linked properties.

Sign Out

Use this option to link to the “log off” component.

Subscriber Definition

Select this option to link to the administrative tool
that is used to maintain subscribers. You are able
to display subscribers, see associated plans, and
whether they are active.

© 2013 MS Govern

Page 267



~\)

eGovern — Public Self g‘ 2. HARRIS
Service Portal N~  GOVERN
eComponent Item Name Description

Subscriber Plan Definition

When selected, this component will link the menu
item to the subscriber plan definition module. This
component is used to design the subscriber
plans.

Subscription Balance

This option will link to the component that is used
to renew subscription plans.

Subscription Approval

<CUSTOM> Select this option to have your menu
link to the subscription approval component. This
custom component will hold newly created
accounts and display them on a list that the
administrator can then Approve or Reject the
user.

UB Accounts

This option will link the component to accessing
UB Accounts.

UB Accounts (Admin)

This links to the Administrative properties compo-
nents for UB Accounts.
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APPENDIX C:Interactive Crystal Reports

The following lists the basics on how to integrate interactive Crystal Reports in
the ePortal and the eProfile websites.
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Parameter Fields

If you integrate these parameter fields to your report, the Govern NET solution
will automatically fill them with values before opening the report. These
parameters have been color coded to better illustrate them within examples
below.

"SESSIONID[required]: Before opening the report, the report manager will
fill this parameter with the current session id, this will be used to redirect to
another report or web page and will prevent loosing all current session
information.

Before opening the report, the report
manager will fill this parameter with the current web site address, this will be
used to redirect to another report or web page.

"WEBREPORTDIRECTORYPATH [required]: Before opening the report,
the report manager will fill this parameter with the value in the web.config entry
"GovernSoftware.WebReportDirectoryPath". This value will be used to locate
the report directory root.

"LANGUAGE [optional]: If this parameter is included, we will fill it with the
current culture language used by the user. You will then be able to use this
value to display the label in the proper language.

"ACCESS_RIGHT [optional]: If this parameter is included, it will be filled

with the access level code of the current user, i.e. internet user without login,

internet user with login, intranet admin, etc. This could be useful to show/hide
different sections of a report based upon user security level.

Formula

Formulas should be added to the report, they are not required, but they will
simplify the implementation and the maintenance of the report.

"WebSessionlD [fixed]: This formula always contains the same value. It's
used to detect if the reports know the session id.

Definition:
if Length ({?SessionID}) > 0 then

"/(S(' + {?SessionID} + '))' else
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"WebSiteAddress [fixed]: This formula always contains the same value. It
is used to build the current web site address with the session id.

Definition:
{?WEBSITEADDRESS} + {@WebSessionID}

"WebPaymentURL [fixed]: This formula always contains the same value,
the URL of the ePayment page.

Definition:
{@WebsiteAddress} + '/ar/
web ar payment.aspx?target=ar info basic&DirectCall-

ToAr=1"

"WebReportViewer| fixed]: This formula always contains the same value,
the URL of the report viewer page.

Definition:

{@websiteAddress} + '/Report/Web Report CrystalViewer.aspx'

This formula always contains the same
value, the URL of the multimedia viewer page.

Definition:

{@WwebsiteAddress} + '/Multimedia/Web Multimedia Viewer.aspx '

NA_IDbyAR_ID: This parameter will read an NA_ID and obtain all AR_ID’s
associated with it. The results will be displayed in the AR Basic Selection
screen.

Definition:

The URL, i.e. link from the report should appear as follows:

/AR/WEB_AR_PAYMENT.ASPX?target=ar_info basic&na_ idbyar id=NA_ ID
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Links

Currently, there are three (3) types of links that are supported in Crystal
Reports, they are as follows:

* Links to other Crystal Reports
* Links to the ePayment page
* Links to the Multimedia page

Linking to another Crystal Reports

There are two values that need to be set, the Report Name and the Reports
Parameters. The report name is marked in yellow. You can append as many
parameters as your reports needs but the first one must be entered like the
green entry, and the others like the red entry.

Example:

{@WebReportViewer}

+ '?REPORTNAME=' + {?WebReportDirectoryPath} +

+

'&ReportParameter=YEAR ID='+{?YEAR ID}

+ ';ACCESS RIGHT=' + {?ACCESS RIGHT}

+ ';LANGUAGE=' + {?LANGUAGE}

+ ';P _ID=' + {?P ID}

+ ';CURRENT YEAR ID='+{?YEAR ID}

"ePayment: You have to set two values, the key value and the previous
page. The Key value support P_ID, AR_ID and UB_ID, it should be entered
like the yellow entry. The previous page is a link to the current report and is
defined like a link to another Crystal Report, with the only difference marked in
green. The %26 is the URL code for the special character "&" that is used to
separate parameter in the URL.

Example:

{@WebPaymentURL}
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+ '&PreviousPage="
+ {@WebReportViewer }

+ '?REPORTNAME=' + {?WebReportDirectoryPath} +
'GOV_WEB_ MENUREPORT.rpt'

+ '%26ReportParameter=ACCESS RIGHT=' + {?ACCESS RIGHT}
+ ';LANGUAGE=' + {?LANGUAGE}

+ ';P_ID=' + {?P_ID}

+ ';YEAR ID=' + {?YEAR ID}

You have to set two values, the Info ID value and the
previous page. The info_id value is the unique identifier of the multimedia
document, it should be entered like the yellow entry. The previous page is a
link to the current report and is defined like a link to another Crystal Report,
with the only difference marked in green. The %26 is the URL code for the

special character "&" that is used to separate parameter in the URL.

Example:

+ '&PreviousPage="
+ {@WebReportViewer}

+ '?REPORTNAME=' + {?WebReportDirectoryPath} +
'GOV_WEB_ MENUREPORT.rpt'

+ '%26ReportParameter=ACCESS RIGHT=' + {?ACCESS RIGHT}
+ ';LANGUAGE=' + {?LANGUAGE}
+ ';P_ID=' + {?P ID}

+ ';YEAR ID=' + {?YEAR ID}
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Transfer of variable to Crystal Reports

Users should note that the WebProfileCurrentNa_ Id variable is
transferred to Crystal Reports when a user is logged on with an eProfile. This
variable is the Name ID (NA_ID) of the current user that is logged on.

Auto Launching a Report

In the Govern New Administration (GNA) release 5.1, when configuring a
menu to display a report, the report can be automatically launched. This
feature is achieved by only specifying the Requested Key parameter in the
Dynamic Search group.

Note: This feature is only valid when a user is logged in with an eProfile.

Web Sites(CMSDEMO_JXMVLNL SQL)
Available Web Site Menu (CMSDEMO_JXMVLN1 SQL)

Menuld g5 Menu Sequence 4

Description pame Based Information

Infon

00004: Name Based Infol

ient

Parameter

E Name

¥ Intranet user

To create a menu to Auto Launch a report...
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In GNA rel. 5.1 click Setup > Web Configuration... > Manage Web Sites...
In the Web Sites editor, click Menu Setup.

Under the Menu list, create a new menu, or select a pre-existing menu.

b~

In the Item group specify Report as the ltem Kind; specify a path to the
report.

5. Specify the Requested Key for the search in the eSearch group; do not
specify a Dynamic Search Style or Group.

Configure any additional parameters.
Click Save to save the menu.

In eGov, when the menu is selected, the ePortal will launch the report directly
using the Name ID (NA_ID) of the eProfile.
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APPENDIX D:Creating a Secure Access

Page

Note: The following section contains information that requires the creation
and modification of system registry keys. Ensure that a full back up of
the registry is made prior to making any modifications. The following
steps should only be made by a System Administrator or users with
Administrator level access and indepth knowledge of the functioning of
the system registry.

When hosting a Web site, it may be necessary to provide secure access to
certain pages within your site. The eGov offers pages that can be accessed
without the security of an eProfile, as well as pages that users require a
username and password to access, i.e. a profile to access. The Application
Pool that the eGov is running within, has security settings that will be applied
to all Web pages within the eGov. This means that all users will have the same
level of access to all pages. This may not be desirable, as there may be pages
that will required controlled access. As an example, the pages that display
multimedia documents may require additional security due to the sensitivity of
documents that they may contain. A method is therefore required to secure
certain pages.

The following will describe steps to create access for specific pages. For our
example we want to create secure access to the Multimedia pages due to the
fact that sensitive documents are kept there. The Multimedia page that will be
targeted is located in the following directory:

\\Myserver\inetpub\wwwroot\MSGovern\WebUserInterface\Multimedia)\

Organize = oo Open - New folder

=
Mame Date modified Type Size

, Controls 10/11/2011 213 PM  File folder
,j Web_Multimedia_Documents.aspx 10/11/2011 213 PM  ASP.MET Server Pa... 1KE
= Web_Multimedia_DocumentsSearch.aspx 10/11/2011 213 PM  ASP.MET Server Pa... 1KE
=] Web_Multimedia_Viewer.aspx 10/11/2011 213 PM  ASP.NET Server Pa... 1KB
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The name of the page is: Web_Multimedia_Viewer.aspx

Note: The following procedures should only be performed by a user with
Administrator level access priveleges.

STEP 1 - Modify the Web.config file

The first thing needed is to locate the web.config file, and using a text editor
locate the <configuration> section within the file.

Original web.config:

<configurations>
<location path="PageToImpersonate.aspx">
<system.web>
<identity impersonate="true"
userName="MyUser"
password="MyPassword"/>
</system.web>
</locations>
</configuration>
Modification to web.config:
Below are the modifications that will need to be made in the section.
<configuration>
<location path="Web Multimedia Viewer.aspx'">
<system.web>

<identity impersonate="true"

© 2013 MS Govern Page 277



)
eGovern — Public Self {‘ 2 HARRIS

Service Portal \ GOVERN

userName="registry:HKLM\SOFTWARE\MSGOVERN\WebUserInterface\Multime-
diaIdentity\identity\ASPNET SETREG,userName"

password="registry:HKLM\SOFTWARE\MSGOVERN\WebUserInterface\Multime-
diaIdentity\identity\ASPNET SETREG,password"/>

</system.web>
</locations>

</configuration>

STEP 2 - Use the ASPNET_setreg.exe utility

Although by design, ASP.NET will reject any HTTP request to resources with
the .config extension, e.g. web.config, sensitive configuration information is
being saved in the web.config. It is best practices to ensure that the sensitive
sections of the web.config file is encrypted for security reasons. Once
encrypted, the settings are safe. In addition, when the settings are being
accessed, ASP.NET will automatically decrypt the sections required.

ASPNET_Setreg.exe is a command-line program that is used to encrypt
sections of your web.config file. The installation package can be obtain from
the Microsoft Website at http://support.microsoft.com/kb/329290.

To encrypt your username and password in the <configuration> section...

1. Install aspnet_setreg.exe under c:\Tools or similar directory
2. Type the following command:
Run CMD c:\Toolss>aspnet setreg.exe -k:SOFTWARE\MSGOVERN\WebUser-

Interface\MultimedialIdentity\identity -u:"yourdomainname\username" -
p: "password"

STEP 3 - Update the Permissions in the Registry

To ensure that the Windows Registry gives permission to the registry keys for
the ASP.NET Account, it will be necessaqry to use the regedit.exe registry
editor.

From the desktop...
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1. Click Start > Run
2. In the Run dialog box, type regedt32; click OK.

3. From the top of the registry tree, “drill down” as follows:

HKEY_LOCAL_MACHINE > SOFTWARE > MSGOVERN > WebUserInter-
face > subkey.
Right click on the subkey and select Permissions.

In the Permissions form, give access rights to ASP.NET users and the
NetworkService (1IS 6.0); replace permissions for all children.

Click OK to save.
Select File > Exit.
Perform an lISReset.
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APPENDIX E:Default Firewall Port
Settings

By default, Microsoft Windows enables the Windows Firewall, which closes
port 1433. This will prevent Internet users from connecting to a default
instance of SQL Server. Internet users, i.e. TCP/IP users, will not be able to
connect to the default port until it has been reopened. The following are the
recommended default Windows firewall port settings for users of the eGovern
- Public Self Service Portal.

Recommended Access for: Port Number(s)
SQL Database 1433
Oracle Database 1521
File sharing (e.g. for Multimedia Documents) 135 to 139, 445

Note: Users that configure port numbers that differ from the above defaults
will need to make note of them. Refer to Microsoft Technical Support
for instructions on how to configure the Windows firewall for database,
and file sharing access.
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APPENDIX F: HTML Tags

The following are lists of common HTML tags that can be used in the WebSkin
Editor

HTML Document Structure

A standard HTML document will have the Browser Window

following structure. (=HEAD> )
I <TITLE= 4
<HTML>
<HEAD>
<TITLE> @}i\,’?
’
This Title Appears in
the Browser Title Bar
</TITLE>
</HEAD>
<BODY>

Information for the body section.
This information
is usually seen in the browser window.

</BODY>
</HTML>

<HEAD> Section

The <HEAD> section is the recommended location for JavaScript, and
Cascading Styles Sheets (CSS). Elements that are often contained in the
<HEAD> section are:

« Title - The title that appears in the title bar of the browser is set between
the <TITLE></TITLE> tags.

* Link - The link element is used to define an external resource such as the
external CSS file containing formatting styles. The following is a sample
using the Link element to link to an external CSS file.
<link rel="stylesheet" type="text/css"
href="CSS Filename.css" />
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* Meta - The meta element is used to define document author, purpose,
keywords, etc.
<meta name="keywords" content="HTML, web design" />

The “Head” section of the document is where you place the title of the page.

The title that appears in the title bar of the web browser is placed between the
“<TITLE></TITLE>" tags.

<BODY> Section

The <BODY> section of your document is used for all content that is to be
displayed in the browser. Following are some tags that are used in the
<BODY> sections

Formatting Tags

Tag Name Tag Used

Heading1 <H1></H1>

Heading2 <H2></H2>

Heading3 <H3></H3>

Heading4 <H4></H4>

Heading5 <H5></H5>

Heading6 <H6></H6>

Bold <B></B>

Italic <I|></|>

Paragraph <p></p>

Font <font face="Arial” color="#FFFFFF” size="5">
- The font name must appear as it does in
your fonts folder
- Colors are defined using Octal

Creating Hyperlinks, Anchors, and Links

The HTML Anchor link <a> is used to define links within your document.

<a href="URL to file"s>Text to be linked</a>
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HREF defines the link address, so for example a line of text that would link to
the MS Govern Web site would look like the following:

<a href="http://www.msgovern.com/”>Click here to go to our site...</a>. When
the above hyperlink is defined, Click here to go to our site will appear
underlined and will be a link to www.msgovern.com

Creating an E-mail Link

The e-mail link is a standard hyperlink using the anchor link with a slightly
different syntax. For example:

This is a mail link...

<a href="mailto:someone@company.com?subject=Per-
mit%20Request">Contact Us</a>

the above e-mail link, will display Contact Us as a hyperlink that when
selected, will launch the installed e-mail client with a new message window.
The message will be addressed to “someone@company.com”, and “Permit
request” will appear in the Subject field.

Note: When you want to enter text in the Subject field, spaces between
words should be entered as “%20” which is the URL encoding for a
space character.

Relative Links

When creating hyperlinks, depending on the length of the domain name, and
the number of subdirectories that the file being referenced is located in, the
URL’s can become very long. In such situations, users that are familiar with
the use of Relative Links will use them as a means of shortening the URL.

For example, a file called web_image01.jpg is being referred to from a page
with a URL of :

http://www.metrocity.com/webpages/html/services.html
The URL for the image is:

http://www.metrocity.com/webpages/html/images/
web imagesOl.jpg

© 2013 MS Govern

Page 283



eGovern — Public Self
Service Portal

7.2 HARRIS

Sl GOVERN

To shorten the URL, a relative URL can be use to replace the longer path:

images/web imagesO0l.jpg

Using Relative Links with the ePortal Application

The use of relative links, although supported, is not recommended. The Web
Portal Application uses Active Server Pages (ASP), information to generate
the page may be obtained from varoius locations. These locations can
change, and as a result the links can be broken. It is therefore recommended
that you use absolute URL's, i.e. the full path for hyperlinks and references.

Tables in HTML

HTML tables allow you to arrange text, images, links, etc. into rows and
columns of cells that are in a table. The principal tags that are used are the

following:
Tags
Tag Name Tag Used Explanation
Main Table Structure | <TABLE></TABLE> Creates table; properties
are defined within.
Table Row <TR></TR> Defines each row
Table Data <TD></TD> Defines each cell of the
table.
Table Header <TH></TH> Used to specify table

headers; can be used for
Rows, Columns, or both.
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Table elements are used to define other elements that specify content, and

formatting

Tag Name

Name & Attribute

Explanation

Border

BORDER
ex. <TABLE BORDER=2>

Specifies thickness of
cell border

Cell spacing

CELLSPACING
ex. <TABLE
CELLSPACING=4>

Sets space between
table cells

Cell padding

CELLPADDING
ex. <TABLE
CELLPADDING=4>

Defines the space
between content of the
cell and the cell wall.

Column Span

COLSPAN

ex. <TR><TH
COLSPAN=2>Test Text</
TH>

OR

<TR><TD
COLSPAN=3>Test Text</
TD>

Lets the cell span over
multiple columns

Row Span

ROWSPAN

ex. <TR><TH
ROWSPAN=2>Test Text</
TH>

OR

<TR><TD
COLSPAN=3>Test Text</
TD>

Lets the cell span over
multiple rows
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Tag Name

Name & Attribute

Explanation

Background Color

BGCOLOR

ex. <TABLE
BGCOLOR="Pink"></
TABLE>

ex. <TR BGCOLOR="Yel-
low”></TABLE>

ex. <TD BGCOLOR=#AAF-
FAA></TABLE>

Sets the background
color of a single cell, row,
or table.

NOTE: Colors can be
specified by name within
quotes, e.g. “Red”, orin
hexadecimal format, e.g.
#FF0000. When usng
hexadecimal format, no
quotation marks are
required.

Cascading Style Sheets (CSS)

The topic of Cascading Style Sheets (CSS) is one that is complex and its full
exploration is beyond the scope of this document. What is presented here is
an overview containing examples that can be used as a starting point.

Style sheets are used to define how HTML elements are displayed in a
browser. Using a Cascading Style Sheet (CSS) allows you to create a single
file that will contain the formatting information for your pages. When changes
need to be made to the appearance, they are made in the CSS document; any
documents that reference the CSS document are automatically updated.

A CSS can be defined in a single external document or on a page by page
basis when embedded in the <HEAD> section of the document.
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—<html>

— <head>

[—cstyie type="text/css">
HEAD Secti H3 {font-family: times}
ection el i

Rsan\ssegif {font-family: sans-serif}

L—</style>
L </head> @

i-— <body>

<H3>This is header 3</H3>

BODY Section szIh;s isaparagraph</P>
L <P class="san§serif">Thi5 isa paragraphﬂ@
</body> \
L—</html>

The above style sheet is placed in the <HEAD> section of the document. The
<STYLE> tag is used to define the CSS. Styles have been specified for the
<H3>, and <P> tags. The default <P> tag can be overriden when you specify a
CSS CLASS.

The CSS class can be used as in the above example, when you want all text
with the <P> tag to appear as courier, but sometimes you would like them to
appear as sans-serif. This is done by adding an “extension” to the standard
CSS code, “P.sansserif”, and specify the extension as a class in HTML in the
<BODY> section of the document, “<P class="sansserif"> </P”. When you
want the default paragraph with courier, you use <P> Text Example </P> and
whenyou want the sans-serif font, use <P class="sansserif’> Text Example </
P>

Note: CSS Code in classes will override default CSS code, e.g. P.sansserif
will override P

Note: Key to success with CSS is paying close attention to spelling. In
addition, like HTML, CSS are not case sensitive, but font families,
URLs to images, and other direct references may be.
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A source of information is the World Wide Web Consortium home page at
http://lwww.w3.0rg/. This is an excellent resource for topics related to HTML,
CSS, and JavaScript.
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Creating
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Creating a Web site menu 34
Creating an Account 143
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Crystal Report
Auto Launching 274
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229
CSS 286
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149
Customizing Address fields with the SRT Editor 240
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Database Server

Recommended xiv
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165
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Defining ePermit Permit Type Parameters 170
Defining Fees for the ePermit Application 196
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Manage Users 139
Manage Utility Billing Accounts 140
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Menu
Configuring Your 125
MS Govern Section 118
Multimedia Codes 179, 193
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Name Creation Process 147

Name Types 178

Navigating Webskin Manager tabs 111
Navigation Button Layout 65

New File 249

New Permit, Offense or Workflow Generation 193

Notification Message
Customize Account Creation 149
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Online Payment

Barcode 136

Misc. Payment 136

Name 136
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Online Services Menu 135
OpenForms Settings group 237
Oracle Databases

Crystal Reports group Settings 229
Output File Name 249
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Permit Activity Setup 152
Permit Kinds 185

Permit Parameters 152, 159

Permit Parameters Command Buttons 169

Permit Type Maintenance 152, 159
Planning Your ePermit Setup 153
Planning your ePermit Setup 152
Posting Web ePayments to A/R 247
Pre-installation activities... 5
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Re-extract Existing File 250
Required control on the web site page 240
Resetting Internet Information Services (11S) 130
Resource File Locking and IIS 142
Resulting File Name 249
Rules
Applying Fees According to Fee Type 200
Applying Fees According to Step Number 198
Applying Fees to an ePermit 198
Rules for Applying Fees based on Fee Type 200
Rules for Batch Generated Usernames and Pass-
words 42
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Search Configuration 45, 62
Search Styles and Groups 180
Self Reported tab
Web Site Manager Parameters 89
Self Reported Tax Editor 236
Command Buttons 237
Parameters 237
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Web Site Manager 89
Server Configuration 5
Server Recommended Hardware xiv
Server, Client and Network Requirements xiv
Settings for Oracle Databases
Crystal Reports group 229
Settings for SQL Databases
Crystal Reports group 229
Setup Procedure 159
Sign Out Menu 140
Site Seal Script 87, 225
SQL Databases
Crystal Reports group Settings 229
Steps for Setting up an EFT Provider 83, 220
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Table Back Color 114
Table Layout 114
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	eComponent Item Name
	Description
	Access Rights
	This is an administrative screen used to set up user rights, or to reset them to default; this link will be reserved for those with Administrator credentials.
	Account Information
	This option to link to the user modification component. The user will be able to change their account details such as password, name and address, etc., if permitted.
	Account Information (Admin)
	Select this option to access the administrator version of the Account Information. An administrator will be able to search for names and change account details.
	eComplaint
	Use this option to configure the eComplaints component.
	eComplaint (Anonymous)
	This option will configure the eComplaints (Anonymous) component. Refer to Anonymous eComplaints on page 37
	eGrievance
	When selected, this option will connect your menu to the eGrievance component.
	ePayment
	Selecting this option will allow you to attach the online payment component.
	ePermit
	This option is will set your menu to link to the ePermit component. See ePermit - Planning Your Setup in the
	eProperty Information
	<CUSTOM> For linking your menu to the custom property information component, select this option.
	eRemittance
	Use this option to link your menu to the eRemittance component for Self-Reported Tax submissions. Refer to eRemittance on page 231.
	eRenewal
	This option will link your menu to the eRenewal component that allows online renewal of certain permit types. Refer to ePermit - eRenewal process on page 201.
	eRequest for Service
	This is the option that is used for the Request For Service (RFS) component.
	GIS
	<CUSTOM> Select this option to use the GIS custom component.
	Home
	Select this option to have the menu link to the designated home page.
	JP Morgan Payment Inquiry
	<CUSTOM> Select this custom component when using the JP Morgan Payment Inquiry system.
	MB Payment
	Select this custom component to use the Misc. Billing ad hoc payment component.
	Modify User
	Select this admin option to link to the User Modification component. This allows you to be able to search for other user profiles. Not to be confused with Dynamic Searches.
	Multimedia Documents
	When selected, this option allows the viewing of Multimedia documents in the database through the Reports.
	Properties
	This links to the component that will add or removes properties to accounts.
	Properties (Admin)
	This is the Administrative version of the Properties components. This allows administrators to display current users and their linked properties.
	Sign Out
	Use this option to link to the “log off” component.
	Subscriber Definition
	Select this option to link to the administrative tool that is used to maintain subscribers. You are able to display subscribers, see associated plans, and whether they are active.
	Subscriber Plan Definition
	When selected, this component will link the menu item to the subscriber plan definition module. This component is used to design the subscriber plans.
	Subscription Balance
	This option will link to the component that is used to renew subscription plans.
	Subscription Approval
	<CUSTOM> Select this option to have your menu link to the subscription approval component. This custom component will hold newly created accounts and display them on a list that the administrator can then Approve or Reject the user.
	UB Accounts
	This option will link the component to accessing UB Accounts.
	UB Accounts (Admin)
	This links to the Administrative properties components for UB Accounts.
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